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Introduction Read this Instruction Manual 
thoroughly before using the 
product.

Thank you for purchasing Shimadzu analytical instrument 
workstation “LabSolutions LCMS” (hereafter referred to as 
“the software” or “LabSolutions”).

This manual describes the procedures for operating this 
product. Read this manual thoroughly before using the 
product and operate the product in accordance with the 
instructions in this manual.

Also, keep this manual for future reference.

This manual assumes that the reader is knowledgeable of 
basic operations of Windows. For the operation of Windows, 
refer to the instruction manual that comes with that product.

Important • If the user or usage location changes, ensure that this 
Instruction Manual is always kept together with the product.

• If this manual is lost or damaged, immediately contact your 
Shimadzu representative to request a replacement.

• To ensure safe operation, contact your Shimadzu 
representative of product installation, adjustment, or re-
installation (after the product is moved), or repair is 
required.

© 2016-2018 Shimadzu Corporation All rights reserved.
Original version is approved in English.
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Notice • Information in this manual is subject to change without 
notice and does not represent a commitment on the part of 
the vendor.

• Any errors or omissions which may have occurred in this 
manual despite the utmost care taken in its production will 
be corrected as soon as possible, although not necessarily 
immediately after detection.

• All rights are reserved, including those to reproduce this 
manual or parts thereof in any form without written 
permission from Shimadzu Corporation.

• Microsoft and Windows are registered trademarks of 
Microsoft Corporation in the United States and/or other 
countries.
Adobe, Adobe logo and Adobe Reader are trademarks or 
registered trademarks of Adobe Systems Incorporated in 
the United States and/or other countries.
Other company names and product names mentioned in 
this manual are trademarks or registered trademarks of 
their respective companies. The TM and  symbols are 
omitted in this manual.

• Microsoft Windows Operating System is referred to as 
“Windows”.

• LabSolutions is registered trademarks of Shimadzu 
Corporation in the United States and Europe (Office for 
Harmonization in the Internal Market).

• Replacement parts for this product will be available for a 
period of seven (7) years after the product is discontinued. 
Thereafter, such parts may cease to be available. Note, 
however, that the availability of parts not manufactured by 
Shimadzu shall be determined by the relevant 
manufacturers.
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 List of Instruction Manuals

 Indications Used in Instruction Manuals
Cautions and Notes are indicated using the following conventions, and the following symbols are 
used in this manual:

Instruction Manuals

Name Content

Getting Started 
Guide

This manual follows an actual data acquisition procedure to describe 
basic methods of operation for first-time users. Read this manual to 
learn basic operations of the software.

Operators Guide This manual describes overall operations and handy functions in more 
details, such as the software's system configuration, data analysis, 
batch processing, confirmation of data acquisition results, and report 
functions.

System Users 
Guide

This manual describes system administration and data management of 
the software. Refer to this manual as necessary.

Installation & 
Maintenance Guide

This manual describes installation and maintenance of the software.

Data Acquisition & 
Processing Theory 
Guide

This manual describes peak detection and quantitation of sample 
components. 
Refer to this manual as necessary.

Help Clicking the on-screen [Help] button or pressing the [F1] key displays a 
description of on-screen parameters, answers to specific questions or 
solutions to various problems. Also, clicking the [Help] button on the 
error message window displays the details of the error or solutions to 
the error. Refer to Help before contacting us.

Indication Meaning

! CAUTION Indicates a potentially hazardous situation which, if not 
avoided, may result in minor to moderate injury or equipment 
damage.

Emphasizes additional information that is provided to ensure 
the proper use of this product.

^ Reference Indicates the location of related reference information.

[ ] Indicates the names of buttons, menu options, setting 
options, windows/sub-windows, and icons that are displayed 
in a window.
Example: Click [OK].
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Warranty Shimadzu provides the following warranty for this product.

1. Period: Please contact your Shimadzu representative for information 
about the period of this warranty. 

2. Description: If a product/part failure occurs for reasons attributable to 
Shimadzu during the warranty period, Shimadzu will repair or 
replace the product/part free of charge. However, in the case of 
products which are usually available on the market only for a 
short time, such as personal computers and their peripherals/
parts, Shimadzu may not be able to provide identical replacement 
products.

3. Limitation of 
Liability:

1) In no event will Shimadzu be liable for any lost revenue, profit or 
data, or for special, indirect, consequential, incidental or punitive 
damages, however caused regardless of the theory of liability, arising 
out of or related to the use of or inability to use the product, even if 
Shimadzu has been advised of the possibility of such damage.

2) In no event will Shimadzu's liability to you, whether in contract, tort 
(including negligence), or otherwise, exceed the amount you paid for 
the product.

4. Exceptions: Failures caused by the following are excluded from the warranty, 
even if they occur during the warranty period. 

1) Improper product handling

2) Repairs or modifications performed by parties other than Shimadzu 
or Shimadzu designated companies

3) Product use in combination with hardware or software other than that 
designated by Shimadzu

4) Computer viruses leading to device failures and damage to data and 
software, including the product's basic software

5) Power failures, including power outages and sudden voltage drops, 
leading to device failures and damage to data and software, 
including the product's basic software

6) Turning OFF the product without following the proper shutdown 
procedure leading to device failures and damage to data and 
software, including the product's basic software

7) Reasons unrelated to the product itself

8) Product use in harsh environments, such as those subject to high 
temperatures or humidity levels, corrosive gases, or strong vibrations

9) Fires, earthquakes, or any other act of nature, contamination by 
radioactive or hazardous substances, or any other force majeure 
event, including wars, riots, and crimes

10)Product movement or transportation after installation

11)Consumable items
Note: Recording media such as CD/DVD-ROMs are considered 
consumable items.

* If there is a document such as a warranty provided with the product, or there is a separate contract agreed upon that 
includes warranty conditions, the provisions of those documents shall apply.

* Warranty periods for products with special specifications and systems are provided separately.

* The license cannot be reissued if you lose the license certificate or the USB dongle.
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1What is LabSolutions?

This software is a workstation for high-performance liquid chromatograph mass spectrometer 
systems (hereafter referred to as “LCMS”). 

It enables control of LC and MS units from a personal computer (PC), and perform tasks such as 
chromatogram data acquisition, data analysis, report generations, and data management. 

This chapter introduces the main features and functions of the software. 

1.1 Features

 Abundant Functions with Simple Operations

Assistant Bar
Click an icon on the assistant bar to change the display to the target operation sub-window. Icons 
displayed on the assistant bar can be customized to support a wide variety of operations. 

Data Explorer
The file content is displayed by dragging-and-dropping the file from the [Data Explorer] sub-window onto 
the target sub-window. 

Outstanding file management functions are provided for copying, moving, and deleting files, and for 
browsing the history information of files. 

Batch Table Wizard
Batch Tables for sequential analysis of multiple samples are easily set by following the on-screen 
instructions. 

Data Browser
The [Data Browser] window enables import and browsing of up to 64 data files.

Quant Browser
The [Quant Browser] window enables browsing of multiple quantitative calculation results that were 
acquired using the same method.

 Enhanced Identification and Quantitative Processing Functions
This software supports a variety of identification methods such as window, band, spectrum similarity, 
absolute retention time and relative retention time. There are 6 different quantitative calculation methods 
that include the external and internal standard methods, and 7 types of calibration curves such as linear 
and exponential. 

 Highly Flexible Report Format
The report format function offers a high degree of flexibility by allowing creation of reports such as 
chromatograms, calibration curves, quantitative results, summary reports, and data analysis reports. 

This software has a substantial selection of pre-installed report format templates, making it easier to create 
the desired report format. 
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 Enhanced GLP/GMP Support Functions
The software contains functions that provide sure and efficient compliance with reliability requirements 
mandated in various regulations such as GLP/GMP and FDA 21CFR Part 11. 

FDA 21 CFR Part11 Compliance
The electronic record and electronic signature functions of this software comply with the requirements of 
21 CFR Part 11.

Information such as data measurement methods, schedules, date/time, operator name, and 
chromatograms can all be saved at once, and human and machine readable data can be saved together 
as required for compliance with Part 11.

When used in combination with the optional CLASS-Agent Manager, this software meets the Part 11 
requirements for electronic records and electronic signatures for review, approval and long-term storage of 
data.

User Administration
The Shimadzu User Authentication Tool administers users on the Shimadzu network. Account policies 
such as the minimum number of characters in passwords, password update interval, and permitted number 
of entry attempts are set to prevent illegal accessing. 

System Administration
The software is also has an audit trail function and log browser function for sure and efficient operation of 
the system. The audit trail function records a history of changes to instrument parameters and data 
processing parameters, and the log browser function allows for a quick search of the system operation 
history. 

The functions have been efficiently arranged to allow the extensive range of functions to be easily put to 
effective use. 

1.2 Basic Knowledge
The software is comprised of the following programs:

Each of these programs are opened from the [LabSolutions Main] window. 

This section describes how to open the [LabSolutions Main] window and the functions contained therein. 

Program Name Contents
[Realtime Analysis] program Used to enter the data acquisition parameters and acquire the data. 

[Offline Editor] program Allows other method files and batch files to be edited during data 
acquisition, and can register a single or batch data acquisition to the data 
acquisition queue. 

[Postrun Analysis] program Analyzes the acquired data to detect the peaks of chromatogram and 
perform quantitative calculations on these peaks. 

[Browser] program Allows importing and browsing of up 64 data files for [Data Browser] 
window or 1024 data files for [Quant Browser] window.

[Security Policy Settings] program
[User Administration] program

Administers the system security and user accessibility to the software. 
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 Open the [LabSolutions Main] Window

The  (LabSolutions) icon is displayed on the Desktop. 

1 Verify that the [LabSolutions Service] icon in the Systray on the Taskbar displays a 

green chromatogram. 

A yellow chromatogram in the [LabSolutions Service] icon indicates that the software is still initializing. Wait 
for the chromatogram to turn green. A red chromatogram in the [LabSolutions Service] icon indicates that an 
error has occurred. Restart the PC. 

2 Double-click the  (LabSolutions) icon on the Desktop. 

3 Select a registered user ID from the [User ID] list, enter the [Password] and click [OK]. 

Select [Admin] in the [User ID] list for the first login to the system, and click [OK]. 

The [LabSolutions Main] window opens. 
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 [LabSolutions Main] Window
The [LabSolutions Main] window displays an icon bar and a box for selecting a specific operation of a 
selected icon. 

• Depending on the specific user’s rights, the program icons in the icon bar of the [LabSolutions Main] 
window are sometimes not displayed or are disabled. 

• Click  at the top right corner of the sub-window to close the [LabSolutions Main] window. 

Icon Bar Explanation
Click this icon to display icons for each of the instruments connected to the PC. Tables or icons can 
be displayed in the [Instruments] sub-window. Right-click on the [Instruments] sub-window, and click 
[Table View] from the displayed menu. The display changes to the table display. 
Double-click an instrument icon to open the [Realtime Analysis] program. The [Realtime Analysis] 
program is used to set the data acquisition parameters, acquire data and check the operating status 
of the instruments. 

[Table View]

Click this icon to open either the [Postrun Analysis] program to analyze data or the [Browser] 
program to display chromatograms and statistical calculation results from multiple data files. 

Click this icon to perform system administration functions related to the security policy, user 
administration, system settings, and validation. 

Click this icon to select a specific PDF formatted Instruction Manual or the Help files. 
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 Basic Functions of the [Realtime Analysis] and [Postrun Analysis] Programs
This section describes the [Data Acquisition] window in the [Realtime Analysis] program. 

No. Explanation

1 The title bar displays the name of the currently running program, window name, currently loaded file name, 
logged in user name, and other information. 

2 The menu bar displays the menus that are enabled according to the current window and rights of the logged in 
user. 

3 The toolbar displays icons for frequently used menu items and icons for operating analytical instrument. 

4 Different sub-windows such as [Data Acquisition] and [Realtime Batch] can be displayed in this section of the 
[Realtime Analysis] program. 
Sub-windows such as [Data Analysis], [PDA Data Analysis], [Calibration Curve], and [Report] are displayed in 
the [Postrun Analysis] program. Use the tabs under each sub-window or the icons in the assistant bar to 
change the displayed window. 

5 The [Instrument Monitor] displays the status of the instruments and the parameter settings.

6 The [Output Window] displays a history of data acquisition operations and error messages that occur.

7 The [Data Explorer] sub-window displays the currently selected folder with the project file types (extensions) 
selectable from the lower tabs. The content of files is displayed by dragging-and-dropping the file in the [Data 
Explorer] sub-window onto the data analysis sub-window. 

8 The assistant bar displays icons for the frequently used data acquisition operations. Click an icon on the 
assistant bar to change the data analysis sub-window. Icons displayed on the assistant bar can be customized 
to support a wide variety of operation flows. 

9
Click  to exit the program. 

1

2

3

9

8

7

6

4

5
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1.3 File Formats
The software uses the following file formats to handle acquired data and related information:

• Method files

• Data files

• Report format files

• Batch files

• UV spectrum files

• Other files

This section describes each of the file formats.

1.3.1 Method Files
Method files store information such as instrument parameters and data processing parameters. 

The file extension for method files is “.lcm”.

Method files store the following information.

1.3.2 Data Files
The software stores the method files, batch files and report format files, chromatogram data, and 
quantitation results in a single data file. This is called an “All-In-One” structure and, since the data 
acquisition and analysis parameters are referenced from the same data file, it ensures the traceability of 
data.

The file extension for data files is “.lcd”.

• The report formats are also saved to the data file. Click [Data Report] on the [File] menu, then select 
[Print] to print the acquisition results of the currently loaded data file according to the report format stored 
with that data.
The report format can be edited by clicking the [Data Report] icon in the [Data Analysis] assistant bar to 
display the [Report] window. Click [Save Report Format File As] on the [File] menu to save the edited 
format for use with other data reports.

• When postrun analysis is performed on chromatogram data, the new data processing parameters are 
saved to the data file. [Apply to Method] on the [Data Analysis] assistant bar or [PDA Data] assistant bar 
must be clicked to save the parameters and allow them to be applied to other chromatogram data. 

Reference
Refer to "4.7 Save (Export) to Method Files" P.126 for more information.

Stored Information Explanation
System Configuration 
Information

System configuration information is saved in the method files to allow for review of 
the instrument parameters.

Instrument Parameters This information includes the instrument parameters for each instrument and also the 
baseline evaluation results.

Data Processing 
Parameters

Calibration curve information, column performance parameters, QA/QC parameters, 
peak integration parameters, identification parameters, quantitative parameters, and 
Compound/Group Tables are all saved in the method file. 

Sub-Window Properties The chromatogram XY range setting, whether the status bar is displayed or hidden, 
etc. are also saved in the method file.
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1.3.3 Report Format Files
Items such as pictures or logos and placeholders for chromatograms, results and etc., are pasted into the 
blank format and it is saved for future printing of data acquisition results.

The file extension for report format files is “.lsr”.

If a report format file is set at the time of data acquisition or postrun analysis, the results can be 
immediately printed according to that format.

Reference
Refer to "7 Report Function" P.245 for information on how to set the batch file. 

1.3.4 Batch Files
Data such as sample information and quantitative calculation conditions, are saved to a batch file during 
sequential measurement of multiple samples.

The item displayed in the Batch Table and the overall batch processing parameters are also saved to the 
batch files.

The file extension for batch files is “.lcb”.

Reference
Refer to "3 Realtime Batch" P.43 for information on how to set the batch file.

1.3.5 UV Spectrum Files
The software uses the JCAMP format with the file extension of “.jcm” for the UV spectrum file.

When peak identification using the similarity of UV spectra is performed, jcm files are included in the 
Compound Table as standard spectrum.

The “.jcm” files can also be registered as spectra to the UV library files. 

1.3.6 Other Files
The software uses the following files in addition to those described above.

File Name Contents
LCMS Tuning File These files store the conditions used to perform instrument adjustment (tuning) and 

the tuning results. The file extension is “.lct”.

UV Library Files These files contain multiple UV spectrum data. They are used to perform library 
searches on the spectrum information for unknown samples.
The file extension is “.llb”.

MS Library Files These files contain multiple MS spectrum data. They are used to perform library 
searches on the spectrum information for unknown samples.
The file extension is “.lib”.

Browsing Files These files store information such as compound information displayed in 
[Quantitative Results View] and the names of method and data files loaded in the 
[Quant Browser] window.
The file extension is “.lcq”.

Layout Files These files store information such as data file names and display layouts loaded in 
[Data Browser].
The file extension is “.lyt”.

System Configuration Files These files hold the link information for the PC and analytical instruments, names of 
the instruments that make up the system, and information on consumables. These 
file names are not used for regular operations.

PDF Files These files contain electronic versions of printed reports.
These files are a generic format that satisfies the requirement of human readable 
data, and are used when registering and managing the data acquisition result reports 
in a database.
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2Data Acquisition

This chapter describes the basic flow of operations from entrance of the data acquisition parameters 
to the performance of a single run data acquisition on the LCMS. 

2.1 [Data Acquisition] Window
Two views of the [Data Acquisition] window are available, the [Chromatogram View] is used to display 
chromatograms and instrument status information and the [Instrument Parameters View] is used to display 
the parameters set for each instrument. 

2.1.1 Open the [Data Acquisition] Window

1 Click the  icon.

2 Select and double-click the instrument that will be used for data acquisition. 

The [Realtime Analysis] program opens. 
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3 Click the  (Data Acquisition) icon on the [Main] assistant bar. 

If the  (Data Acquisition) icon is not displayed, click  on the title of the assistant bar. 

4 Ensure that [Ready] is displayed in the [Data Acquisition] window. 

If [Not Connected] is displayed on the status display, refer to "3 System Configuration" in the 
Installation & Maintenance Guide. 
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2.1.2 [Data Acquisition] Window Description
This section describes how to view and use the [Data Acquisition] window. 

No. Explanation

1 Displays the [Standard] toolbar, [Data Acquisition] toolbar, [Instrument Control] toolbar,  [LC Control], and [PDA 
Control] toolbar. 

2 Displays chromatograms and the instrument status curves. 
A [PDA] tab is displayed when a PDA is configured. 
An [MS] and [ALL] tab are displayed when an MS is configured. 

Reference
Refer to "2.3.1 Monitor the Chromatograms and Instrument Status Curves" P.23 to display the status 
information of instruments.

3 Displays the instrument status and parameter settings. 

4 Click  to transfer the data acquisition settings set in [Instrument Parameters View] to the analytical 
instrument.

Reference
Refer to "2.2.5 Analytical Instrument Startup" P.22 for details. 

5 Displays the instrument parameters for data acquisition. 
In the [Normal] sub-window, the main data acquisition parameters are set on the [MS], [Simple Settings] and 
[LC Time Prog.] tabs. 
In the [Advanced] sub-window, a tab for each configured instrument module is displayed so that data 
acquisition parameters can be set in more detail. 

6 Switches between the full screen and normal display. 

[Chromatogram View]2

6

Toolbar1

5 [Instrument Parameters View] 3 [Instrument Monitor]4
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2.2 Enter Data Acquisition Parameters
Enter the data acquisition parameters in [Instrument Parameters View]. 

The parameters are saved to the method file and used to perform data acquisition. 

This section describes the operations in the [Instrument Parameters View] . 

2.2.1 Switch Between the Displays of Instrument Parameters View
[Instrument Parameters View] has two sub-windows, [Normal] and [Advanced]. 

In the [Normal] sub-window, the main data acquisition parameters are set on the [MS], [Simple Settings] 
and [LC Time Prog.] tabs. In the [Advanced] sub-window, a tab for each configured instrument module is 
displayed so that data acquisition parameters can be set in more detail. 

This section describes how to set the data acquisition parameters and create a method file. 

1 Click [Normal] to open the [Normal] sub-window. 

2.2.2 Set the LC Instrument Parameters
This section describes how to set the LC instrument parameters on the [Simple Settings] and [LC Time 
Prog.] tabs.

1 Click the [Simple Settings] tab and enter the data acquisition parameters. 

Set the [LC Stop Time], pump flow rate and initial concentration for gradient systems, oven temperature, 
detector wavelength and other parameters. 

• Enter the data acquisition time from one sample injection to the next sample injection at [LC Stop 
Time]. 

• Click [Apply to All acquisition time] to set the [End Time] for each detector to the same value as [LC 
Stop Time]. 

• Deselect [Oven] when the oven is not used.

• To switch the detector lamp off, make this setting on the respective detector in the [Advanced] 
sub-window. 

• The MS detector measurement time is displayed on the [Simple Settings] tab, but it cannot be 
edited. Set the MS detector measurement time on the [MS] tab. 
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• The [Auto-purge] tab is displayed when an auto-sampler is used.
Refer to "2.3.2 Auto-Purge the Pump and Autosampler" P.27 for details.

• If a new method file is made and the rack set at [Sample Rack] on the [Autosampler] tab does not 
match the actual rack in use, an error message is displayed and data acquisition cannot be 
started.
Click [Detect Rack] on the [Autosampler] tab in the [Advanced] sub-window to correct the rack 
selection.

2 Click the [LC Time Prog.] tab, and enter the concentration gradient conditions. 

When switching the concentration gradient or valve during data acquisition, set [Time], [Unit], [Command], 
and [Value] for the time program. Clicking [Draw Curve] plots the time program gradient condition settings 
on the graph. 

The time entered in the [Time] column of the time program corresponds to the time elapsed since the 
start of analysis. Enter a value of at least 0.01 min. 

2.2.3 Set the MS Instrument Parameters
This section describes how to create events and specify settings on the [MS] tab. This instrument keeps 
changing MS conditions within the same data acquisition process. Each individual MS condition is called 
an "event," and polarity can be set to each event. When multiple events are registered, the next event is 
switched to after the "event time" set for each event has elapsed. When the last event is carried out, gain 
tothe first event is returned to. (In the case of 1 [min] in the example in the figure below, Event 1 Event 2 
 Event 1, and in the case of 2 [min], Event 2  Event 3  Event 2, and so forth) The total time required 
to execute a series of concurrent events is called loop time. 
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1 Click the [MS] tab.

2 Select the polarity and data acquisition mode for the event to add. 

1 Select the polarity of the event to set. 

2 Click the button for the event’s data acquisition mode. 
The event is now added to the Event Table. 

The button name for the data acquisition mode changes depending on the selected polarity. When 
[Positive] is selected, the button name includes a plus symbol, such as [MRM(+)] or [Product Ion 
Scan(+)]. 

No Explanation
1 Select the polarity and acquisition mode for an event to add and add the event to the Event Table. 

2 Displays an overview of events for registered data acquisition modes. 

3 Sets the details of the event selected in the Event Table.

2
1

1

2

3



 Operators Guide   15

2.2  Enter Data Acquisition Parameters

2

3 Sets detailed parameters for events. 

Settings differ depending on the data acquisition mode. 

For MRM
Q1 and Q3 are both parameters for the SIM measurement mode. 

No Explanation
1 Sets the measurement start time and end time for the event. 

2 Sets the compound name of the component to measure. Each MRM event sets measurement conditions 
for one component. 

3 Sets the m/z values for precursor ions and product ions obtained by fragmenting precursor ions. Up to 32 
channels can be set. Set the target and referenced ion m/z for 1 compound in each channel in the same 
MS event.The chromatogram in ch1 is used as the target and the chromatogram in ch2 is used as the 
reference ion by default.
Sets the time and collision energy values required to load chromatograms via the specified channel. 
A method optimization function is available for fine tuning m/z values for precursor ions and product ions 
and automatically searching for product ions. 
See "9 Method Optimization" P.285.

4 Sets the time required for a single event. When the MS event time is long, the shape of chromatogram 
will be changed as the sampling rate is long. When the MS event time is short, it will affect the sensitivity 
and the reproducibly as the sampling rate is short.

3

4

1 2
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For Product Ion Scanning
Q1 and Q3 are parameters for SIM and scan measurement modes, respectively. 

No Explanation
1 Sets the measurement start time and end time for the event. 

2 Sets the m/z range for scan measurements. 

3 Sets the m/z value for the specific precursor ion measured by Q1 and collision energy values to obtaine 
product ion by fragmenting precursor ions.
Fragment ions obtained by fragmenting precursor ions at the m/z value set here are measured by Q3. 

4 Sets the time required for a single event. When the MS event time is long, the shape of chromatogram 
will be changed as the sampling rate is long. When the MS event time is short, it will affect the sensitivity 
and the reproducibly as the sampling rate is short.

2 1

3 4
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For Precursor Ion Scanning
 Q1 and Q3 are parameters for scan and SIM measurement modes, respectively. 

No Explanation
1 Sets the measurement start time and end time for the event. 

2 Sets the scan range for all precursor ions included in product ions set at [Product Ion m/z]. 

3 Sets the m/z value for the specific product ion measured by Q3 and collision energy values to obtaine 
product ion by fragmenting precursor ions. 

4 Sets the time required for a single event. When the MS event time is long, the shape of chromatogram 
will be changed as the sampling rate is long. When the MS event time is short, it will affect the sensitivity 
and the reproducibly as the sampling rate is short.

12

43
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For Neutral Loss Scanning
Q1 and Q3 are both parameters for the scan measurement mode that keeps the mass difference 
constant. 

4 Repeat steps 2 and 3 to add the event to the Event Table. 

No Explanation
1 Sets the measurement start time and end time for the event. 

2 Sets the m/z range of scan measurements. 

3 Sets the neutral loss value and collision energy values to obtaine product ion by fragmenting precursor 
ions. 
It scans Q1 in the m/z measurement range, then scans Q3 in the m/z range decreased by this value. 

4 Sets the time required for a single event. When the MS event time is long, the shape of chromatogram 
will be changed as the sampling rate is long. When the MS event time is short, it will affect the sensitivity 
and the reproducibly as the sampling rate is short.

12

43
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 Insert an Event
Right-click on the event where the event is to be inserted in the Event Table. Click [Insert] on the displayed 
menu, and select an appropriate data acquisition mode. 

A new event is inserted. 

 Change the Data Acquisition Mode 
To change the data acquisition mode for an event that is already registered, select an appropriate data 
acquisition mode from the dropdown list box to the left of [Acq. Time]. 

The polarity cannot be changed for events that are already registered. To change the polarity, register the 
event again. 



2  Data Acquisition

20   Operators Guide

 Delete an Event
Right-click on the event to delete in the Event Table, then click [Delete] on the displayed menu. 

• Events can also be deleted by selecting the event and pressing the [Delete] key. 

• Multiple events cannot be deleted at the same time. 

 Set the Same Measurement Time for All Events 
Right-click on the events in the Event Table for which the measurement time is entered, then click [Set 
Same Measurement Time] on the displayed menu. 
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2.2.4 Save Data Acquisition Settings in a Method File

1 Click [Save Method File As] on the [File] menu.

The [Save Method File As] window is displayed.

2 Enter the file name, and click [Save]. 

A method file is created with the specified file name and the new instrument parameters are saved to the 
file. 
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2.2.5 Analytical Instrument Startup
This section describes how to transfer (download) instrument parameters to an analytical instrument and 
the procedure for starting the instrument. 

1 Drag-and-drop the desired method file onto the [Data Acquisition] window from the 
[Data Explorer] sub-window. 

If the [Data Explorer] sub-window is not displayed, click the  (Toggle Data Explorer) button on 

the tool bar. 

The content of the method file is displayed in the [Data Acquisition] window. 

2 Check the instrument parameters, and click . 

The instrument parameters are transferred to the analytical instrument. 

3 Click the  (Instrument On/Off) button on the toolbar. 

Pump solvent delivery and oven temperature control are started. 

If the instrument is already activated when the method file is downloaded, operations are started 
using the downloaded instrument parameters. 

4 Click (MS Instrument On/Off) on the toolbar.

DL heater and heat block temperature control are started.
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2.3 Data Acquisition Preparation
This section describes the procedures to perform before starting data acquisition, such as auto-purging of 
the pump and autosampler, and verification of column equilibration (baseline check). 

2.3.1 Monitor the Chromatograms and Instrument Status Curves
This section describes how to monitor chromatograms displayed in [Chromatogram View] and instrument 
status curves. 

 Chromatogram Display Settings
The chromatogram display scale can be changed. 

This section describes how to monitor chromatograms on multiple channels. 

1 Right-click on the graph in [Chromatogram View], and click [Display Settings]. 
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2 Click the [LC] tab and enter the necessary parameters. 

1 Click [Overlay] to draw chromatograms overlaid. 

2 Enter the detector intensity range for the Y-axis. 
Click [Normalize] so that the intensity range falls within the minimum and maximum values of the 
currently displayed chromatogram. 

3 Select the detector (or channel in Dual Mode) and the display unit for the Y-axis. 

The intensity range of each detector (or channel in Dual Mode) cannot be set in the [Overlay] 
mode.

3 Click the [MS] tab and enter the necessary parameters.

1 Select [Base Shift] to display each MS chromatogram in the Base Shift view. 

2 Set the event number of MS chromatograms to display.

3 Enter the m/z value of the desired MS chromatogram. 

Enter “TIC” to display TIC.

To display an MS chromatogram of an SIM event or MRM event, select the corresponding m/z value 
in the dropdown list box. 

2

1

3

2

3

1
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4 Click the [General] tab, enter the necessary parameters, and click [OK]. 

1 Select [Sample Name], [Sample ID] and [Data Comment]. 

The sample information is displayed in the status display of the [Data Acquisition] window. 

2 Enter the [Time Range] for the X axis display range. 
Click [Normalize] to set the display range of the X-axis to either the [LC Stop Time] currently set in 
the method file or the longest detector time. 

5 Click the  (Save) button on the toolbar. 

The time range and intensity range are saved to the method file. 

• Settings other than the time range and intensity range are stored to memory for each user and 
instrument. 

• The [PDA] and [UV Spectrum] tabs are displayed when a PDA detector is used. 

• The [MS] and [ALL] tabs are displayed when an MS detector is used.

• Click [Plot] to monitor the multi chromatograms of the PDA detector. 
When the plot is started, the system status changes to [Plot]. 
Click [Stop] to stop the plot. 

• The reference chromatogram can be drawn overlaying [Chromatogram View]. 
Click [Open Reference Data File] in the [File] menu to select and display the reference 
chromatogram. The reference chromatogram cannot be drawn overlaying MS data. 

1

2
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 Display Instrument Status Curves
The instrument status curves that can be displayed on the graph in [Chromatogram View] include [Pump 
Press.], [Oven Temp.], [Room Temp.], and [Detector Cell Temp.]. 

1 Right-click on the graph in [Chromatogram View], and click [Display Settings]. 

2 Click the [Status] tab, enter the necessary parameters, and click [OK]. 

1 Select the desired display items in [Draw Status Curve]. 

2 Set the display range for each status item.

3 Select the type of status to display on the intensity axis on the right of the graph. 

The selected status is displayed on the graph. 

• Settings are stored to memory for each user and instrument. 

• Status cannot be displayed on MS chromatograms. 

1

2

3
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2.3.2 Auto-Purge the Pump and Autosampler
The mobile phase in the pump and the autosampler syringe rinse solution can be automatically purged. 

A function is also provided to deliver solvent at a lower mobile phase flow rate after the autopurge ends 
until the column oven reaches its preset temperature. 

Autopurge is executed in the following order: purging of pump  purging of autosampler  purging at 
initial concentration conditions (when pump mode is other than Isocratic)  warm up. 

The [Autopurge] tab is displayed when an autosampler is used. 

1 Click the [Autopurge] tab in [Instrument Parameters View], and set the autopurge 

conditions for the pump. 

1 Select the lines to be purged from the [Mobile Phase Name] list. 

2 Enter a [Purge Time] for each line. 

2 Set the autopurge conditions for the autosampler. 

1 Select [Autosampler] . 

2 Enter the [Purge Time]. 

1 2

21
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3 Set the [Warm-up] conditions. 

1 Enter the [Wait time] and [Flow]. 

• [Warm up] is used to deliver solvent at a lower flow rate after purging of the autosampler ends 
until the oven reaches its preset temperature. 

• Enter “0” min at [Wait time] to disable the [Warm up] function. 

4 Click the  (Save) button on the toolbar. 

The settings are saved to the method file. 

5 Click the  (Autopurge) button on the toolbar. 

Autopurge is started. 

• Click the  (Purge autosampler) button on the toolbar. The purge is executed by [Purge Time] set on 

the [Autosampler] tab. 

• After the autopurge ends, column equilibration can be checked using the baseline check function. 

Reference
 Refer to "2.3.3 Check the Baseline" P.29 for information on the baseline check procedure. 

1
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2.3.3 Check the Baseline
Use the baseline check function to determine whether the baseline noise and drift values are within the 
preset time and at or below the threshold for each channel. 

1 Click [Baseline Check Parameters] from the [Method] menu in the [Data Acquisition] 

window. 

2 Set the baseline check parameters, and click [OK]. 

1 Select the noise calculation method.

2 Select [Noise] and [Drift]. 

3 Enter the time and threshold used for checking [Noise] and [Drift]. 

4 Enter a [Maximum Time] to performing repeat the evaluation if the checks “fail”. 

Select a [Failure Action] to be taken in the event of a baseline check failure. The [Failure Action] 
parameter is used when [Baseline Check] is used in the Batch Table. 

3 Click the  (Save) button on the toolbar. 

The settings are saved to the method file. 

4 Click on the  (Baseline Check) button on the toolbar. 

The baseline check is initiated, and the results of the baseline check are displayed after measurement 
ends. 

• The results of the baseline check are saved in the C:\LabSolutions\Log\Baseline folder. 

• PDA baseline check cannot be performed for a channel set to [Max Plot] in the [Wavelength] 
column of the [Multi Chrom] tab in the [Data Processing Parameters] sub-window. 

• The baseline check cannot be performed for MS detectors. 

1

4
2 3
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2.3.4 Calculate the Baseline Slope (Slope Test)
When the Slope Test is performed, the baseline of the chromatogram is measured to automatically 
calculate the Slope value. 

The calculation results of the Slope Test can be set as the Slope value for the peak integration parameters. 

1 Right-click on the graph in the [Chromatogram View], and click [Slope Test]. 

2 Click [Set to Parameter] to enter the on-screen value into the data processing 

parameters. 

The data processing parameter [Slope] value is set. 

• The Slope value is generally rounded up to value that is larger than the calculated value. 
For example, a Slope value of “1988” is changed to “2000”. 

• The Slope Test cannot be performed with MS detectors. 

3 Click the  (Save) button on the toolbar. 

The Slope value is saved to the method file. 

The Slope Test cannot be executed during data acquisition or during PDA plotting. 



 Operators Guide   31

2.3  Data Acquisition Preparation

2

2.3.5 Check the Condition of Consumables (System Check)
Check the system to verify that it is in good condition before starting data acquisition by checking the use 
frequency of the instrument consumables (i.e. the system check). 

Users are required to have the [Run System Check] rights to execute the system check. 

1 Click the  (System Check) icon on the [Main] assistant bar. 

2 Select the items to check, and click [Run]. 

1 Select [Consumables Check]. 

2 Select [MS Check]. 

3 Click [Advanced], and select the items to perform the system check on. 

4 Select [Report Out] to automatically print the system check results. 

• When using the LC-2010/LC-2010HT, logs recorded on instruments can be displayed in result 
reports. Up to 50 logs (30 on the CMD) can be displayed. 

• When using an LC or photodiode array detector, set the system check method on each of their 
respective tabs. 

• If [Advanced Report] is selected, the system check is executed on all items. 

• Click [Advanced] in the [System Check] sub-window, and select [UV Detector Wavelength Check] 
to simultaneously check the wavelength on the UV detector.

1
2
4 3



2  Data Acquisition

32   Operators Guide

3 After the system check ends, click [View Results]. 

The [System Check Results] sub-window opens. 

• Click [Print] in the [System Check Results] sub-window to print the system check results. 

• The system check results are saved to a file named according to the following rule:
“SysChk#_YYYYMMDDHHMMSS.lcs” (where, “#” is the system number.) 

• To check the results of previous system checks, click [Load] in the [System Check Results] sub-window, 
and select the desired results. 

• Set [System Check] in a Batch Table, to check the use frequency of instrument consumables before 
starting data acquisition. Refer to "3.2.3 Batch Table Parameters" P.52 for details.

• Realtime batch can be canceled according to the results of the system check by using the Batch Table 
action function.

• The system check is based on the consumable criteria of each instrument. Check consumable criteria in 
the [System Check] sub-window by clicking [System Check] in the [Properties] sub-window of each 
instrument. 

• Click [Reset] to open the [Consumables Reset] sub-window. 
Reset the consumables when they have been replaced. 

• Users are required to have the [Edit System Configuration] rights to set system check criteria. 
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2.3.6 Control Toolbar
Change instrument status such as pump solvent delivery on/off, autosampler purge and rinse, oven control 
on/off, detector zero correction, and MS detector on/off using the [LC Control] toolbar, [PDA Control] 
toolbar and [MS Control] toolbar. 

The displayed buttons vary depending on the system configuration of the instrument. 

[LC Control] toolbar

[PDA Control] toolbar

Button Name Explanation

Instrument On/Off Turns the ACTIVATE feature of the SCL-10Avp/SCL-10Asp system 
controller on/off.
This button controls the pump and column oven for the CBM-20A/20Alite.

Controller LCD On/Off Turns the LCD of the SCL-10Avp/SCL-10Asp system controller on/off. 

Controller Lock/Unlock Locks or unlocks keypad control of the SCL-10Avp/SCL-10Asp system 
controller. Only software control is permitted when keypad control is 
locked. This button is used to prevent operational errors. 

Pump On/Off Turns the solvent delivery pump on/off. 

Purge autosampler Executes an autosampler purge according to the [Purge Time] set on the 
[Autosampler] tab in [Instrument Parameters View]. 

Rinse autosampler Rinses the autosampler and sampling needle. 

Oven On/Off Turns the column heater oven on/off. 

Zero Detector A Returns the signal intensity of detector A to zero. 

Button Name Explanation

PDA Detector Lamp On/Off Turns the PDA detector lamp on/off. 

Zero PDA Detector Returns the signal intensity of the PDA detector to zero. 
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[MS Control] toolbar

If the toolbar is hidden, use the right-click popup menu on the menu bar, and select the desired toolbar from 
the displayed menu. 

Button Name Explanation

MS Instrument On/Off Turn on/off the heater and gas in 1 operation.

Open/Close Drying Gas Turns the drying gas on/off.

This item is displayed for an ESI, DUIS, APCI or Micro-ESI interface.

Open/Close Nebulizing Gas Turns the nebulizer gas on/off. 

This item is displayed for an ESI, DUIS, APCI or Micro-ESI interface.

Open/Close Heating Gas Turns the heating gas on/off. 

Displayed for LCMS-8045/8050/8060 systems with an ESI, DUIS or 
Micro-ESI interface.

Interface Heater On/Off Turns the interface heater on/off. 

Displayed for LCMS-8045/8050/8060 systems with an ESI, DUIS or 
Micro-ESI interface.

DL On/Off Turns the heater of the DL on/off. 

Interface Heater On/Off Turns the APCI heater on/off.

This item is displayed for an APCI interface.

Heat Block On/Off Turns the heater of the heat block on/off. 

IG On/Off Turns the IG (ion gage) on/off. 

MS Detector On/Off Turns the MS detector on/off.
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2.3.7 Instrument Monitor
[Instrument Monitor] displays the instrument status and parameter settings. The instrument settings can be 
changed without changing the instrument parameters in the method file by entering a value in the [Setting] 
cell.

This section describes the procedure for changing the pump flow rate [PumpA. Flow]. 

If the [Instrument Monitor] is not displayed, click the  (Toggle Instrument Monitor) button on the toolbar. 

1 Click the [Pump A Total Flow] cell in the [Setting] column, and enter the new pump flow 

rate. 

2 Press the [Enter] key. 

The flow rate is changed. 

• Change the displayed status items in [Instrument Monitor] in the [Table Style] sub-window. Right-
click on [Instrument Monitor], and select [Table Style] from the displayed menu. 

• If the value in the [Setting] column is changed in [Instrument Monitor], it is not saved to method 
file. 
Details of changes under analysis made are recorded in the operation log, and can be checked in 
the [Logs] sub-window. This sub-window is opened by clicking [Acquisition Log] on the [View] 
menu in the [Data Analysis] / [PDA Data Analysis] / [MS Data Analysis] window
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2.4 Plot
Verify that the MS detector baseline is stable before acquiring data.

1 Check [Instrument Parameter View] and click . 

2 Click [MS Instrument On/Off] on the [MS Control] toolbar. 

The nebulizer gas is turned on, and heating of the DL and other operations are started. 

3 When the temperature of the DL and heat block reaches the set value on [Instrument 

Monitor], click the [Plot] icon in the chromatogram view. 

Verify that the MS detector baseline is stable. 

2.5 Single Run
There are two ways of acquiring data, by single run (only one data acquisition), or by realtime batch 
(sequential analysis of multiple samples). 

This section describes the procedure for a single run. 

Verify that [Ready] is displayed on the status display. 

Reference
Refer to "3 Realtime Batch" P.43 for information on sequential analysis of multiple samples. 

2.5.1 Execute Single Run
Execute single run from the [Data Acquisition] window. 

1 Click the  (Start Single Run) icon on the [Acquisition] assistant bar. 
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2 Set the acquisition conditions, and click [OK].

1 Enter the data file name. 

2 Select [Auto-increment], and the number type. 
The data file name is automatically appended with an incremental number. 

Example: “TEST-001.lcd”

When [Auto-increment] is selected, the file is not overwritten even if the file name was previously 
used. 

3 Enter the position of the sample for [Vial#] and [Tray]. 

Enter “-1” to acquire data without injecting samples from the autosampler. 

4 Enter the sample injection volume.

Single run is started. 
During data acquisition, the [LabSolutions Service] icon in the Systray on the Taskbar flashes green. 

Data acquisition ends when the data acquisition time in the method file has elapsed. 

Do not turn the PC off while the [LabSolutions Service] icon is flashing. 

1
2

3
4
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2.5.2 Change the End Time During Data Acquisition
The data acquisition time can be changed during data acquisition. 

This section describes the procedure for changing the data acquisition time. 

• During data acquisition, [LC Stop Time] on the [Simple Settings] tab in [Method View] cannot be changed. 

• If the acquisition time is changed using [Change Acquisition Time], a record is created in the operation 
log. 

1 Click [Change Acquisition Time] on the [Acquisition] menu. 

2 Enter an [Acquisition Time], and click [OK]. 

• If multiple detectors are used, click [All Times Change] to changes the data acquisition time to the 
longest detector acquisition time. 

• If [Change to Minimum Value] is selected, click [All Times Change] to change the data acquisition 
time to the shortest detector acquisition time. 

• Click [Apply to Method File] to apply the new acquisition time to the method file and use it for all 
subsequent data acquisitions. However, the MS detector cannot be changed if [Apply to Method 
File] is selected. 

• The MS detector data acquisition time can be lengthened but not shortened. 

• You can not change the value as an analysis time that already passed.

2.5.3 Stop Single Run
Single run can be stopped in the midway to end acquisition earlier than the preset end time. 

1 Click the  (Stop) icon on the [Acquisition] assistant bar. 

Data acquisition is stopped, and a data file is created for the data so far. 
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2.6 Check Analysis Results During Data Acquisition 
(Snapshot)
Execute snapshot during data acquisition to display and process the data obtained since acquisition was 
started. 

This section describes the procedure for executing a snapshot during data acquisition. 

1 Click the  (Snapshot) icon on the [Acquisition] assistant bar. 

The data obtained so far is displayed in the [Data Analysis] window. 

2.6.1 Update Snapshots
Use snapshot update to load cumulative acquired data from a continuing data acquisition after snapshot 
has been executed. 

1 Click the  (Update for Snapshot) button on the toolbar in the [Data Analysis] window. 

The snapshot is updated to display the latest chromatogram. 
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2.7 Automatic Instrument Startup

Use  (Startup) to automatically start the instrument at a specified date and time. 

1 Click the  (Startup) button on the toolbar. 

2 Enter the date and time to start the instrument, and click [OK]. 

1 Set the date and time to start the instrument. 

2 Select [Method File], and enter the method file name. The method file can also be selected by 
clicking . 

When the method file is not specified, the analytical instruments are started up by the 
parameters already downloaded to the instrument (i.e. parameters used in the previous data 
acquisition) when a startup is performed. 

The instrument starts up at the specified date and time. 

• If startup is executed in a batch file(s) registered to the batch queue, the startup begins after 
processing of the previously registered batch file(s) ends. 
For details on the procedure for changing the execution order of batch files registered to the batch 
queue, refer to "3.5 Data Acquisition Using the Batch Queue Function" P.66. 

• Startup can also be set in realtime batch. 
For details, refer to "3.4.2 Start Data Acquisition at a Specified Date and Time (Startup)" P.59. 

2.8 Automatic Instrument Shutdown
Use [Shutdown] to automatically shut down the instrument after data acquisition ends. 

1

2



 Operators Guide   41

2.8  Automatic Instrument Shutdown

2

1 Click the  (Shutdown) button on the toolbar. 

2 Set Cool down Time to shut down the instruments, and click [OK]. 

1 Select [Shutdown Method File], and enter the method file name. The method file can also be 
selected by clicking . 

When a method file is not specified, the analytical instruments are shut down by the parameters 
already downloaded to the instruments when a shutdown is performed. 

2 Enter the time that the instrument is operated by the instrument parameters of the specified method 
file. 

3 Select relevant checkboxes for the gas, heater, or other units to switch off when shutting down the 
instrument. 

The analytical instruments shut down when the [Cool down Time] elapses. 

• When [Real Time Analysis Window Close] is selected, the [Realtime Analysis] program is exited 
after the analytical instruments are shut down. 

• If shutdown is executed in a batch file(s) registered to the batch queue, the shutdown begins after 
processing of the registered batch file(s) ends. 
For details on the procedure for changing the execution order of batch files registered to the batch 
queue, refer to "3.5 Data Acquisition Using the Batch Queue Function" P.66. 

• Shutdown can also be set in realtime batch. 
For details, refer to "3.4.3 Shutdown Analytical Instruments After Data Acquisition (Shutdown)" 
P.60.

1

2

3
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3Realtime Batch

Realtime batch is sequential data acquisition of multiple samples. Execution of realtime batch starts 
with the preparation of a Batch Table. 

This chapter describes the procedures for automating data acquisition. 

• Making Batch Tables

• Baseline check to verify the stability of the baseline

• [Startup] to begin realtime batch analysis at a specified date and time

• [Shutdown] to shutdown the instrument after realtime batch ends

3.1 Display Batch Tables

Click the  (Realtime Batch) icon on the [Main] assistant bar in the [Realtime Analysis] program to 

display the Batch Table. 

3.2 Create Batch Tables
Enter the sample information, vial #, method file name, and data file name in a Batch Table to sequentially 
acquire data from multiple samples. 

This section describes how to create a Batch Table

3.2.1 Batch Table Wizard
Batch Tables can be made easily by using the Batch Table Wizard. 

Some features of the Batch Tables cannot be set with the Batch Table Wizard. It is necessary to directly edit 
the Batch Table to set these functions. 

1 Click the  (Wizard) icon on the [Realtime Batch] assistant bar. 
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2 Enter the parameters, and click [Next]. 

1 Click [New] at [Batch Table] to create a new Batch Table file.
Click [Add] to add a row to the currently displayed Batch Table. 

2 Enter the [Method File]. 

3 Enter the [Injection Volume]. 

4 Select [Qualitative] or [Quantitative] at [MS Data Processing].

5 Enter the data acquisition pattern for the standard samples and unknown samples. 

Enter a number for [Number of Sample Groups] to indicate the number of times the data acquisition 
pattern will be repeated. 

Select [Bracket Calibration] to select the type of bracket quantitation. 

Reference
For details, see "3.4.6 Bracket Quantitation" P.64. 

6 Select [Insert QA/QC Samples] to insert a QA/QC sample.

If [Insert QA/QC Samples] is selected, the [Batch Table Wizard - QA/QC Sample] sub-window is 
displayed. If [Insert QA/QC Samples] is deselected, proceed to Step 4.

1
2
3

5

6

4
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3 Enter the QA/QC sample information, then click [Next]. 
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4 Enter the standard sample information, and click [Next]. 

1 Enter [Sample Name] and [Sample ID] for the standard sample. 

If [Auto-increment] is selected, the [Sample Name] and [Sample ID] are automatically appended with 
an incremental number. 

2 Enter a [Data File Name]. 

Select [Create file names automatically] to automatically generate a data file name. 

Reference
For details, see "Set the Data File Name" P.75. 

3 Set the [Number of Calibration Levels], [Repetitions per Run] and select [Clear all calibrations at the 
beginning] to initialize the calibration curve. 

The final vial No. of the standard sample you have set is displayed at [Vial#] in the Batch Table. 

4 Select [Print Report] and set [Report Format File] to create reports. 

1

2

3

4
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5 Enter the unknown sample information, as with the standard sample, and click [Next].

6 Set the summary report output parameters, and click [Next]. 

1 Select [Print Summary Report] for [QA/QC], and select a [Summary Report Format File]. 

[QA/QC] is not displayed if [Insert QA/QC Samples] is deselected in the [Batch Table Wizard] 
sub-window. 

2 Select [Print Summary Report] for [Analysis], and select the type of sample summary that will be 
reported. 

3 Select the [Summary Report Format File]. 

1

2

3
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7 Select the items to be executed, and click [Next]. 

If [Startup] or [Shutdown] are selected, a setting sub-windows for each item is displayed. (Steps 8 or 9)
If all of these items are deselected, proceed to Step 10. 

8 Select the startup settings, and click [Next]. 

The startup start date and time cannot be set in the Batch Table Wizard. Refer to "3.4.2 Start Data 
Acquisition at a Specified Date and Time (Startup)" P.59 to enter a specified date and time. 

1 Enter an instrument startup time at [Pumping Period].

2 Select [Startup Method File], and enter the method file.

1

2
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9 Select the shutdown settings, and click [Next]. 

1 Select [Shutdown Method File], and enter the method file. 

2 Enter an instrument shutdown time at [Cool down Time]. 

10 Enter a batch file name, and click [Finish]. 

This completes Batch Table setup using the Batch Table Wizard. The batch file is created using the 
specified file name. This Batch Table is displayed in the Batch Table sub-window. Check the contents of the 
Batch Table. 

1

2
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3.2.2 Edit Batch Tables
This section describes 2 functions, [Fill Series] and [Fill Down], that are often used for direct Batch Table 
editing. 

 Append Table Settings with an Incremental Number
The [Vial#], [Sample Name], [Sample ID], and [Data File] entries in the Batch Table are appended with an 
incremental number. 

This section describes how to add an incremental extension to the [Vial#]. 

1 Click the [Vial#] for the top row.

2 Right-click the top [Vial#] cell, and click [Fill Series] from the displayed menu. 

If [Vial#] is blank, the [Vial#] sub-window opens. If a value is entered in the [Vial#] cell that value is 
used incrementally fill the [Vial#] cells in the rest of the table. 

3 If the [Vial#] sub-window is displayed, enter the [Row#], [Vial#], [Repetitions], and select 

[Auto-increment], then click [OK]. 

The [Vial#] column is incrementally filled. 
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[Fill Series]
[Fill Series] functions according to how the cell is selected and the value entered in the cell. 

• If the end of the character string is not a number (ex: “standard sample”)
A 3-digit number is appended starting with the row following the selected cell.
“standard sample”, “standard sample 001", “standard sample 002", and so forth. 

• If the end of the character string is a number (ex: “STD01”)
The cells are filled with STD01, STD02, STD03 and so forth. 

• If only 1 cell is selected (ex: “ABC”)
The cells following the selected cell become ABC001, ABC002, ABC003 and so forth. 

• If multiple cells are selected (ex: “STD1”, “AAA” and “STD5” are selected in this order)
The selected cells are changed to STD1, STD2, and STD3. 

• If a blank cell is selected (ex: a cell in the [Sample Name] column)
The [Sample Name] sub-window opens. Enter the sample name parameters, and click [OK]. 

 Copy Settings
The individual columns of the Batch Table can be copied. 

This section describes how to copy and fill the [Sample Name] column. 

1 Enter a [Sample Name] in the top row. 

2 Right-click the top cell of the [Sample Name] column that is to be copied, and click [Fill 

Down]. 

The contents of the top cell is copied to the subsequent cells of the [Sample Name] column. 
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[Fill Down]
[Fill Down] functions according to how the cell is selected. 

• If only 1 cell is selected (ex: “STD”)
All selected cells following the selected cell become STD. 

• If multiple cells are selected (ex: “STD1”, “AAA” and “STD5” are selected in this order)
All cells become the same STD1 as the initial cell. 

• If a blank cell is selected (ex: a cell in the [Sample Name] column)
The [Sample Name] sub-window opens. Enter the [Sample Name] parameters, and click [OK]. 

3.2.3 Batch Table Parameters
In addition to sample information and sample type, method file, data file, and report output settings, the 
following Batch Table parameters can also be set. 

Parameter Contents

Run mode Determines whether there is a standby period before data acquisition, and whether to 
execute data acquisition and data processing on each row of the Batch Table. 

Background compensation Performs compensation using the blank (solvent only) chromatogram to subtract 
baseline drift or solvent peaks. 

Reference
For details, refer to "3.4.5 Background Data File" P.63. 

System check Performs a system check before data acquisition, enter the system check parameter in 
the top row of the Batch Table. Click the [System Check] cell, and enter the system 
check parameters in the [System Check] sub-window. 

System suitability Checks the suitability of the system based on the analysis results of known multiple 
samples.
The results can be displayed or output in text format. 

Custom parameters Calculation formulas can be set for totaling the peak area of related substances in 
analysis data and for compensating quantitative values. The results are output to a 
Quantitative Results Table or reports. 

Reference
For details, refer to "3.4.7 Custom Calculation Function" P.65. 

Action The batch processing can be controlled according to pass/fail of the check conditions in 
each row of the Batch Table. 

Options 1 to 10 Up to ten additional information columns can be added to the Batch Table. 
Once you enter [Option Title] in <Settings> - [Option Items] Tab, this additional sample
information is saved in the same data as [Sample Name] and [Sample ID].
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 Hide or Display Batch Table Items
Use the [Table Style] sub-window to hide or display columns in the Batch Table. 

This section describes how to add or delete displayed items to the Batch Table. 

1 Right-click on the Batch Table, and select [Table Style]. 

2 Select the desired items, and click [OK]. 

Display Hidden Batch Table Items

1 Select the items to display from the [Hide Items] list. 

2 Click [Add]. 

The selected items are added to the end of the [Display Items] list. 

3 Select an item to change the display order. 

4 Click [Up] or [Down]. 

The top item in the [Display Items] list is displayed in the first (left) Batch Table column. 

1 2 3 4
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Hide Items in the Batch Table

1 Select the items to hide from the [Display Items] list. 

2 Click [Remove]. 

The selected items move to the [Hide Items] list. 

Realtime batch is executed based on settings in the Batch Table even if the items are hidden. 
For example, if a summary report output and summary report format file are entered, the summary 
report is output after realtime batch ends even if these items are hidden in the Batch Table. 

1 32
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3.3 Data Acquisition Using Batch Tables
Perform data acquisition using the Batch Table created in "3.2 Create Batch Tables". 

This section describes partial execution of a Batch Table, how to stop realtime batch, and how to pause 
realtime batch to edit the Batch Table. 

3.3.1 Partial Execution of a Batch Table 
This section describes how to perform data analysis on only part of the Batch Table (1 to 3 rows). 

1 Select the row numbers to be analyzed. 

2 Click the  (Start Realtime Batch) icon on the [Realtime Batch] assistant bar. 

3 Check [Selected Row(s)], and click [Start]. 

A screen for confirming partial execution opens. 

4 In this screen, click [OK]. 

Batch processing of the selected rows is executed. 
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3.3.2 Stop Realtime Batch

1 Click the  (Stop) icon on the [Realtime Batch] assistant bar. 

2 Select the processes to stop, and click [OK]. 

Batch processing is stopped. 

• If only [Data acquisition under execution] is selected, the current data acquisition is stopped and 
processing moves to the next row of the Batch Table, and data acquisition is started on that row. 

• If only [Batch Processing] is selected, processing for the entire Batch Table stops after the current 
data acquisition ends. 

• If both [Data acquisition under execution] and [Batch Processing] are selected, Batch Table 
processing stops in the middle of the current acquisition. 

• When data acquisition is resumed in the row after the stop of batch processing, some information 
such as, pass/fail information for the QA/QC function, may be cleared. 
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3.3.3 Pause Realtime Batch to Edit the Batch Table
Realtime batch can be paused and the non-acquired rows of the Batch Table can be edited (add, insert, 
delete). 

This section describes how to delete a non-acquired row of the Batch Table. 

This operation cannot be performed on rows that have already been acquired. 

1 During realtime batch, click the  (Edit Table/Restart) icon on the [Realtime Batch] 

assistant bar. 

2 Set the row where realtime batch is to be paused, and click [OK]. 

Data acquisition goes into the standby state at the selected row, and batch processing is paused. 

Data acquisition continues until the row selected in the [Pause] sub-windows reached. The [Release 
Paused Status] sub-window opens when the pause is executed.
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3 Select the row to be deleted on the Batch Table, right-click on the selected row, and click 

[Delete Row]. 

The selected row is deleted.

4 Click the  (Save) button on the toolbar. 

The method file is overwritten and saved.

5 Click the  (Edit Table/Restart) icon on the [Realtime Batch] assistant bar. 

Batch processing is resumed from the paused row. 
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3.4 Automation of Data Acquisition Operations
Using the Batch Table to automate data acquisition allows for the automation of baseline check, system 
check, startup and shutdown as well as mobile phase substitution (autopurge). 

This section describes how to automate data acquisition, output of summary reports, background 
compensation, bracket quantitation, and the custom calculation function. 

Use the Batch Table [Action] function to control batch processing actions. 

3.4.1 Check Baseline Stability Before Data Acquisition (Baseline Check)
This section describes how to check the baseline before starting data acquisition. Set the baseline check 
thresholds and other items in the baseline check parameter of the method file. 

The baseline check cannot be performed for MS detectors. 

1 Select [Baseline Check] in the row where baseline check is to be performed. 

Reference
If [Baseline Check] is not displayed in the Batch Table, refer to "Display Hidden Batch Table Items" 
P.53. 

2 Click the  (Save) button on the toolbar. 

The baseline check settings are saved to the batch file. 

3.4.2 Start Data Acquisition at a Specified Date and Time (Startup)
Use realtime batch Startup to automatically start realtime batch at a preset date and time. This section 
describes how to use Startup. 

1 Click the  (Settings) icon on the [Realtime Batch] assistant bar. 
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2 Click the [Startup] tab, enter the conditions for automatically starting the analytical 

instruments, and click [OK]. 

1 Select [Startup]. 

2 When [Set start date and time when starting batch] is selected, the sub-window for entering the start 
date and time is displayed. 

The analytical instruments are started at the specified [Start Date & Time].

3 Select [Method File], and enter the name of the method file that contains the parameters for 
analytical instruments startup. 

• Click  to change the referenced file. 

• Enter a time in [Pumping Period] for the analytical instruments to operate at the initial conditions 
before batch processing begins. 

• If a method file is not specified, the analytical instruments are started up by the parameters 
downloaded to the instruments when the startup is performed. 

3 Click the  (Save) button on the toolbar. 

The startup settings are saved to the batch file. 

3.4.3 Shutdown Analytical Instruments After Data Acquisition 
(Shutdown)
Use realtime batch Shutdown to automatically shut down the analytical instruments after realtime batch 
ends. This section describes how to use Shutdown. 

1 Click the  (Settings) icon on the [Realtime Batch] assistant bar. 

2

3

1



 Operators Guide   61

3.4  Automation of Data Acquisition Operations

3

2 Click the [Shutdown] tab, enter the conditions for automatic shutdown of the analytical 

instruments, and click [OK]. 

For example: LCMS-8045/8050/8060

1 Select [Shutdown]. 

2 Select [Shutdown Method File], and enter the name of the method file that contains the parameters 
for shutdown of the analytical instruments.

• Click  to change the referenced file.

• If a method file is not specified, the analytical instruments are shut down by the parameters 
downloaded to the instruments when a shutdown is performed. 

• When creating a shutdown method file for turn the LC detector lamp off, select [Off] in the [Lamp] 
parameter. 

3 Enter a time in [Cool Down Time] for the instruments to run after analysis and before shutdown. 

4 Select the instruments for shut down.

• The displayed items vary according to the MS detector model.

3 Click the  (Save) button on the toolbar. 

The shutdown settings are saved to the batch file. 

2
1

3
4
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3.4.4 Print a Summary Report
A summary report summarizes the chromatograms and the statistical calculation results from multiple data. 
This section describes how to set a summary report. 

1 Drag and select the rows in the Batch Table to be included in the summary report. 

If the [Summary Type] and [Summary Report Format File] items are not displayed in the Batch Table, 
refer " Display Hidden Batch Table Items" P.53. 

2 Right-click on the selected rows, and click [Summary Report Settings]. 

3 Select a [Report Format File], and click [OK]. 

• Click  to change the referenced file. 

• The selected start row and end row numbers are displayed at [Row Number]. Change the numbers to 
change the rows to be printed in the summary report. 

Reference
See "7.4 Create a Report Format File" P.253 for details on the report format. 

4 Click the  (Save) button on the toolbar. 

The summary report settings are saved to the batch file. 
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3.4.5 Background Data File

The function cannot be performed for MS detectors. 

Background data refers to a chromatogram obtained by performing the gradient analysis (LC) without 
injecting a sample. Use the background data file to compensate for baseline drift in the acquired sample 
date.

This section describes how to acquire background data and perform background compensation in the 
same realtime batch. 

1 Select the row where background data will be acquired. 

• Ensure that the background data row is above the sample rows. 

• If [Auto Filename] is selected for the [Data File] column, click the  (Settings) icon on the 

[Realtime Batch] assistant bar, and select [Create filenames automatically with] on the [Data 
File Name] tab. 

2 Select [Background] for the rows where background compensation will be applied. 

3 Enter a [Background Data File] for each of the rows where [Background] is selected. 

Reference
If [Background] and [Background File] are not displayed in the Batch Table, refer to "Display 
Hidden Batch Table Items" P.53. 

5 Click the  (Save) button on the toolbar. 

The background compensation settings are saved to the batch file. 

1 32



3  Realtime Batch

64   Operators Guide

3.4.6 Bracket Quantitation
When sequential data acquisition is performed on multiple samples, the detector sensitivity may change 
over time and sometimes affect the initial and final data acquisition results. To correct this situation, the 
quantitative value for unknown samples can be obtained by bracketing the unknown sample with standard 
samples, and creating a calibration curve from the standard sample data acquired before and after the 
unknown sample. 

Three different types of bracket calibration curves are available, [Overlap], [Sequence] and [Average]. 
Select the appropriate type according to how the standard sample calibration points are set. 

This section describes how to select bracket quantitation. 

1 Click the  (Settings) icon on the [Realtime Batch] assistant bar. 

2 Click the [Bracket] tab, select the bracket quantitation type, and click [OK]. 

3 Click the  (Save) button on the toolbar. 

The bracket quantitation settings are saved to the batch file. 

No. Parameter Explanation

1 Overlap Quantitates the unknown sample using the calibration curve made from the results of the 
standard samples acquired before and after the unknown sample. 

2 Sequence Quantitates the unknown sample using the calibration curve made from the results of all 
standard samples regardless of the position of the bracketed unknown sample. 

3 Average Quantitates the unknown sample using the calibration curve made by averaging the results 
of all standard samples before the unknown sample and the results of the standard sample 
directly after the unknown sample. 

1

2

3
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3.4.7 Custom Calculation Function
The custom calculation function allows for automation of operations, such as totaling of the peak area and 
quantitative value compensation. 

This section describes how to set custom parameters. 

1 Click the [Custom Parameters] cell in the Batch Table where custom calculations are 

necessary. 

Reference
If the [Custom Parameters] column is not displayed in the Batch Table, refer to "Hide or Display 
Batch Table Items" P.53. 

2 Enter [Title], [Formula] and constants to display in the Compound Result Table, and 

click [OK]. 

3 Click the  (Save) button on the toolbar. 

The custom parameter settings are saved to the batch file. 

Execute batch processing to check the calculation results, and then check the results on the [Compound] tab 
in [Results View]. If custom parameters are not displayed, display them using the [Table Style] sub-window. 

No. Parameter Explanation

1 Title Enter a title to displayed in the Compound Result Table. 

2 Formula Enter a formula using numeric values, macro variables and operators (+, -, *, /, e). 
• Macro variables

Retention time (RetTime), area (Area), height (Height), concentration (Conc), Measured 
retention time of ISTD in the same ISTD group (RetTimeISTD)*, Set retention time of ISTD 
in the same ISTD group (RetTimeCompTableISTD)*, Set retention time of each compound 
(RetTimeCompTable)*
*: Variables only effective by MS

• For a specific peak
RetTime [1] (retention time of peak with compound ID “1”)

• To specifying peaks between data
RetTime [1] (3) (retention time of peak with compound ID “1” of data at 3 rows above the 
preset row)

3 Const A to C Up to any three constants can be specified in each calculation formula. 

1 2 3
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 Custom Parameter Example

The 1st row is an example of a compensated area calculation. In this example, each peak area of the 
unknown sample is multiplied by the compensation factor to obtain the compensated area. 

The 2nd row is an example of a calculation between samples. In this example, calculation uses the peak 
area of an unknown sample and the peak area of a standard sample that was acquired three samples 
before the unknown sample. 

The 3rd row is an example of calculation between peaks. In this example, the total value of 4 peak values 
is calculated. 

3.5 Data Acquisition Using the Batch Queue Function
This software allows you to perform continuous data acquisition using different batch files. Batch files used 
for continuous data acquisition are registered to a memory area called the “batch queue”. 

In the batch queue, registered batch files are displayed as a list, and are executed in order by realtime 
batch from the top of the queue. 

The order of registered batch files can be changed and registered batch files can be deleted from the list. 
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3.5.1 Register Batch Files to the Batch Queue

1 Click the  (Batch Editor) icon on the [Main] assistant bar. 

2 Open the batch file in the [Batch Editor] window. 

3 Click the  (Queue Batch Run) icon on the [Batch Editor] assistant bar. 

The batch file is added to the batch queue. 

• The information for batch files that are registered to the batch queue is retained even if the 
[Realtime Analysis] program is exited. 

• The status of a batch file registered to the batch queue can be set to “Waiting” (pause) before 
realtime batch analysis begins on that batch file. Select [The batch queue is registered as a state 
of “Waiting”] on the [Batch] menu, select the rows of the batch queue to set to the “Waiting” status, 
and click [Start] to save the batch queue settings. 
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3.5.2 Change the Batch Queue Order or Delete Batch Files 

1 Click the  (Batch Editor) icon on the [Main] assistant bar. 

2 Click the  (Batch Queue) icon on the [Batch Editor] assistant bar. 

3 To change the order of batch files in the batch queue, select the desired row, and click 

[Up] or [Down]. 



 Operators Guide   69

3.5  Data Acquisition Using the Batch Queue Function

3

The order of batch files in the batch queue is changed. 

4 To delete a registered batch file from the batch queue, right-click on the desired row, 

and click [Delete]. 

The selected row is deleted from the batch queue. 

5 Click [Start]. 

Realtime batch is started in the new batch file order. 
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3.5.3 Priority Batch
The currently acquiring batch file can be paused to give priority to another batch file that must be measured 
immediately in realtime batch. This is called “priority batch”. 

1 Click the  (Batch Editor) icon on the [Main] assistant bar. 

2 Display the batch file to give priority to in realtime batch. 

3 Click [Start Priority Batch] on the [Batch] menu. 

The priority batch is started. 

• Priority batch is started after the current data acquisition ends. 

• Priority batch cannot be set to batch files set with bracket quantitation, summary report, QA/QC, 
and batch action. 

The following shows an example of how the [Batch Queue] sub-window changes when priority batch is 
set for batch file Sample3.lcb. 
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3.6 Create a Calibration Curve to Quantitate an 
Unknown Sample
If data processing parameters have already been determined for a target compound, they may be 
extracted from a method so that a calibration curve can automatically be established during acquisition of 
standard samples and used for quantitation of unknown samples.

This section describes how to set data processing parameters and Batch Table items to perform 
quantitative calculations. 

3.6.1 Edit the Data Processing Parameters
This section describes how to edit the LC data processing parameters.

1 Click the  (Data Analysis) icon on the [Acquisition] assistant bar. 

2 Drag-and-drop the data file onto the [Data Analysis] window from the [Data Explorer] 

sub-window. 

Select a data file with data acquisition conditions (instrument parameters) that match those for the target 
component to be analyzed.

3 Click the  (Wizard) icon on the [Data Analysis] assistant bar. 

Reference
Refer to "6.7 Use the "Compound Table Wizard"" P.232 for MS data.

4 Refer to "4.5.1 Compound Table Wizard" P.116 to set the data processing parameters 

using the Compound Table Wizard. 

5 Click  (View Mode) in [Method View]. 

The data loaded in the [Data Analysis] window is reanalyzed according to the new parameter settings.  
Check the analysis results in [Chromatogram View] and [Results View]. 

6 Click the  (Apply to Method) icon on the [Data Analysis] assistant bar. 

The parameters are exported to the method file. 
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Reference
For details, see "4.7 Save (Export) to Method Files" P.126. 

3.6.2 Edit Batch Tables
This section describes how to the set the [Method File], [Sample Type], [Level#], [Data File], [Sample 
Amt.], [Dil. Factor.], and [ISTD Amt.] items required for quantitative calculation. 

See "3.2 Create Batch Tables" P.43 for details on other items. 

 Add Rows to Batch Tables

1 Right-click on the Batch Table, and select [Add Row] from the displayed menu. 

2 Enter the number of samples, and click [OK]. 

Rows are added to the Batch Table. 
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 Set the Method File

1 Click the [Method File] cell on the Batch Table. 

2 Select the method file, and click [Open]. 

The method file is set. 

3 Set other [Method File] cells in the same way. 

Reference
Refer to "Copy Settings" P.51 to copy and paste the same method file name to multiple rows. 
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 Set the Sample Type
Set the type of sample to measure. 

In the case of a standard sample, set the first standard sample to [Initialize Calibration Curve] and the next 
standard sample to [Add Calibration Level]. The default setting [0: Unknown] is used for unknown samples. 

1 Click the [Sample Type] cell of the first standard sample. 

2 Click [Standard], select [Initialize Calibration Curve] and click [OK]. 

The initial cell for the sample type is displayed as [1: Standard (I)]. 

3 Click the [Sample Type] cell of the next standard sample. 

4 Click [Standard], select [Add Calibration Level] and click [OK]. 

The [Sample Type] cell is displayed as [1: Standard]. 
Repeat steps 3 and 4 for multiple standard samples. 
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 Set the Level#
Set the standard sample [Level#] according to the concentration value in the Compound Table of the 
method file. The calibration points are created from the level number of the Compound Table and the area 
and height values of the preset standard sample.

[Level#] values are not used for unknown samples, even if they are set.

1 Click the [Level#] cell for the standard sample.

2 Enter the level number.

The level number is changed. 

3 Set the [Level#] cell for other standard samples. 

 Set the Data File Name
Either directly enter a file name in the [Data File] cell, or automatically create the data file. 

This section describes how to automatically create a data file name. 

1 Click the  (Settings) icon on the [Realtime Batch] assistant bar. 
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2 Click the [Data File Name] tab, set each item, and click [OK]. 

1 Select [Create filenames automatically with]. 

2 Select the items for the file name to automatically create from the [Items] list. 

Enter a character string in the [Prefix] box to create a data file name with a fixed character string. 

3 Click [Add]. 

Items are added onto the end of [Selected Items], and the file name is created using the currently 
displayed items. 

4 Select an item in the [Selected Items] list to change the display order. 

5 Change the display order by clicking [Up] or [Down]. 

Automatically created file names use an _ (underscore) to join together items in order starting 
with the top item in the [Selected Items] box. 
For example, when a file name is automatically created using Batch File Name (AAA), Batch 
Start Date (2008/04/01):
the file name is “AAA_20080401”. 

6 Select a numeric format to automatically append the file name with an incremental number at [Auto-
increment Format]. 

The data file name in the Batch Table is displayed as [Auto Filename]. 

Postrun batch reprocessing cannot be executed when a field is set to [Auto-increment Format] because a 
specific filename and path are required. Therefore, it is recommended to copy the batch after realtime 
acquisition ends. When a batch is copied, the data file name generated at the time of data acquisition is 
transferred to the appropriate cell of the copied batch allowing postrun batch processing to be executed.

To copy a batch, select the following menu item. 

2

6

3 4 51
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 Set the Sample Amount, Dilution Factor, and ISTD Amount. 
Enter values in each cell of the Batch Table to set the [Sample Amt.] (weight) and dilution factor for an 
unknown sample, and ISTD amount (for internal standard method) to spike the unknown sample. 

This section describes how to set the ISTD amount. 

• Enter the ISTD amount for sample types other than the standard sample when the quantitative calculation 
method is internal standard method. 

• Enter the concentration of the ISTD for the number of internal standard substances set in the Compound 
Table. 

• Set [Dilution Factor] to either [Apply] or [Not Used] in the [Data Processing Setting] sub-window in the 
[System Settings] sub-window. 

Reference
If [Sample Amt.], [Dil. Factor] and [ISTD Amt.] are not displayed in the Batch Table, refer to "Hide or Display 
Batch Table Items" P.53. 

1 Click the [ISTD Amt.] cell for the unknown sample. 
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2 Enter the concentration for each internal standard substance, and click [OK]. 

1 Deselect [Use level 1 conc. in the compound table of a method file]. 

If [Use level 1 conc. in the compound table of a method file] is selected, the level 1 concentrations of 
the compounds specified as the internal standard substances in the method file are used. Select this 
checkbox when a standard sample and unknown sample are spiked with the same amount of 
internal standard substances. 

2 Enter the concentrations of the internal standard substances in each group. 

3 Enter the [ISTD Amt.] cell for other unknown samples. 

2

1
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3.6.3 Data Acquisition Using Batch Tables
Perform data acquisition using a preset batch file. 

1 Click the  (Start Realtime Batch) icon on the [Realtime Batch] assistant bar. 

When data acquisition is started, the [Realtime Batch] and [Data Acquisition] windows change as follows. 

During data acquisition, the [LabSolutions Service] icon in the Systray on the Taskbar flashes green. 

Do not turn the PC off while the [LabSolutions Service] icon is flashing. 

Reference
See "3.3.2 Stop Realtime Batch" P.56 for details on how to stop or pause realtime batch. 

 When an Autosampler Is Not Used
When a manual injector on the LC is connected to the Manual Inject (start) terminals of the system 
controller, initiate acquisition by rotating the manual injector to the inject position.
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3.6.4 Check the Quantitation Results
Check the quantitation results for the unknown sample in the [Data Analysis] window. 

1 Click the  (Data Analysis) icon on the [Realtime Batch] assistant bar. 

The [Postrun Analysis] program is displayed, and the data file for the selected row on the Batch Table is 
loaded. 

2 Click the [Compound] and [Calibration Curve] tabs in [Results View], and check the 

quantitation results. 
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3.7 Data Acquisition Using the Optimization Function 
for the Data Acquisition Cycle Time
During realtime batch, the data acquisition cycle can be sped up by overlapping the autosampler operation 
for the next acquisition before the current acquisition is complete.

This function is enabled when the CBM-20A/20Alite (Ver. 2.0 or later) is used as the LC system controller. 
(Any model of autosampler can be used, as long as it can be connected to the CBM-20A/20Alite.)

Both the method file and the batch file must be set in order to use the autosampler overlap operation. This 
section describes these setting procedures.

3.7.1 Set the Instrument Parameters

1 Click the  (Data Acquisition) icon on the [Main] assistant bar in the [Realtime 

Analysis] program.

2 Click [Advanced] in [Instrument Parameter View].

3 Click the [Controller] tab.

4 Select [Automatic] at [Autosampler pretreatment beginning].

Reference
Refer to Help for details about each of the parameters.

5 Select [Save Method File As] on the [File] menu.

Save the method file.
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3.7.2 Create Batch Tables

1 Click the  (Realtime Batch) icon on the [Main] assistant bar.

2 Open the batch file in the [Realtime Batch].

3 Set the method file name saved in "3.7.1 Set the Instrument Parameters" in all the rows 

in the [Method File] column.

• Set a method file name in the top row. Then right-click this cell, and click [Fill Down] to fill in all of 
the rows with the same method file name.

• Overlap injection is not performed between rows with different method file names.

4 Click the  (Settings) icon on the [Realtime Batch] assistant bar.

5 Select [Start pretreatment for next sample during current data acquisition] on the 

[General] tab page.

Reference
Refer to Help for details about each of the parameters.

6 Save the batch file, and execute realtime batch.
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4Data Analysis

This chapter describes how to display the results of acquired data and set data processing 
parameters during postrun analysis. The [Data Analysis] window displays the contents of a single 
data file. 

Reference
• Use the [Quant Browser] window to display the contents of multiple data files, refer to "12 Data Browser" 

P.347. 

• Refer to "14 LC Calibration Curves" P.391 for details on creating calibration curves used for quantitative 
calculations. 

4.1 [Data Analysis] Window
The [Data Analysis] window is comprised of the following views:

• [Chromatogram View] - displays chromatograms and instrument status

• [Results View] - displays Peak Tables and quantitative results

• [Method View] - displays the data processing parameters

4.1.1 Open the [Data Analysis] Window

1 Click the  icon in the [LabSolutions Main] window.
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2 Double-click [Postrun]. 

The [Data Analysis] window can also be opened by clicking the  (Data Analysis) icon on the 

[Acquisition] assistant bar. 

3 Drag-and-drop a data file onto the [Data Analysis] window from the [Data Explorer] sub-

window. 

The content of the data file is displayed in the [Data Analysis] window. 
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4.1.2 [Data Analysis] Window Description
This section describes how to view and use the [Data Analysis] window. 

The size of each view can be changed. Click [Save Layout] on the [Layout] menu, and save the changed 
layout under a new name. 

No. Explanation

1 Displays the [Standard] toolbar, [Data Analysis] toolbar, and [Background Compensation Bar]. 

2 Displays the chromatogram for the currently open data file. 
[Chromatogram View] displays graphs with the [Full Chromatogram] on top and the [Zoomed Chromatogram] 
on the bottom. If the data has been acquired from multiple detectors, [Other Detector] graphs can also be 
displayed. 
[Pressure] and [Flow] can be set to overlaying [Chromatogram View] in the display settings. 

Reference
 Refer to "Status Display in the [Chromatogram View]" P.86 for details. 

3 Displays the parameters in the [View] mode. 
Switch to the [Edit] mode to change the parameters. 
Change back to the [View] mode to perform postrun analysis using edited parameters. 

4 The data processing parameters are displayed on the [Integration], [Identification], [Quantitative], [Compound], 
[Group], [Performance], [Custom], and [QC Check] tabs. 

Reference
Refer to "4.2 Peak Integration Parameters" P.88 for details. 

5 The analysis results are displayed on the [Peak Table], [Compound], [Group], and [Calibration Curve] tabs. 

[Chromatogram View]2Toolbar1

3

5 [Results View] 4 [Method View]
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 Status Display in the [Chromatogram View]
The pressure, temperature and other conditions at the time of data acquisition are displayed and can be 
overlaid in the [Chromatogram View]. 

1 Right-click on the graph, and click [Display Settings]. 

2 Click the [Status] tab, make the necessary selections, and click [OK]. 

1 Select the status items to be overlaid on the chromatogram. 

2 Set the display range of each status item or click [Normalize]. 

3 Select the parameter to display on the right axis of the graph (Intensity Axis). 

 Top of Peak Comment

1 Right-click on the chromatogram, and click [Graph Properties]. 

1

2

3
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2 Select the peak top comment that is displayed on zoomed chromatograms, and click 

[OK]. 

The selected comment is displayed at the top of the peak in the enlarged chromatogram. 
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4.2 Peak Integration Parameters
Change the peak integration parameters and repeat peak integration. 

While in the [Data Analysis] window, the changes to peak integration parameters are applied only to data 
processing parameters in the current data file. 

The parameters must be exported to a method file before they can be applied to other data, then data 
processing using this newly saved method must be applied to all of the additional data. Refer to "4.7 Save 
(Export) to Method Files" P.126. 

4.2.1 Peak Integration of Detected Peaks
This section describes how to set peak integration parameters. 

1 Click  (Edit Mode) in [Method View]. 

Click the [Integration] tab, and change the parameters as required. 

Click  to change the integration time program and peak selection range. 

If analysis was performed on multiple detectors, the parameter changes can be applied to the other 
channels by clicking [Copy to All Channels]. 
Click [Noise/Drift Calculation], and make changes to the [Noise/Drift Calculation Settings] in the sub-
window that is displayed. 

Reference
Refer to Help for details about each of the parameters. 

2 Click  (View Mode) in [Method View]. 

The data loaded in the [Data Analysis] window is reanalyzed according to the new parameter settings. 
Check the processing results in the [Chromatogram View] and [Results View]. 
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4.2.2 Remove Unwanted Peak Integration

 Remove Integration of Unwanted Peaks with Minimum Area/Height
Use a larger [Min. Area/Height] value to exclude integration of small peaks. 

The following example describes how to change the [Min. Area/Height] value from “1000” to “10000”. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Integration] tab, and change the [Min. Area/Height] value to “10000". 

Select [Height] at [Calculated by] to remove the integration of unwanted peaks based on peak 
height. 

3 Click  (View Mode) in [Method View]. 

The data loaded in the [Data Analysis] window is reanalyzed according to the new parameter settings. 
Check the processing results in the [Chromatogram View] and [Results View]. 
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 Remove Integration of Unwanted Peaks with the Integration Time Program
The integration time program allows for detailed peak integration, that is not normally possible with typical 
integration parameters. 

The following example describes how to remove integration of unwanted peaks using the integration time 
program. 

You can delete unwanted peaks by setting a period in which peak detection is not performed in the Time 
Program Table in the [Integration Time Program] sub-window. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Integration] tab, and click . 

3 Create an integration time program, and click [OK]. 

1 Click  (Period of “Integration Off”). 

2 Use the cursor to select the start and end positions of the range where integration is not performed. 

3 Evaluate the [Start Time] and [End Time] in the [Period of “Integration Off”] sub-window, and click 
[Simulate]. 

2

1

3
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The time and processing commands are added to the time program. 

Examine the resulting integration. 

Use the mouse to click  to zoom in or out a chromatogram and change the display of the 
specified view area. 

4 Click  (View Mode) in [Method View]. 

The data loaded in the [Data Analysis] window is reanalyzed according to the new parameter settings. 
Check the processing results in the [Chromatogram View] and [Results View]. 

4.2.3 Analyze Tailing Peaks
This section describes how to process a target peak that overlays the tail of the main peak. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Integration] tab, and click . 
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3 Set the peak to perform tailing processing on, and click [OK]. 

1 Click  (Period of “Tailing On”). 

2 Use the cursor to select the start and end positions of the range where tailing processing is 
performed. 

3 Evaluate the [Start Time] and [End Time] in the [Period of “Tailing On”] sub-window, and click 
[Simulate]. 

The time and processing commands are added to the time program. 

Examine the resulting integration. 

If the peak on the tail of the main peak is small, adjust the Slope value until it is detected. 

1

2

3
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4 Click  (View Mode) in [Method View]. 

The data loaded in the [Data Analysis] window is reanalyzed according to the new parameter settings. 
Check the processing results in the [Chromatogram View] and [Results View]. 

Referring to the procedure above, click  (Period of “Leading On”) if the target peak overlaps the front of 
the main peak. 

4.2.4 Manual Peak Integration
It is possible to manually integrate peaks that are not properly integrated using the automatic integration 
parameters in the method file. 

• Manual peak integration commands are saved only to current data.

• Manual peak integration commands cannot be exported to the method file. 

• To execute the same processing command on multiple data files, make settings in the Integration Time 
Program in [Method View], and save that method file for use. Alternatively, copy the content in the Manual 
Peak Integration Table, paste it into other data tables to apply it on them, and then perform analysis.

• The content in the Manual Peak Integration Table is retained even if postrun analysis is performed using 
the other method files.

 Display [Manual Integration Bar]

1 Click the  (Manual Peak Integration) icon on the [Data Analysis] assistant bar.

[Manual Integration Bar] is displayed.

[Manual Integration Bar] can also be displayed by clicking the  (Manual Integration Bar) on the 
toolbar or right-clicking on [Chromatogram View] and selecting [Manual Integration Bar].

Two types of [Manual Integration Bar] formats are available, Standard toolbar and Advanced toolbar. The 
format type can be switched by changing the setting.

This section describes the Normal toolbar.
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Manual Integration Bar (Standard Toolbar with Labels)

Furthermore, there are three operation types, auto mode, selecting processing commands on the toolbar, 
and operation by shortcut keys. This section describes operations in auto mode.

Icon Name Explanation
Auto Mode This mode selects the optimal processing based on the relationship 

between the position of the mouse cursor and the chromatogram 
automatically.
The command shortcut key can also be used.

Move BL Moves the peak detection points (start or end) along the X-axis (time). 

Move BL (Vertical) Moves the peak detection points (start or end) along the Y-axis (intensity).

Insert Peak Inserts a peak start and peak end point for a peak that was not previously 
integrated.

Insert Peak (Free) Specifies the times and intensity values of the start point and the end 
point of the peak, and inserts the peak.
A vertically divided peak can be inserted.

Split Peak Splits a peak vertically at a specified time.
If there is a valley near the specified time on the chromatogram, the peak 
is split at the time on the valley.

Unify Peaks Unifies two peaks adjacent to a vertical division line that is specified by 
clicking the mouse. Or, unifies multiple peaks between two points, which 
are specified by dragging the mouse, into a single peak.

Reject Peak Removes the peak that is specified by clicking the mouse.
Or, removes multiple peaks between two points that are specified by 
dragging the mouse.

Force B/V Changes to detection of baseline separation if the separation state of two 
adjacent peaks is vertical division.
Changes to vertical division if the separation state is baseline separation.

Force T / Not Performs tailing processing if the specified peak is vertically divided. This 
processes a peak as a peak included in the tailing.
If the specified peak is on tailing, vertical division processing is 
performed.

Force L / Not Performs leading processing if the specified peak is vertically divided. 
This processes a peak as a peak included in the leading.
If the specified peak is on leading, vertical division processing is 
performed.

Clear All Table Deletes all the content in the Manual Peak Integration Table and sets the 
peak detection method to automatic peak integration.

Toggle Manual Peak 
Integration Table

Toggles the Manual Peak Integration Table between display/hide.
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 Move the Peak Detection Point in Auto Mode

1 Click the  (Auto Mode) icon to start the auto mode.

2 Move the mouse to near the detection point to move to.

The detection point is highlighted.

3 Click the detection point to move to and confirm it.

This can be controlled by dragging the mouse.

A vertical blue line is displayed.

At this time, if the detection point is specified with the [Y] key held down, the point can be moved in 
the intensity axis direction.

If the point is specified with the [F] key held down, it can be moved in both the X and Y directions.



4  Data Analysis

96   Operators Guide

4 Align the mouse (vertical line) to the time of the move destination and click the mouse.

The peak detection point is changed and baseline is adjusted.

 Remove a Peak in Auto Mode

1 Click the  (Auto Mode) icon to start the auto mode.
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2 Move the mouse to inside the peak to remove.

The peak inside is filled.

3 Right-click on the graph, and click [Reject Peak(No Correction)] on the displayed menu.

The peak is removed.

 Unify Peaks in Auto Mode
This section describes how to execute the peak integration processing command on multiple peaks as a 
single peak.
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1 Click the  (Auto Mode) icon to start the auto mode.

2 Move the mouse to near the vertical division line to unify.

The vertical division line is highlighted.

3 Right-click on the graph, and click [Unify Peaks] on the displayed menu.

The peak is unified.
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The peak integration processing command can also be executed on multiple peaks as a single peak 
by changing the [Width] value on the [Integration] tab page in [Method View].

Reference
For details on the [Width] value, refer to Help.

4.2.5 Enable/Disable Each Processing Command
This section describes how to enable/disable each processing command using the Manual Peak 
Integration Table.

1 Click the  (Toggle Manual Peak Integration Table) icon on [Manual Integration Bar].

The Manual Peak Integration Table is displayed.

2 Clear the checkbox for the processing command to disable and click [Analyze].

Only the processing commands with their checkboxes selected are executed again.

Pressing the [Delete] key deletes the row selected in the Manual Peak Integration Table. 

4.2.6 Overlay Data in the Analysis Sub-window
A reference data file can be opened on the current open data file and displayed as an overlay in the 
[Chromatogram View].

1 Select [Open Reference Data File] on the [File] menu. 
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2 Click the data file to display, and click [Open]. 

The chromatogram in the selected data file is displayed on the sub-window. 

• Up to 16 data files can be drawn overlaying each other as reference chromatograms. 

• If the data file was obtained by data acquisition on multiple channels, the [Select Channels] sub-
window opens to allow for proper chromatogram selection. 

• To display the baseline of a reference chromatogram, right-click on the zoomed chromatogram, 
and select at [Graph Properties]. 

Reference
Refer to "4.1.2 [Data Analysis] Window Description" P.85 for details. 

• The peak integration parameters for the reference chromatograms cannot be displayed or 
modified. 
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4.3 Peak Identification Parameters
This section describes how to set the allowable time width (window/band width) used for identifying peaks 
based on the Compound Table and which of the identification methods, absolute retention time method or 
relative retention time method is used. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Identification] tab, and set each parameter. 

1 Select either [Window] or [Band] at [Window/Band]. 
If [Window] is selected, enter [Window] in % units, and if [Band] is selected, enter [Default Band 
Time] in minutes. 

2 Select either [Absolute Rt] or [Relative Rt] as the peak identification method. 

Parameter Contents
Window The allowable time width for the peak top is set as a percentage (%) of the retention time. All 

peaks are calculated with the same window percentage. 
Allowable time width (min) =  (Compound Table retention time (min)  window (%) + 0.02)

Band The allowable time width of the peak top is set as an absolute time. The allowable time width 
can be set to each peak in the Compound Table. 
Allowable time width (min) =  Default Band Time (min)

Parameter Contents
Absolute Rt Identifies target peaks from the retention time of each peak and their allowable times 

preset to the Compound Table. 

Relative Rt Compares the retention time of the sample peak to the retention time of the reference 
peak to compensate for retention time deviation caused by fluctuation of the data 
acquisition conditions. A reference peak must be set in the Compound Table. 

Reference
For details, see "4.5.4 Directly Edit the Compound Table" P.122. 

1

2
3

4
5
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3 Select the peak to identify from [All Peaks], [Closest Peak], and [Largest Peak]. 

If peak identification is based on internal standard substances or if peak identification is 
performed on reference substances, the peak having the maximum area or maximum height is 
automatically identified regardless of the [Peak Selection] setting. 

4 Set [Display not identified peaks as peaks with zero area (height)]. 

If this checkbox is selected, the information of that compound is displayed at [Results View]. 

5 Set how the Compound Table retention time is automatically updated based on the retention time of 
an actually identified peak each time that data processing is performed on the standard sample.

3 Click  (View Mode) in [Method View]. 

The data loaded in the [Data Analysis] window is reanalyzed according to the new parameter settings. 
Check the processing results in the [Chromatogram View] and [Results View]. 

Parameter Contents
All Peaks If multiple peaks fall within a single allowable time range, all peaks are identified as the 

target compound despite whether the Window method or Band method is set as the 
allowable time width setting method. 

Closest Peak If multiple peaks fall within a single allowable time range, only the peak closest to the 
retention time in the Compound Table is identified as the target compound, despite 
whether the Window method or Band method is set as the allowable time width setting 
method. 

Largest Peak If multiple peaks fall within a single allowable time range, only the peak with the largest 
peak area or height value is identified as the target compound, despite whether the 
Window method or Band method is set as the allowable time width setting method. 

Similarity [Similarity] can be selected when the photodiode array detector is used. The similarity 
between the spectrum at the retention time of the peaks in the allowable identification 
width and the standard spectrum registered in the Compound Table is calculated, and only 
the peak with the largest similarity value is identified as the target compound. 

Parameter Contents
Replace Replaces the retention time of each compound in the Compound Table with the retention 

time of the actually identified peak. 

Average Replaces the retention time with the value obtained by averaging the retention time of each 
compound in the Compound Table and the retention time of the actually identified peak. 
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4.4 Quantitative Parameters
This section describes how to set the quantitative parameters used to calculate the concentration values of 
the target peak. 

4.4.1 External Standard Method
This method involves calculating concentrations from the peak area or height of unknown samples using a 
calibration curve based on a standard sample. This is the most frequently used quantitative calculation 
method. 

Data acquisition is performed on a fixed volume of multiple concentrations of a standard solution that were 
prepared to bracket the anticipated concentration of the substance in the unknown sample. 

A calibration curve is made using the absolute concentration of the standard solution (absolute amount) as 
the vertical axis and the respective peak area or height as the horizontal axis. 
(The X- and Y-axes display can be changed using [X Axis Calib. Curve].)

Fig.4-1 External Standard Method (Absolute Calibration Curve Method)

Quantitative Processing Reference

Quantitate by external standard method. "4.4.1 External Standard Method" P.103

Quantitate by internal standard method. "4.4.2 Internal Standard Method" P.105

Quantitate by standard addition method. "4.4.3 Standard Addition Method" P.107

Calculate the percentage (%) of each component by 
corrected area normalization method. 

"4.4.4 Corrected Area Normalization Method" P.109

Quantitate multiple compound peaks as a group "4.4.5 Grouping" P.111

Make the calibration curve of the natural logarithmic 
axis

"4.4.6 Calibration Curve for Exponential Calculation" P.112

Correct the concentration value of a standard sample 
using the standard concentration factor. 

"4.4.7 Standard Concentration Factor" P.113

Quantitate using the calibration curve of other 
components. 

"4.4.8 Reference Standard ID and Correction Factor" P.114
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After the calibration curve is created, the same volume of the unknown sample solution is analyzed under 
the same conditions used to analyze the standard solutions. 

The peak area or height (A5) of the unknown sample is determined and the concentration (C5) of the 
substance in the unknown sample can be calculated from the calibration curve. 

This section describes how to quantitate using the “external standard method”. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Quantitative] tab, and set each parameter. 

1 Select [External Standard] for the [Quantitative Method]. 

2 Enter the number of concentration levels (calibration points) at [# of Calib. Levels]. 

3 Click the [Compound] tab, and enter the concentration for each of the standard samples 

in the [Conc. (1)], [Conc. (2)] and [Conc. (3)] columns.

This example uses a 3-point calibration curve. 

[Not Used] is displayed if the concentration cell is selected and the keyboard [Delete] key is pressed 
or if “-1” is entered in the cell.

Use this method when separate standard samples are prepared for individual target components. 

4 Click  (View Mode) in [Method View]. 

5 Save the method file before creating the calibration curve. 

Reference
For details on how to make calibration curves, refer to "3 Realtime Batch" P.43 or "14 LC Calibration 
Curves" P.391. 

1

2
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4.4.2 Internal Standard Method
This highly precise method involves performing quantitative calculation with an area ratio or height ratio to 
correct for injection volume errors. 

The internal standard (ISTD) substance should be a stable compound that separates completely from 
other peaks in the sample, has a similar chemical nature and elutes near the substance to be quantitated.

The standard solutions are prepared with 1 or more known concentrations of the target substance (“X” from 
here on) and a specified concentration of the internal standard substance (“ISTD” from here on). Then data 
acquisition is performed on fixed amounts of these standard solutions. 

A calibration curve is created using the ratio of “X concentration/ISTD concentration” in the standard 
solution as the vertical axis and the ratio of “peak area of X/peak area of ISTD” as the horizontal axis. 
(The X- and Y-axes display can be changed using [X Axis Calib. Curve].)

Fig.4-2 Internal Standard Method

A sample solution is prepared by spiking the unknown sample with the same concentration of ISTD as was 
used in the standard solution preparation. Data acquisition is performed on the same volume of unknown 
sample solution under the same conditions used to analyze the standard solutions.

The peak area ratio between X and ISTD (A5/Aistd.) for the unknown sample is calculated and the 
concentration ratio (C5/Cistd) is calculated from the calibration curve. 

This section describes how to quantitate using the “internal standard method”. 
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1 Click  (Edit Mode) in [Method View]. 

2 Click the [Quantitative] tab, and set each parameter. 

1 Select [Internal Standard] for the [Quantitative Method]. 

2 Enter the number of concentration levels (calibration points) at [# of Calib. Levels]. 

3 Click the [Compound] tab, and set the [Type], [Conc.], and [ISTD Group] for each 

compound. 

This example uses the following calibration curve parameters. 

Make a calibration curve using 3 concentrations of standard solution:
• Peak A: ISTD

• Peak B: Target substance. Quantitated using Peak A. 

• Peak C: ISTD

• Peak D: Target substance. Quantitated using Peak C. 

• The ISTD concentration values are used to calculate the calibration curve as the ISTD amount. 

• If multiple ISTDs are used, number the substances in the [ISTD Group] column so that the ISTDs 
corresponding to the target substance are in the same ISTD group. 

4 Click  (View Mode) in [Method View]. 

• The amount of ISTD in the standard sample is entered in the Compound Table. The amount of 
ISTD in unknown samples is entered in the Batch Table and in single run. Refer to "3.6.2 Edit 
Batch Tables" P.72 for details on entering the ISTD amount. 

• To make a calibration curve with multiple calibration points (levels) add equivalent amounts of 
ISTD to standard solutions of different concentrations. If the standard solution is spiked with the 
ISTD before it is diluted, only a 1-point calibration curve is created. 

• Prepare standard sample solutions by diluting a stock solution in stages to achieve multiple 
concentrations of the target substance. Prepare the unknown sample solution at the appropriate 
concentration. Spike all of the diluted standard samples and the unknown sample with equal 
amounts of the ISTD. 
When the unknown sample is spiked with the same amount of ISTD as the standard solution, 
quantitative calculation can be performed by comparing the sample amount and ISTD amount 
with all levels of the ISTD concentration fields set to “1”. 

1

2



 Operators Guide   107

4.4  Quantitative Parameters

4

5 Save the method file before creating the calibration curve. 

Reference
For details on how to make calibration curves, see "3 Realtime Batch" P.43 or "14 LC Calibration 
Curves" P.391. 

4.4.3 Standard Addition Method
This method involves analyzing an unknown sample that has been spiked with a known amount of the 
target substance and an unspiked unknown sample. Quantitation is performed using the difference 
between the measured peak areas or heights. 

Equivalent aliquots of the same unknown sample solution are prepared. One aliquot remains unspiked and 
the other aliquots are spiked with differing known concentrations of the target substance. All of the 
unknown sample solutions are analyzed and the results are used to quantitatively calculate the amount of 
target substance in the unspiked unknown sample. The calibration curve created with the spiked amount of 
substance (concentration) as the horizontal axis and peak area or height as the vertical axis. 

This method is often used in situations where the components of unknown sample matrix compromise the 
sensitivity of the target substance. 

The sample solution (source solution) is divided into several equal parts, and each part is spiked with 
standard solution and used for data acquisition. 
(Example C1: unspiked, C2: 1.0 mg/L, C3: 2.0 mg/L)

The calibration points of the peak area (A1, A2, A3) and spiked amount (0, 1.0 mg/L, 2.0 mg/L) from the 
data acquisition results, are used to make a 3-point calibration curve (linear). 

The absolute value where the calibration curve intersects the X-axis (point of intersection - C4) indicates 
the concentration (X) of the target component. 

Fig.4-3 Standard Addition Method

This section describes how to quantitate using “standard addition method”. 
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1 Click  (Edit Mode) in [Method View]. 

2 Click the [Quantitative] tab, and set each parameter. 

1 Select [Standard Addition] for the [Quantitative Method]. 

2 Enter the number of concentration levels (calibration points) at [# of Calib. Levels]. 

The unspiked sample is one calibration point and 2 spiked samples are used, making the 
number of calibration points, 3. (1 unspiked sample + 2 spiked samples = 3). Therefore, set the 
number of levels to “3”. 

3 Click the [Compound] tab, and enter the [Conc.] of the standard sample. 

This example uses the following calibration curve parameters.

• Level 1: Unspiked sample “concentration = 0"

• Level 2: 10 mg/L spiked sample

• Level 3: 20 mg/L spiked sample

• Enter “0” for [Conc. (1)] since it is used for the unspiked sample calibration point. 

• Set [Type] to standard for the unspiked and all of the spiked samples, and perform data 
acquisition using the method file saved above. (Perform postrun batch analysis if the data has 
already been acquired.) 
Then, change [Type] to [Unknown] for only the unspiked sample, and reprocess the data using 
the using the method file that contains this calibration curve to obtain the quantitative results. 

4 Click  (View Mode) in [Method View]. 

1

2
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4.4.4 Corrected Area Normalization Method
This method involves, first, correcting the peak area or height of each component peak in an unknown 
sample and totaling these values. The percentage of the corrected area or height for each component with 
is calculated with respect to that total value is assumed to be the quantitative value.

This section describes how to obtain the sensitivity correction factor using a standard sample of known 
concentration and how to perform quantitation by the “corrected area normalization” method by manually 
entering that sensitivity correction factor. 

With corrected area normalization, the percentage of the area or height value of all detected peaks is 
assumed to be the quantitative value. 

 Sensitivity Correction Factor Using a Standard Sample
This section describes use of a mixed sample as the standard sample. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Quantitative] tab, and set each parameter. 

1 Select [Corrected Area Normalization] for the [Quantitative Method]. 

2 Select [Linear] for the [Curve Fit Type]. 

3 Enter the concentration in the [Conc.(1)] cell for each compound in the [Compound] tab. 

4 Click  (View Mode) in [Method View]. 

Refer to "14.1 Calibration Curves by Postrun Batch" and use the standard sample data to make a 
calibration curve. The 1st coefficient obtained is the sensitivity correction factor. 

1

2

1
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 Enter the Sensitivity Correction Factor
This section describes how to manually enter the sensitivity correction factor if it is known. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Quantitative] tab, and set each parameter. 

1 Select [Corrected Area Normalization] for the [Quantitative Method]. 

2 Select [Manual RF (Linear)] for the [Curve Fit Type]. 

3 Enter the sensitivity correction factor in the [1st Coefficient] cell for each compound in 

the [Compound] tab. 

4 Click  (View Mode) in [Method View]. 

1

2
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4.4.5 Grouping
Bundling homologs or isomers when there are multiple compounds is called “grouping”. 

Grouping is effective in dividing the peaks into groups to perform quantitative analysis only on individual 
groups or when measuring the amount of impurities in a certain main component as a single group. 

This section describes how to perform grouping quantitation. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Quantitative] tab, and select [Group Calibration] or [Conc. Summation] for the 

[Grouping Type]. 

• The sum of the peak areas or heights of the grouped compounds is used with [Group Calibration], 
a calibration curve is created for each group, and quantitation is performed for each group. 

• A calibration curve is created for each compound and quantitation is performed for each 
compound, with [Conc. Summation]. Then the sum of the concentrations of the grouped 
compounds is used as the concentration of the group.

3 Click the [Compound] tab, and enter the same group number in the [Group#] column of 

all of the compounds in a group. 

4 Click the [Group] tab, and enter [Name], [Conc.], and [Unit]. 

5 Click  (View Mode) in [Method View]. 
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4.4.6 Calibration Curve for Exponential Calculation
Since the sample concentration and sensitivity are not directly proportional when using an LC-ELSD 
detector, make a calibration curve using the exponential function. 

This section describes how to perform quantitative calculation using a calibration curve calculated from the 
exponential function. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Quantitative] tab, and select [Exponential] for the [Curve Fit Type]. 

• At least 2 standard samples (i.e. 2 calibration points) are required to create a calibration curve 
with the exponential calculation. Select 2 or higher at [# of Calb. Levels].

• [Zero] cannot be set for the exponential calibration curve since the curve does not pass through 
the origin.

• Both of the axes of the graph for the exponential calibration curve are logarithmic. 

3 Click the [Compound] tab, and enter the [Conc.](s). 

4 Click  (View Mode) in [Method View]. 
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4.4.7 Standard Concentration Factor
Make a calibration curve using values obtained by multiplying concentration values of each level with 
compensation factors. 

This section describes how to set the standard concentration factor. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Compound] tab. 

3 Right-click on the Compound Table, and click [Table Style]. 

4 Add the [Standard concentration factor]  column to the Compound Table in the [Table 

Style] sub-window, and click [OK]. 

1 Select [Standard concentration factor] in the [Hide Items] list. 

2 Click [Add]. 

The [Standard concentration factor] item is added to [Display Items] list. 

Change the display order of items in the Compound Table, by selecting the item in the [Display 
Items] list and then clicking [Up] or [Down]. 

2

1



4  Data Analysis

114   Operators Guide

5 Enter the [Standard concentration factor] column. 

6 Click  (View Mode) in [Method View]. 

4.4.8 Reference Standard ID and Correction Factor
If standards cannot be prepared for impurities or related substances, create a calibration curve using a 
standard substance with the same (or proportional) response factor, and quantitate the concentration of the 
impurities or related substances using that calibration curve.

Use the value obtained by multiplying the peak area or height or the peak area or height ratio of the internal 
standard by the correction factor, to create the reference standard calibration curve specified by ID. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Compound] tab. 

3 Right-click on the Compound Table, and click [Table Style]. 
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4 Add the [Ref STD ID] and the [Correction factor] column to the Compound Table in the 

[Table Style] sub-window, and click [OK]. 

1 Select [Ref STD ID] and [Correction factor] in the [Hide Items] list. 

2 Click [Add]. 

The [Ref STD ID] and [Correction factor] item are added to the [Display Items] list. 

Change the display order of items in the Compound Table, by selecting the item in the [Display 
Items] list and then clicking [Up] or [Down]. 

5 Enter the [Ref STD ID] and [Correction factor] column. 

6 Click  (View Mode) in [Method View]. 

2

1
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4.5 Compound Table
The Compound Table must be completed to identify detected peaks or to perform quantitative calculation 
on the detected peaks. There are various ways of entering data into the Compound Table. Use the method 
that is the most convenient. 

• "Compound Table Wizard"

• "Compound Table from the Peak Table"

• "Compound Table Retention Times Using the Mouse"

• "Directly Edit the Compound Table"

4.5.1 Compound Table Wizard
This section describes how to complete a Compound Table using the wizard. Using the wizard also allows 
the peak integration, peak identification, and quantitative parameters to be entered in the consecutive sub-
windows.

1 Click the  (Wizard) icon on the [Data Analysis] assistant bar. 

2 Enter the peak integration parameters, and click [Next]. 

Reference
Refer to "4.2 Peak Integration Parameters" P.88 for details on setting the peak integration 
parameters.
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3 Select the [Select] column to register a peak in the Compound Table, and click [Next]. 

4 Enter the quantitative parameters, and click [Next]. 

Reference
Refer to "4.4 Quantitative Parameters" P.103 for details on setting the quantitative parameters. 

5 Enter the peak identification parameters, and click [Next]. 

Reference
Refer to "4.3 Peak Identification Parameters" P.101 for details on setting the peak identification 
parameters. 
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6 Enter the [Name], [Type] and [Conc.] column in the Compound Table, and click [Finish]. 

• The default [Name] is “RT (Retention Time) + peak retention time”. 

• Edit the Compound Table to match the parameters set in quantitative processing. 

The settings made in the wizard are saved to the data processing parameters in the open data file. 

Reference
• Refer to "4.7 Save (Export) to Method Files" P.126 to save settings made in the wizard to method file. 

• Refer to "14 LC Calibration Curves" P.391 for details on creating calibration curves. 

4.5.2 Compound Table from the Peak Table
Peaks displayed in [Chromatogram View] can be registered to the [Compound] tab in [Method View]. 

This section describes how to register peaks in [Chromatogram View] to the Compound Table. 

1 Click the [Peak Table] tab in [Results View]. 

2 Right-click [Peak#] for the desired peak, and click [Register Selected Peak to Compound 

Table]. 
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The selected peaks in the Peak Table are registered to the Compound Table. 

3 Click the [Compound] tab in [Method View]. 

4 Enter [Name] and [Conc.] of the registered peak in the Compound Table. 

Click the  (Wide Size) button to maximize the view width. Click the  (Normal Size) button to restore 

the view size. 

5 Click  (View Mode) in [Method View]. 

Reference
• Refer to "4.7 Save (Export) to Method Files" P.126 for details on saving to the method file. 

• Refer to "14 LC Calibration Curves" P.391 For details on creating calibration curves. 
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4.5.3 Compound Table Retention Times Using the Mouse
Retention times in the Compound Table can be easily set with the mouse in [Chromatogram View]. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Compound] tab, and select the desired [Ret. Time] cell. 

The peak position lines are displayed in red in the [Chromatogram View]. 

Right-click on the chromatogram, and if [Peak Position Line] on the displayed menu is not selected, 
select [Peak Position Line] to display the peak position line. 
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3 Select the peak whose retention time is to be changed. 

The retention time change is automatically registered to the Compound Table. 

Fine-adjust the peak position line by dragging the line with the [Shift] key held down. 

4 Click  (View Mode) in [Method View]. 

Reference
• Refer to "4.7 Save (Export) to Method Files" P.126 for details on saving to the method file. 

• Refer to "14 LC Calibration Curves" P.391 for details on creating calibration curves. 

Peak position line
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4.5.4 Directly Edit the Compound Table
Click the target compound cell to edit a cell in the Compound Table. 

This section describes how to select the Window/Band method and compound type. 

 Select the Window/Band Method for Each Compound
The identification method set on the [Identification] tab in [Method View] is used for all of the compounds. It 
can also be set to each compound in the Compound Table. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Compound] tab. 

3 Right-click on the Compound Table, and click [Table Style]. 

4 Add the [Window/Band] and the [Band] column to the Compound Table in the [Table 

Style] sub-window, and click [OK]. 

1 Select [Window/Band] and [Band] in the [Hide Items] list. 

2 Click [Add]. 

The [Window/Band] and [Band] item are added to the [Display Items] list. 

Change the display order of items in the Compound Table, by selecting the item in the [Display 
Items] list and then clicking [Up] or [Down]. 

2

1
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5 Set [Window/Band] and [Band] parameters. 

1 Click the [Window/Band] cell for the desired compound, and select [Default], [Window] or [Band]. 

2 Enter the allowable time width in the [Band] cell, if [Band] is selected. 

If [Window/Band] is set to [Default], the value set on the [Identification] tab is used. 

6 Click  (View Mode) in [Method View]. 

Reference
• Refer to "4.7 Save (Export) to Method Files" P.126 for details on saving to the method file. 

• Refer to "14 LC Calibration Curves" P.391 for details on creating calibration curves. 

 Compound Type
This section describes how to set the reference compound for peak identification using the relative 
retention time method. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Compound] tab, and select the [Type]. 

Click the [Type] cell of the desired compound, and select [Reference]. 

Use this method to set the ISTD as the reference for the internal standard method. Click the [Type] 
cell of the ISTD, and select [ISTD & Ref.]. 

3 Click  (View Mode) in [Method View]. 

If changes are made to the parameters such as [Type] on the [Compound] tab, the calibration curve will 
change. In this case, the current calibration curve information saved in the data file is automatically deleted. 

Reference
• Refer to "4.7 Save (Export) to Method Files" P.126 for details on saving to the method file. 

• Refer to "14 LC Calibration Curves" P.391 for details on creating calibration curves. 
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4.6 Column Performance Parameters
This section describes how to set the various calculation methods for supporting the system suitability test 
and how to check calculation results. 

• USP

• USP2

• JP

• JP2

• EP

• BP

• DAB

• EMG

• EMG (50%)

• area/height

• user-defined

Reference
For details about the column performance equations, refer to Help or the Data Acquisition & Processing 
Theory Guide.

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Performance] tab, and select the appropriate checkbox(es) at [Calc. Method]. 

• Select [User Defined] to display the [User] parameters box. 

• Either select [1st Peak Time] or enter a [Set Time] at [Unretained Peak Time].

• Select [Column Length] to calculate the number of theoretical plates.

3 Click  (View Mode) in [Method View]. 
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4 Click the [Peak Table] tab in [Results View], and check the number of theoretical plates 

and resolution. 

5 To check the tailing factor, right-click on the Peak Table, and click [Table Style]. 

6 Add the [Tailing F.] column to the Compound Table in the [Table Style] sub-window, and 

click [OK]. 

1 Select [Tailing F.] in the [Hide Items] list. 

2 Click [Add]. 

The [Tailing F.] item is added to the [Display Items] list. 

Change the display order of items in the Compound Table, by selecting the item in the [Display 
Items] list and then clicking [Up] or [Down]. 

[Tailing F.] is displayed in the Peak Table. 

Add [Tailing Factor] or [Resolution] display settings to the [Quantitative Results] report items to print 
the results in the output report.

2
1



4  Data Analysis

126   Operators Guide

4.7 Save (Export) to Method Files
After setting the quantitative parameters and the Compound Table, save (export) the new settings to the 
method file. 

1 Click the  (Apply to Method) icon on the [Data Analysis] assistant bar. 

2 The name of the method file used for data acquisition is displayed. Click [Save]. 

Enter a new name at [File name] to create a new method file. 

3 Select the method items to save, and click [OK]. 

1 Select [Current Settings].

[Current Settings] saves the latest currently displayed method parameters. 
[Acquisition Settings] saves the method parameters used for data acquisition. 

2 Select the method items to save. 

The selected method items are saved to the method file. 

1

2
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5PDA Data Analysis

This chapter describes how to analyze chromatograms or spectra obtained by data acquisition with 
the PDA (photodiode array) detector, execute purity calculations on detected peaks, and perform 
library searches.

5.1 [PDA Data Analysis] Window
The [PDA Data Analysis] window is comprised of the following views:

• [Contour View] - displays a contour view with absorbance color-coded

• [Chromatogram View] - displays chromatograms and status curves

• [Spectrum View] - displays the UV spectra

• [Purity View] - displays the purity calculation results of detected peaks

• [Results View] - displays quantitative calculation results

• [Method View] - displays and editing data processing parameters

5.1.1 Open the [PDA Data Analysis] Window

1 Click the  (PDA Data Analysis) icon on the [Main] assistant bar in the [Postrun 

Analysis] program. 

2 Drag-and-drop the data file onto the [PDA Data Analysis] window from the [Data 

Explorer] sub-window. 

The contents of the data file is displayed in the [PDA Data Analysis] window. 
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5.1.2 [PDA Data Analysis] Window Description
This section describes how to view and use the [PDA Data Analysis] window. 

• Only data file can be displayed in the [PDA Data Analysis] window. 
Drag-and-drop the other data files onto the [PDA Data Analysis] window to change to the content of their 
data files. 

• If the data file was acquired by simultaneous use of another detector, the chromatogram acquired by that 
detector is also displayed in the [Data Analysis] window. 

No. Explanation

1 Displays the [Standard] and [PDA Data Analysis] toolbars. 

2 Displays the contour graph with PDA data color-coded into absorbance ranges. 

Drag the  and  to display the chromatograms and spectra extracted at that position in [Chromatogram 
View] and [Spectrum View]. 

3 Displays the UV spectrum at selected retention time or a selected peak. 
Right-click the [Spectrum View] to select operations such as switching of the view mode (Extracted or 
Registered) and UV library search for selected spectra. 

4 The [Peak Purity] tab displays the purity result for the selected peak. 
The [Peak Profile] tab displays the overlaid chromatogram for the selected peak at multiple wavelengths.

5 Select the [Edit] mode to change various parameters in [Method View]. 

6 Displays the data processing parameters of the currently open data file. 
The [Multi Chrom], [UV Spectrum], [Library Search], and [Purity] tabs are displayed in addition to the tabs 
displayed in the [Data Analysis] window. 

7 Displays the peak integration and quantitative results. 
The display content is the same as [Results View] in the [Data Analysis] window. 

8 Displays the chromatogram at the wavelength on the [Multi Chrom] tab in the data processing parameters and 
the chromatogram extracted from the contour. 
Right-click on the graph in [Chromatogram View] to select operations such as switching the view mode 
(Overlay Chromatograms, Stack Chromatograms and Single Chromatogram), registration of multi 
chromatograms, and manual peak integration. 

Use  to change the channel and peak position. 

1 Toolbar 2 [Contour View]

4 [Purity View]

6 [Method View]

8 [Chromatogram View] 7 [Results View]

5

[Spectrum View]3
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 View the Data in Its Entirety (3D Image)
PDA data can be shown in its entirely as a 3D image. 

1 Click [3D Image] on the [View] menu. 

The [3D Image] sub-window opens. 

• Click  in the top right corner of the sub-window to close the [3D Image] sub-window. 

• The [3D Image] sub-window can be enlarged by dragging on the sub-window, and the display 
angle can be changed by dragging on the periphery of the 3D display area. 

• The [3D Image] sub-window does not support the [256 Colors] Windows graphic mode. Use it in 
environments with the [High Color] setting or above. Do not change the number of colors for 
graphics while the [3D Image] sub-window is displayed. 
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5.1.3 Display Chromatograms Extracted from [Contour View]
In [Contour View], the chromatograms or spectra can be extracted from [Contour View] by using the 
extraction lines. 

This section describes how to change the extraction position of the wavelength (Y-axis) and display the 
chromatogram at that position in the [Chromatogram View]. 

1 Drag  to move to the target position. 

(Click  to fine-adjust the wavelength extraction position.)

The extracted chromatogram is displayed in the [Ex] (extracted chromatogram) region in the 
[Chromatogram View]. 

• The wavelength extraction position can be checked by the wavelength displayed by  on [Contour View] 
or by the wavelength displayed in the [Ex] region in [Chromatogram View]. 

• Right-click on [Contour View] and select [Graph Properties] to adjust the Contour Properties. Select 
[Display Settings] to adjust the Contour View Display Settings. 

• The extracted chromatogram is only displayed if [Display Extracted chromatogram] is selected on the 
[Multi Chrom] tab in [Method View]. 
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5.1  [PDA Data Analysis] Window
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5.1.4 Display Spectra Extracted from [Contour View]
The chromatograms or spectra can be extracted from [Contour View] by using the extraction line. 

This section describes how to change the extraction position of the time (X-axis) and display the spectrum 
at that position in the [Spectrum View]. 

1 Drag  to move to the target position. 

(Click  to fine-adjust the time extraction position. )

The extracted spectrum is displayed in [Spectrum View]. 

• The wavelength extraction position can be checked by the wavelength displayed by  on [Contour View] 
or by the retention time displayed in [Spectrum View]. 

• Right-click on [Contour View] and select [Graph Properties] to adjust the Contour Properties. Select 
[Display Settings] to adjust the Contour View Display Settings. 

• Right-click on the spectrum and select or deselect [Registered Spectrum] and switch between [Spectrum 
View (Registered)] and [Spectrum View (Extracted)].
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5.1.5 Manipulate Extracted Chromatograms and Spectra
Double-click anywhere on a chromatogram (or spectrum) display to check the chromatogram waveform or 
spectrum shape.

 Display the Spectrum of a Desired Retention Time Extracted from the 
Chromatogram
Double-click a selected chromatogram at a desired retention time to display the spectrum of that retention 
time in [Spectrum View]. 

To check the spectrum of a time at the top of a detected peak, click [Peak ]. The spectrum moves to the 
top of the detected peak. 

 Display the Chromatogram of a Desired Wavelength Extracted from the 
Spectrum
Double-click a desired wavelength of a spectrum to display the chromatogram at that wavelength in the 
[Ex] (extracted chromatogram] section of the [Chromatogram View]. 

• Chromatograms extracted from [Spectrum View] cannot be displayed if a channel other than [Ex] 
(extracted chromatogram) is selected in [Chromatogram View]. 

• The extracted chromatogram cannot be displayed if [Display Extracted chromatogram] is deselected on 
the [Multi Chrom] tab in [Method View]. 
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5.2 Register Chromatograms
Chromatograms extracted from 3D data can be registered in the Multi-Chromatogram Table. 

5.2.1 Register Chromatograms to the Multi-Chromatogram Table
Register a chromatogram to the Multi-Chromatogram Table to perform operations such as comparison of 
multiple chromatograms, output of reports and peak integration. 

This section describes how to register chromatograms to the Multi-Chromatogram Table. 

1 Right-click on the chromatogram in [Ex] (extracted chromatogram), and select [Register 

Extracted Chromatogram to Table]. 

The extracted chromatogram is registered to a channel in the Multi Chromatogram Table. 

• The extracted chromatogram cannot be displayed if [Display Extracted chromatogram] is 
deselected on the [Multi Chrom] tab in [Method View].

• Right-click on the chromatogram, and select [Register Lambda max Chromatogram to Table] to 
register the lambda max chromatogram for the target peak to the Multi Chromatogram Table. 
Then, double-click near the peak top of the target peak in [Chromatogram View]. The 
chromatogram is registered to the Multi Chromatogram Table. 

• If the chromatogram display mode is [Overlay Chromatograms] or [Stack Chromatograms], new 
chromatogram are displayed in [Chromatogram View] as they are registered to a channel in the 
Multi Chromatogram Table. 
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2 Click  (Edit Mode) in [Method View]. 

3 Click the [Multi Chrom] tab in [Method View], and select the registered chromatograms. 

1 Select [Display Extracted chromatogram] to display the chromatogram in [Chromatogram View]. 

2 Click the [Wavelength] cell. 

Select [Max Plot] from the [Types of Chromatograms] and enter a [Start Wavelength] and an [End 
Wavelength] to display that chromatogram as a Max Plot. 

Max Plot refers to the chromatogram obtained by plotting the intensity of the maximum absorbance in the 
specified wavelength range. 

4 Click  (View Mode) in [Method View]. 

The chromatogram is displayed in [Chromatogram View]. 

21
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5.2.2 Peak Integration Parameters
The peak integration parameters for PDA data can be individually edited for each channel in the Multi 
Chromatogram Table. 

This section describes how to select a channel and perform data processing on that channel. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Integration] tab, and select the target channel from the [Channel] list. 

3 Edit the peak integration parameters. 

Reference
Refer to "4.2 Peak Integration Parameters" P.88 for details on peak integration operations. 

4 Click  (View Mode) in [Method View]. 

The chromatogram in the selected channel is reintegrated with the new peak integration parameters. 

Right-click on the chromatogram in [Chromatogram View], and select [Manual Integration Bar] to manually 
integrate the chromatograms for each channel. Refer to"4.2.4 Manual Peak Integration" P.93 for details on 
manual peak integration. 
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5.3 Register Spectra
Register spectra extracted from 3D data to the Spectrum Table to perform a library search and calculate 
the similarity between each spectrum and the reference spectrum. 

5.3.1 Register Spectra to the Spectrum Table
If the displayed spectra are registered to the Spectrum Table, they can be compared with other spectra and 
their similarity can be calculated. 

This section describes how to register extracted spectrum to the Spectrum Table. 

Right-click on the spectrum and select or deselect [Registered Spectrum] and switch between [Spectrum 
View (Registered)] and [Spectrum View (Extracted)]. 

1 Right-click on [Spectrum View], and click [Register Extracted Spectrum to Table]. 

The extracted spectrum is registered to the Spectrum Table. 

2 Right-click on [Spectrum View], and click [Show Spectrum Table]. 

3 Edit the Spectrum Table. 

1 Check the content of the [Data Source], [Param.], and [Scale] cells of the registered spectrum. 

If an extracted spectrum has been registered, [Time] is displayed at [Data Source], and the retention 
time when it was extracted from the chromatogram is displayed at [Param.]. 
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2 Click the [Data Source] cell and select [Library] and select the UV library file to register a spectrum in 
a library file to the Spectrum Table. 

3 Select the spectrum in the library file from the [UV Library-Select Spectrum] sub-window, and click 
[OK]. 
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4 Click [Apply], check the display in [Spectrum View], and then click [OK]. 

• If [Spectrum View (Registered)] is displayed, double-click anywhere in [Chromatogram View] to register 
the extracted spectrum to the Spectrum Table. 

• Select [Register Spectrum to Table] on the [Integration] tab in [Method View] to automatically register the 
spectrum at all peak top times to the Spectrum Table. 
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5.3.2 Calculate Spectrum Similarity
The similarity between the reference spectrum and another spectrum in the Spectrum Table can be 
calculated if a reference spectrum ([Ref]) is registered to the Spectrum Table. 

This section describes how to register a reference spectrum to calculate similarity. 

1 Right-click the ID No. to be used as the reference spectrum, and click [Set to Reference 

Spectrum for Similarity]. 

[Ref] is displayed in the [Similarity] for the selected ID#. 

2 Click [Apply], and check [Similarity] of the spectrum currently registered to the 

Spectrum Table. 

[Similarity] is displayed as a value with respect to [Ref] = 1. 

3 Click [OK]. 

Right-click on the [Spectrum View] and select [Registered Spectrum] to display the spectrum 
currently registered in the Spectrum Table. 
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5.3.3 Create a Spectrum File
Spectra can be exported to common format (.jcm) files. Exported files are used to register to library files 
and to perform peak identification based on similarity. 

This section describes how to export a spectrum in [Spectrum View] to a file, and how to export spectra 
registered to the Spectrum Table to files. 

 Export a Spectrum in [Spectrum View]

1 Right-click on [Spectrum View], and click [Export Spectrum As]. 

If the view mode is [Spectrum View (Registered)], select the spectrum label before right-clicking on 
[Spectrum View]. 

2 Enter the file name, and click [Save]. 

The spectrum file is created. 
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 Export Spectra Registered to the Spectrum Table

1 Right-click on the ID No. of the spectrum to export, and click [Export Spectrum As]. 

2 Enter the file name, and click [Save]. 

The spectrum file is created. 
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5.4 UV Spectrum Library
A file that contains multiple UV spectra is called a library file. Library file allow for the comparison of 
unknown spectra to a library of known spectra to identify the unknown compound.

This section describes how to make a library file according to the following procedures.

1. "Create a Library File"

2. "Register a UV Spectrum to the Library File"

3. "Edit a Library File"

Reference
Refer to "5.5.1 Identify Peaks by Spectrum Similarity" P.148 or "5.5.2 Use [Library Search] to Search for 
Spectra" P.151 for more details. 

5.4.1 Create a Library File
A UV spectra library file must be created before extracted spectra can be added to it.

1 Click the  (UV Library Editor) icon on the [Main] assistant bar in the [Postrun 

Analysis] program. 

2 Click  (New) on the toolbar. 
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3 Enter a [File name], and click [Save]. 

The UV library file is created. 

5.4.2 Register a UV Spectrum to the Library File
This section describes how to register the UV spectra displayed in the [Spectrum View] and spectra files to 
the library file made in "5.4.1 Create a Library File". 

 Register a UV Spectrum File

Reference
Refer to "5.3.3 Create a Spectrum File" P.140 for details. 

1 Right-click on [Spectrum Information] in the [UV Library Editor] window, and click 

[Register from UV spectrum file]. 



5  PDA Data Analysis

144   Operators Guide

2 Select the desired UV spectrum file and then click . 

The UV spectrum file name is displayed in the [Selected Files] box. Repeat this procedure to select all 
files required for the UV library. 

The selected UV spectra files are registered to the UV library file. 

 Register a UV Spectrum

1 Right-click on [Spectrum View] in the [PDA Data Analysis] window, and click [Register 

Spectrum to Library]. 

The spectrum is added to the UV library file. 
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2 Select the desired UV library file, and click [Open]. 

The spectrum is added to the UV library file. 

• Right-click on the ID No. of the desired spectra, and select [Register Spectrum to Library] to add spectra 
in the Spectrum Table to the library file. 

• If the view mode is [Spectrum View (Registered)], select the spectrum label before right-clicking on 
[Spectrum View], and then select [Register Spectrum to Library]. 
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5.4.3 Edit a Library File
This section describes how to edit the spectrum files registered at "5.4.2 Register a UV Spectrum to the 
Library File". 

1 Click the  (UV Library Editor) icon on the [Main] assistant bar in the [Postrun 

Analysis] program. 

2 Click the  (Open) button on the toolbar. 

3 Select the desired UV library file, and click [Open]. 
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4 Edit the [Spectrum Information] in the UV library file. 

1 Enter the [Compound Name] if one was not already entered. 

2 Enter the wavelength range in the [Lambda Range] column for use the library search. 

3 Check the [Lambda max] and [Lambda min] values. 

The items displayed at [Spectrum Information] can be edited with [Table Style]. 
Right-click on [Spectrum Information], and select [Table Style]. 

5 Click the  (Save) button on the toolbar. 

The UV library file is saved. 

1 2 3
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5.5 Specify a Compound From a Spectrum
Compare the spectra of known compounds with the spectrum of an unknown compound to identify and 
specify the compounds from a spectrum. 

This section describes the following operations. 

• "Identify Peaks by Spectrum Similarity"

• "Use [Library Search] to Search for Spectra"

• "Spectrum Conditions of the Search Target"

Set the spectrum conditions of the search target to perform higher precision similarity and library searches. 

5.5.1 Identify Peaks by Spectrum Similarity

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Identification] tab, and select [Similarity] in the [Peak Selection] list. 
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3 Click the [Compound] tab, right-click on the Compound Table, and click [Table Style]. 

4 Make the settings in the [Table Style] sub-window, and click [OK]. 

1 Select [Std. Spectrum], [Min Similarity], and [Wavelength] in the [Hide Items] box. 

2 Click [Add]. 

[Std. Spectrum], [Min Similarity], and [Wavelength] are added to the [Display Items] box. 

Change the display order of items in the Compound Table, by selecting the item in the [Display 
Items] box and then clicking [Up] or [Down]. 

2
1
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5 Right-click the [ID#] of the compound whose similarity is to be identified, click 

[Extracted Spectrum], [UV Spectrum File] or [UV Library File] at [Register Standard 

Spectrum], and register the standard spectrum for the compound. 

6 Enter the [Min Similarity] and [Wavelength] that is associated with the [Std. Spectrum]. 

7 Click  (View Mode) in [Method View]. 

• Right-click and select [Show Standard Spectrum] to check a registered spectrum. 

• The peak is not identified if the similarity between the standard spectrum and the spectrum of the time at 
the top of the detected peak falls below the threshold. 
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5.5.2 Use [Library Search] to Search for Spectra
This section describes how to perform a library search.

1. Set library search criteria

2. Execute the library search

 Library Search Criteria
The following example describes how to set the criteria to search the similarity between an unknown 
spectrum and the spectra registered to the library file. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Library] tab, and enter the search criteria. 

1 Set the [Wavelength Range] and [Max # of Hits]. 

[Max # of Hits] is the number of spectra to display in the [UV Library Search Results] sub-
window. 

2 Set the [Library Files] parameters. 

• Select [Use All Library Files in UVLibrary Folder] to search all of the library files in the 
UVLibrary folder. 

• Select [Use All Library Files in a Specified Folder] and specify a folder to search all of the 
library files in a specific folder in the UVLibrary. 

3 Select [Prefilter] and [Enable], then click the [Index] cell and select a keyword to further filter the 
search results by compound name, retention time or another keyword. 

3 Click  (View Mode) in [Method View]. 

2

3

1
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 Execute the Library Search
When the library search is executed, matching spectra are displayed in order from the highest similarity to 
the lowest in the [UV Library Search Results] sub-window. 

The following example describes how to select a spectrum in [Spectrum View (Registered)] and perform a 
library search. 

To perform a library search on the extracted spectrum, first, display the spectrum extracted from [Contour 
View] or [Chromatogram View] in [Spectrum View (Registered)], and execute the library search. 

1 Select the spectrum in the [Spectrum View], right-click on the view, and click [Library 

Search]. 

The spectra found (hit) by the search criteria are displayed in the library search results. 
The following sub-window displays search results when the [Max # of Hits] is set to “3”. 

1

4

2 3

5
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Click [Repeat Search] on the [Library Search] menu, and change the search criteria in the [Library 
Search] sub-window to perform the search again with new criteria. 

5.5.3 Spectrum Conditions of the Search Target
Set the spectrum conditions during extraction of the UV spectrum to perform higher precision peak 
identification and library searches. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [UV Spectrum] tab, and set the spectrum conditions. 

1 Select [Smoothing] in the [Filtering Type] list to perform spectral smoothing. 

2 Select [Background Compensation] to perform background compensation on spectra. 

3 Click  (View Mode) in [Method View]. 

No. Explanation

1 Changes the spectrum displayed in the graph.
The number of graphs to display can be set at [Display Settings] on the [View] menu. 

2 Determines the number of hits displayed in the search results window.

3 Displays the [Ret. Time] and [Lambda max] values for the UV spectrum of the target peak. 

4 Displays a table of spectrum information that was hit (found) in the search. 
The spectrum information is displayed in order from the highest similarity to lowest. 

5 Displays the searched spectra (Library) overlaying the unknown spectra (Target). 

2 1
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5.6 Peak Purity Analysis
The peak purity can be calculated and the peak shape of chromatograms at each wavelength can be 
compared to check whether detected peaks contain impurities. 

Reference
 Refer to Help for details on peak purity analysis. 

5.6.1 Peak Purity Calculation Parameters
This section describes how to set the calculation range and the compensation conditions based on the 
noise spectrum. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Purity] tab, and set the conditions for the peak purity calculation. 

1 At [From] and [To], enter the wavelength range where purity will be calculated. 

2 At [Step], enter the wavelength interval to use for the calculation. 

3 Select [Background Compensation]. 

• Select [Background Compensation] to calculate the peak purity of components with a slow 
retention time or whose baseline easily drifts as in gradient acquisition. 

• Insufficient peak separation causes the start and end points of the peak to overlap. Better 
results are obtained by not performing background compensation. 

4 Select [Identified Peaks] from the [Compute Purity] drop-down list. 

Depending on the number of peaks and whether [All Peaks] is selected, it may take time to 
perform data analysis. 

5 At [From] and [To], enter the retention time range to set as the noise spectrum. 

Select a time range that incorporates the retention time of the target component. 

• Display the chromatogram as a Max Plot, and verify that there are no peaks between [From] 
and [To], then select the noise spectrum range. 

• Select [Compute noise spectrum from current data for peak purity] to compute the noise 
spectrum from the every data file. 

3 Click  (View Mode) in [Method View]. 

The purity calculation is executed according to the preset conditions. 

1
2

3
4

5
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5.6.2 Displaying Calculation Results
[Purity View] has 2 sub-windows for viewing the results of the peak purity calculation, [Peak Purity] and 
[Peak Profile]. 

[Peak Purity] is used to check the peak purity based on the spectrum information of the detected peak. 
[Peak Profile] is used to check for impurities by comparing chromatograms at multiple wavelengths. 

First, select the desired peak in [Chromatogram View] or [Contour View]. This section describes how to 
select peaks whose purity is to be checked in [Chromatogram View]. 

Next, check the calculation results at [Purity View]. The section describes the following 2 methods:

• "Display Calculation Results using the 3-Point Peak Purity Method"

• "Display the Calculation Result using the Total Peak Purity Method"

1 Move the extraction line in [Chromatogram View], to the peak for which purity is to be 

calculated. 

Reference
Refer to "Display the Spectrum of a Desired Retention Time Extracted from the Chromatogram" 
P.132 for more details. 

If the peak is detected, the purity of the selected peak is calculated. 

 Display Calculation Results using the 3-Point Peak Purity Method
Peak purity is calculated based on 3 points, the upslope, peak top point and downslope.

1 Select the [Peak Purity] tab in [Purity View] then right-click the graph and select [Display 

Settings]. 
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2 Select [3-Point] from the [Purity Index Mode] drop-down list, and click [OK]. 

3 Confirm that the 3-point spectra method waveform and calculation results are 

displayed.

If the spectral similarity between the peak top, the upslope and the downslope is higher than the 
threshold, it is an indication that the calculated peak does not contain impurities. 

 Display the Calculation Result using the Total Peak Purity Method
Peak purity is calculated based on all of the points from peak start to peak end, then the similarity and 
purity curves are displayed. 

1 Select the [Peak Purity] tab in [Purity View] then right-click the graph and select [Display 

Settings].
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2 Select [Total Peak] from the [Purity Index Mode] drop-down list, and set the [Graph Type] 

and [Y Axis Scaling], and click [OK]. 

• If [Purity] is selected, the purity curve (curve obtained by subtracting the threshold curve from the 
similarity curve) and zero compensation line are displayed in the graph. 

• If [Similarity] is selected, the similarity curve and threshold curve are displayed in the graph. 

• To change the display scale of the similarity curve, deselect [Auto Y Scale] at [Y Axis Scaling], 
and enter a display range. 
In the following example, the display range is set to 0.99 to 1.01. 

• Notice in the following [Purity] graph example that impurities are detected where the purity curve 
is below the zero compensation line. 
The negative [Peak purity index] value confirms that the sample contains impurities. 

The [Purity] graph or [Similarity] graph is displayed. 

Purity graph Similarity graph
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 Examine Chromatograms using the Peak Profile
Display chromatograms at multiple wavelengths to compare peak shape. 

1 Select the [Peak Purity] tab in [Purity View] then right-click the graph and select [Display 

Settings].

2 Enter the parameters in the [Display Settings] sub-window, and click [OK]. 

1 Select the [Display Mode]. 

The [Chromatogram] or [Ratio Chromatogram] is displayed. 

The center wavelength refers to the wavelength of the chromatogram extracted from the contour 
view or set in the Multi Chromatogram Table. 

No. Explanation

1 Select [Chromatogram] to display the chromatogram based on the [Wavelength Interval] and [Number of 
Additional Chromatograms] parameters. 
Select [Ratio Chromatogram] to display the central wavelength chromatogram with the ratios between 
the chromatograms based on the [Wavelength Interval] and [Number of Additional Chromatograms]. 

2 Select how many wavelengths (nm) will separate the chromatograms displayed on the short and long 
sides of the center wavelength. 

3 Select the number of chromatograms to display on the short and long sides of the center wavelength. Up 
to 5 wavelengths can be specified on each side. 

4 If [Chromatogram] is selected as [Display Mode] and [Normalize Chromatograms] is selected, the 
intensity axis of the chromatogram is normalized. 

1
2
3
4

Chromatogram Ratio chromatogram
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5.7 Print PDA Data Analysis Results
A report format file must be made in the [Report] window to print PDA data analysis results. This software 
provides several report format files to make printing easier. First-time users of this software can easily print 
analysis results using the pre-installed report format files. As users becomes more familiar with the 
software operations, they can edit or add report items to the pre-installed report format files, or create a 
new report format file and use it to print reports. 

This chapter describes the following procedures.

• "Open the [Report] Window"

• "Open Report Format Files"

• "Edit PDA Report Format"

• "Preview Before Printing"

• "Save Report Format Files"

5.7.1 Open the [Report] Window
Open the [Report] window in either the [Realtime Analysis] program or the [Postrun Analysis] program. 

This section describes how to open the [Report] window in the [Postrun Analysis] program. 

1 Click the  (Report Format) icon on the [Main] assistant bar in the [Postrun Analysis] 

program. 

The [Report] window opens. 
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5.7.2 Open Report Format Files
Several report format files are pre-installed in the \LabSolutions\Sample\LC folder. This section describes 
how to open the report format file “PDADataAnalysisResults.lsr”. 

1 Click  (Select Folder) in the [Data Explorer] sub-window. 

2 Select “\LabSolutions\Sample\LC”, and click [Close]. 

The “\LabSolutions\Sample\LC” folder is displayed in the [Data Explorer] sub-window. 
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3 Drag-and-drop “PDADataAnalysisResults.lsr” onto the [Report] window. 

4 Click the  (Data) tab in the [Data Explorer] sub-window, and select the appropriate 

data file folder.
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5 Drag-and-drop the data file into the report format. 

The data file is loaded into the report format and displayed. 

6 If the report includes multiple pages, use the icons on the toolbar to review the content 

of the other pages.

If the desired data file is not displayed in the [Data Explorer] sub-window, click  (Select Folder), 
and specify the folder that contains the desired data file. 
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5.7.3 Edit PDA Report Format
The following 8 report items are provided for inclusions in the PDA data analysis format. 

This section describes how to edit items in the report format file opened at "5.7.2 Open Report Format 
Files". 

Item Contents

 Contour Graph
Prints the contour graph and 3D graph of the data acquired by the PDA detector. 

Reference
For details, see "Change the Display Color and Scale of the Contour View" 
P.164. 

 3D Graph

 UV Spectrum
Prints the information in the spectrum files and the spectra extracted from the data 
acquired by the PDA detector. 

Reference
For details, see "Change the Content and Print Scale for UV Spectra" P.166. 

 Peak Purity
Prints the peak purity calculation results for the data acquired by the PDA detector. 

Reference
For details, see "Specify the Peaks and Calculation Method to Print the Peak 
Purity Calculation Results" P.170. 

 Peak Profile

 UV Spectrum Index
Prints the identified peak information and its spectrum. 

 UV Library Search
Prints the library search results for the data acquired by the PDA detector. 

Reference
For details, see "Change the Content and Print Scale for Library Search 
Results" P.168. 

 UV Library
Prints a list of the spectrum information registered to the UV spectrum library. 
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 Change the Display Color and Scale of the Contour View
Use the pre-installed report format file “Contour3DReport.lsr” to print contour views. Refer to "5.7.2 Open 
Report Format Files" and open “Contour3DReport.lsr”. 

1 Double-click the [Contour Graph] item.

The [Contour Properties] sub-window is displayed.

2 Click the [Contour] tab, and set the [Inten. Scale Position], [Color Mode], and [Number of 

Colors] parameters. 

3 Click the [Scale/Title/Range] tab, then under the [Display Area] deselect [Auto] for the 

the X-axis (time), Y-axis (wavelength) and Z-axis (intensity). Enter the desired scale for 

each. 

4 Click [OK]. 

Reference
For details, see "5.7.4 Preview Before Printing" P.172. 
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 Change the Display Scale of 3D Graphs
Use the pre-installed report format file “Contour3DReport.lsr” to print 3D graphs. Refer to "5.7.2 Open 
Report Format Files" to open “Contour3DReport.lsr”. 

1 Double-click the [3D Graph] item. 

The [3D Graph] item is located on the second page of “Contour3DReport.lsr”. 

2 Click the [3D] tab, and set the [Inten. Scale Position], [Color Mode], [Number of Colors], 

and [Rotate] parameters. 

3 Click the [Scale/Title/Range] tab and under the [Display Area], deselect [Auto] for the X-

axis (time), Y-axis (wavelength) and Z-axis (intensity). Enter the desired scale for each. 

4 Click [OK]. 

Reference
For details, see "5.7.4 Preview Before Printing" P.172. 

The point of rotation is not displayed. 
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 Change the Content and Print Scale for UV Spectra
Use the pre-installed report format file “PDADataAnalysisResults.lsr” to print UV spectra. Refer to "5.7.2 
Open Report Format Files" to open “PDADataAnalysisResults.lsr”. 

1 Double-click the [UV Spectrum] item. 

2 Click the [Spectrum] tab, and select the spectrum from the [Selection] list. 

Parameter Explanation
ID Peak Selects the spectra to print by entering the ID#s of the compounds in the Compound 

Table. 
The spectra of all identified peaks are printed if [0]-[0] is entered. 

All Channel Select the retention time range at [RT]. 
The spectra of all detected peaks are printed if [0]-[0] is entered.
If multiple peaks are detected, the printed spectra can be easily checked by selecting 
[Reduce duplicate output for same RT]. 

Multi Chromatogram Sets the number of the peak at [Peak #].
The spectra of all detected peaks are printed if [0]-[0] is entered. 

Spectrum Table Sets the row No. of the table at [Row]. 
All of the spectra registered in the Spectrum Table are printed if [0]-[0] is entered.
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3 Click the [Header] tab, and edit the items to display in the report. 

4 Click the [Scale/Title/Range] tab. 

1 Deselect [Auto] for the X-axis (wavelength) and Y-axis (intensity) in the [Display Area], and enter the 
desired scale. 

2 To output reports of lambda max or lambda min spectrum, select [Lambda max Label] or [Lambda 
min Label], and click [Format]. 

5 Click [OK]. 

Reference
Refer to "5.7.4 Preview Before Printing" P.172 for details. 

1
2
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 Change the Content and Print Scale for Library Search Results
Use the pre-installed report format file “PDADataAnalysisResults.lsr” to print library search results. Refer to 
"5.7.2 Open Report Format Files" to open “PDADataAnalysisResults.lsr”. 

Data processing parameter changes on the [Library Search] tab for the data file are not printed even if the 
library search results are printed. Add the [Method] item to print the settings made on the [Library Search] 
tab. 

1 Double-click the [UV Library Search] item. 

The [UV Library Search] item is located on the second page of “PDADataAnalysisResults.lsr”. 

2 Click the [UV Library Search] tab. 

1 Select the searched peaks to display in the [Selection] list. 

2 Enter the number of hits to display at [# of Hits]. 

3 Select the target spectrum print method at [Display target spectrum]. 

1

3

2
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3 Click each of the [Search Header], [Result Spectrum Header], and [Target Spectrum 

Header] tabs, and edit the header information to display in the report. 

The [Target Spectrum Header] tab is shown in the following example. 

Reference
Refer to "7.5.10 Edit Calibration Curve Information" P.267 for more details.

4 Click each of the [Result Spectrum - Scale/Title/Range], and [Target Spectrum - Scale/

Title/Range] tabs and under [Display Area], deselect [Auto] for X-axis (wavelength) and 

Y-axis (intensity). Then, enter the desired scale. 

The [Target Spectrum - Scale/Title/Range] tab is shown in the following example. 
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5 Click the [Search Result] tab, and select the table information to be displayed for each of 

the spectra hit (found) in the search. 

6 Click [OK]. 

Reference
Refer to "5.7.4 Preview Before Printing" P.172 for details. 

 Specify the Peaks and Calculation Method to Print the Peak Purity Calculation 
Results
Use the pre-installed report format file “PDADataAnalysisResults.lsr” to print peak purity calculation results. 
Refer to "5.7.2 Open Report Format Files" to open “PDADataAnalysisResults.lsr”. 

Data processing parameter changes made on the [Purity] tab for the data file are not printed even if the peak 
purity calculation results are printed. Add the [Method] item to print the settings made on the [Purity] tab. 

1 Double-click the [Peak Purity] item.

The [Peak Purity] item is located on the third page of “PDADataAnalysisResults.lsr”. 
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2 Click the [Peak Purity] tab. 

1 Select the peaks to display in the [Selection] list. 

If [ID Peak] is selected, select the calculation results to print by entering the ID#s of the compounds 
in the Compound Table. The calculation results of all identified peaks are printed if [0]-[0] is entered. 

If [Multi Chrom] is selected, select the number of the peak at [Peak #]. The calculation results of all 
detected peaks are printed if [0]-[0] is entered.

2 Select the purity calculation mode in the [Mode] list. 

3 Select the display graph in the [Graph Type] list. 

3 Click the [Header] tab, and edit the items to display in the report. 

Reference
Refer to "7.5.10 Edit Calibration Curve Information" P.267 for details.

4 Click [OK]. 

1

2

3
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5.7.4 Preview Before Printing
Preview the print details set in "5.7.3 Edit PDA Report Format" before printing the report.

1 Click the  (Preview) icon on the [Report] assistant bar. 

2 Check the report in the preview sub-window, and click [Close]. 

3 Click the  (Print) icon on the [Report] assistant bar. 

The report is printed. 
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5.7.5 Save Report Format Files
Once a report format is complete, save the report format file under a new name. 

1 Click [Save Report Format File As] on the [File] menu. 

2 Set [Save in], enter the file name, and click [Save]. 
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6MS Data Analysis

This chapter describes how to acquire data on an MS detector, to display obtained chromatograms 
and spectra, and set data processing parameters during postrun analysis. 

Qualitative and quantitative processing is performed on compounds in unknown samples. In 
qualitative processing, peak integration is performed on chromatograms to detect peaks and search 
for obtained spectra in a library. In quantitative processing, the concentration of compounds in an 
unknown sample is calculated according to a calibration curve created form a standard sample of a 
known concentration. 

6.1 [MS Data Analysis] Window
The [MS Data Analysis] window is comprised the following sections.

• [Chromatogram View] - displays chromatograms

• [Spectrum View] - displays spectra

• [Results View] - displays Peak Tables and quantitative results

• [Method View] - displays data processing parameters

6.1.1 Open the [MS Data Analysis] Window

1 Click the  icon in the [LabSolutions Main] window, and double-click the [Postrun] 

icon. 
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2 Click the  (MS Data Analysis) icon on the [Main] assistant bar in the [Postrun 

Analysis] program. 

3 Drag-and-drop the MS data file onto the [MS Data Analysis] window from the [Data 

Explorer] sub-window. 

The contents of the data file are displayed in the [MS Data Analysis] window. 
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6.1.2 [MS Data Analysis] Window Description
This section describes how to view and use the [MS Data Analysis] window. 

No. Explanation
1 Displays the [Standard] and [MS Data Analysis] toolbars. 

2 Click this icon in each sub-window to expand the sub-window to a full-screen view and again to return the view 
back to the normal size view. 

3 Displays the chromatograms in the open data file. Double-click on a chromatogram to display the spectrum 
extraction line (vertical cursor). The [Spectrum Process Bar] displayed at the bottom shows the range where 
the spectrum underwent average/subtraction processing. 
Refer to "6.2.8 Manual Average/Subtraction Processing on Spectra" P.194 for details on average/subtraction 
processing of spectra. 

4 The chromatogram line width displayed in the [Chromatogram View] can be emphasized.

This item can be chosen, when display modes are [View All Segments] and [View Multiple 
Segments], or when it is in [Overlay] mode at the time of [View Each Segment]. 

5 Allows changing the active block.
The number of blocks to be displayed in a single window and the number of chromatograms to be displayed in 
one block are specified on the [Chromatogram Table] tab in the [MS Data View Parameters] sub-window.

6 Moves the spectrum extraction line on the chromatogram. Click the [Peak] button to move the spectrum 
extraction line moves to the next peak top. Click the [Scan] button to move the spectrum extraction line in 
small increments. 

7 Click the [Segment] button to change the displayed segment when [Chromatogram View] is set to [Each 
Segment]. Refer to "6.2.4 Change the [Chromatogram View] Display Mode" P.183 for details on [Each 
Segment]. 

8 Displays the MS spectrum at the time selected by the spectrum extraction line on the chromatogram. 

Toolbar1

0 [Method View]

[Chromatogram View]3

[Results View]b

2

8
[Spectrum 
View]

6 7

9

a

5
4
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• Files currently being edited in other windows are [Read Only] and cannot be saved. Exit the other 
application and open the file again to save the results of editing. 

• The [MS Data Analysis] window displays the contents of only one data file. Open the [Quant Browser] or 
[Data Browser] window to check the contents of multiple data files. Refer to "11 Quant Browser" P.327 or 
"12 Data Browser" P.347 for details. 

• The [MS Data Analysis] window is comprised of views that are separated by several dividers. The views 
can be resized by dragging these dividers with the mouse. 

• Click [Save Layout] on the [Layout] menu in the [MS Data Analysis] window to save the layouts for each 
view. Click [Select Layout] on the [Layout] menu in the [MS Data Analysis] window to open a saved 
layout. 

• Click [Layout for Qualitative] or [Layout for Quantitative] on the [Layout] menu in the [MS Data Analysis] 
window to display the ideal layout for the respective processing type. 

• Click [Display All] on the [Layout] menu in the [MS Data Analysis] window to return to the default layout. 

• Click [Rollback to Original Data] on the [File] menu return the data processing parameters to those when 
the data was acquired. 

• For data obtained using the MS detector, event groups that have the same measurement starting and 
ending time are displayed as a segment. In the example shown below, event 1 and event 2 are 
considered segment #1 and event 3 is segment #2. 

9 Click  (Edit Mode) to change the data processing parameters in the method. Click  (View 
Mode) after editing the parameters to reflect the changes in the [Method View]. 

0 Displays the data processing parameters. 

a  (Wide Size) or  (Normal Size) is displayed in [Results View] and [Method View], use them to stretch 
the sub-windows across the screen in the horizontal direction and return to the normal size display. 

b Displays the analysis results. 

No. Explanation
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6.2 Display Chromatograms and Spectra
This section describes how to display chromatograms and spectra on the [MS Data Analysis] window. 

6.2.1 Spectra from [Chromatogram View]
Double-click a chromatogram in the [Chromatogram View] to move the spectrum extraction line to that 
position, and display the spectrum in the [Spectrum View]. 

1 In the [Chromatogram View], double-click the time to be extracted as the spectrum. 

If a time is selected within peak detection, the displayed spectrum undergoes average or subtraction 
processing based on the spectrum processing parameters. 

The spectrum extraction line moves, and the spectrum at that time position is displayed in [Spectrum 
View]. 
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• Click the [Peak] buttons at the top of the [Chromatogram View] to move the spectrum extraction 
line to the next peak top (RT). Peaks must already have been detected to use this function. 

• The spectrum that is displayed when the [Peak] button is clicked undergoes average/subtraction 
processing based on the spectrum processing parameters. 

• Click the [Scan] button at the top of the [Chromatogram View] to move the spectrum extraction 
line moves by the preset scan unit.

Reference
Refer to "6.3.1 Qualitative Peak Integration" P.199 for details on peak integration and "6.2.7 Average/
Subtraction Processing on Spectra" P.192 for details on spectrum processing parameters. 

6.2.2 Chromatograms from [Spectrum View]
Double-click a spectrum peak in [Spectrum View] to display the chromatogram of that m/z in the 
[Chromatogram View]. 

1  Double-click the m/z in [Spectrum View] that is to be extracted as the chromatogram. 

The chromatogram of that m/z is listed in the Chromatogram Table and added to the [Chromatogram 
View]. 

Reference
Refer to "6.2.6 Display Chromatograms from the Chromatogram Table and MIC Table" P.188 for details on 
the Chromatogram Table. 
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6.2.3 Display Chromatograms and Spectra from the Compound Table
Click a row in the Compound Table on the [Compound] tab in [Method View] to display all of the spectra for 
the time of the identified peak. 

1 Click (Wide Size) in [Method View]. 

2 Click the [Compound] tab in [Method View], and click the row of target compound. 
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The spectrum extraction line moves to the time position in [Chromatogram View] where that compound is 
identified, and the spectrum in [Spectrum View] is updated. 
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6.2.4 Change the [Chromatogram View] Display Mode
The display in [Chromatogram View] can be changed to [View All Segments], [View Multiple 
Segments] or [View Each Segment]. 

In the [View Multiple Segments], segments are displayed in the [Chromatogram View] as blocks 
containing the specified number of segments. To switch blocks, use the spin button at the top of the 
[Chromatogram View].

In the [View Each Segment], the chromatogram can be viewed as an [Overlay], [Stack] or [Single] 
view. This section describes how to change the chromatogram display from [Overlay] to [Stack]. 

1 Right-click on the desired chromatogram in the overlay display and select [View Each 

Segment], and click [Stack]. 

The chromatograms are displayed in a stack and the focus bar is displayed to the left of the active 
chromatogram. 

• When [All Segments] is selected, only the [Overlay] setting is available. 

• The [Single] setting displays each chromatogram individually. Select the  at the top of the 

[Chromatogram View] to change the displayed chromatogram. The  buttons are only displayed 

when [Single] is selected. 
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 Display Multiple Chromatograms in the Base Shift View
The base of each chromatogram displayed in the overlay can be shifted to make them easier to identify. 

1 Right-click on the desired over lay chromatogram, and select [Base Shift]. 

The chromatograms are displayed with their bases shifted. 
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 Chromatogram View Display Settings
Set the chromatogram display mode, whether to display [Spectrum Process Bar] and [Sample Info.], and 
the chromatogram display range in the [Chromatogram View Display Settings] sub-window. 

1 Right-click on [Chromatogram View], and click [Display Settings]. 

2 Select the desired items, and click [OK]. 

1 Select the chromatogram display mode. 

2 Determine whether to display the [Spectrum Process Bar] and [Sample Info.] in [Chromatogram 
View]. 

3 When [Auto-scan to Intensity] is selected at [Scale to], the intensity axis of the chromatogram is 
displayed according to the maximum intensity. If [User Defined] is selected, set the range of the 
intensity axis to display at [Intensity Range]. 

1

3

2
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 Peak Top Comments
This section describes how to display the retention time at the top of the peak. 

1 Right-click on the chromatogram, and then click [Graph Property]. 

2 Select the peak top comment to display on the chromatogram, and click [OK]. 

In this example, the retention time is displayed at the top of the peak. 
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6.2.5 Change the [Spectrum View] Display Mode
If the inside of a segment contains multiple events, the spectra acquired for each individual event can be 
displayed as a stack or an overlay. This section describes how to change from a stack display to an overlay 
display. 

1 Open a data file that contains multiple events inside the same segment, and click 

[Overlay]. 

When multiple spectra are displayed in the stack display mode, the focus bar is displayed to the left 
of the active spectrum. 

All currently displayed spectra are displayed in the overlay display mode. 
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2 Make the desired selections. 

1 If data acquisition was performed with multiple segments, click  to change the displayed 
segment. 

2 Determine whether to display spectra for each event when data acquisition was performed with 
multiple events. 

3 If profile analysis was performed, set the centroid spectrum display and profile spectrum display. 
When both display modes are selected, both spectra are displayed simultaneously. 

4 Select whether to overlay spectra by absolute intensity or relative intensity. 

6.2.6 Display Chromatograms from the Chromatogram Table and MIC 
Table
Chromatogram Table and MIC Tables are used to display chromatograms at a specified m/z or to display 
chromatograms that cannot be specified by a single m/z, such as TIC/MIC. 

 Register Chromatograms in the Chromatogram Table
TIC/MIC selection, MS chromatogram display and base shift are set in the Chromatogram Table. This 
section describes how to enter the m/z and display chromatograms. 

1 Click the  (Data View Parameters) icon on the [MS Data] assistant bar. 

1
2

4

3
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2 Click the [Chromatogram Table] tab, set each item, and click [OK]. 

1 If the [View Multiple Segments] is selected, sets the number of blocks to be displayed in one window 
and the number of chromatograms to be plotted per block.

To select the [View Multiple Segments], attach the checkmark to [View Multiple Segments]

on the right-click menu in the [Chromatogram View].

2 If the [Set Identical Settings for All Segments] is selected, TIC/BPC/MIC/None settings specified for 
individual segments or events are ignored. And Select [TIC] or [None].

 TIC: Specifies using the TIC/MIC mass table for TIC.

 None: Ignores TIC/MIS mass table settings and does not display TICs, BPCs, or MICs.

3 If data acquisition was performed with multiple segments, click  to change the target segment. 

4 Specify TIC, BPC or MIC. 

Use the table on the right to select the chromatogram to display for each event and the display scale 
for the intensity axis.

5 If [Disp.] is selected, the chromatogram for the preset m/z is displayed. 

6 Enter the m/z. 

In this example, enter “338.00” at [m/z]. 

• Enter the [m/z] start and end points delimited with a hyphen to display chromatograms in a 
specified m/z range. (example: 183.00-185.00)

• When displaying chromatograms for MRM events, the [Precursor m/z] and [Product m/z] 
values separated by a " > " symbol is displayed in a dropdown list box at [m/z]. (Example: 
231.10 > 189.00)

7 Specify the display scale for the intensity axis. 

3

4

8
9

1
2

5

6

7

Mass table2
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8 If [Spectrum View] is double-clicked and m/z is registered to the Chromatogram Table, the scale can 
be set so that the chromatogram automatically becomes about 50% of the maximum intensity of TIC 
when [Set factor on registering MC] is selected. 

9 Select [Base Shift] to display the chromatogram with its base shifted. 

Chromatograms are added to [Chromatogram View] according to the settings made to each item. 

 Edit the MIC Table and Display MIC in [Chromatogram View]
Set the m/z range to be integrated in the MIC Table to display MIC in [Chromatogram View]. 

1 Click the  (Data View Parameters) icon on the [MS Data] assistant bar. 

2 Click the [MIC Table] tab, and set each item. 

1 Select [Use TIC] so that TIC is used instead of MIC. 

Usually, TIC is combined with [Remove m/z Range]. 

2 Set the m/z range of MIC to be integrated. 

1

2

3
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In this example, change the setting from “10.00” to “500.00”. 

3 Set the m/z range to exclude from the m/z that was set at [Added m/z Range]. 

• Up to 8 pages can be set. Click  to change the page. 

• Click [Delete Page] to delete the contents of the currently displayed [Page #]. 

3 Click the [Chromatogram Table] tab, select [MIC], and click [OK]. 

The chromatogram obtained by integrating signals within the m/z range is displayed in [Chromatogram 
View]. 

The page number can be changed using the box to the right of [MIC] in the Chromatogram Table. 
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6.2.7 Average/Subtraction Processing on Spectra
When a peak is selected and its spectrum is displayed in [Chromatogram View], average/subtraction 
processing is performed on the spectrum according to the spectrum processing parameters. 

Reference
Refer to "6.2.8 Manual Average/Subtraction Processing on Spectra" P.194 for details on performing manual 
average/subtraction processing on spectra. 

1 Click  (Full Size) in [Method View]. 

2 Click  (Edit Mode) in [Method View]. 
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3 Click the [Spectrum] tab, and set each item. 

1 When a peak is selected on a chromatogram, select whether to set the displayed spectrum as the 
peak top (+ number of average points) or to set the displayed spectrum as a spectrum obtained by 
integrating from the peak start to peak end range. 

2 Select the spectrum to be integrated in background. 

4 Click  (View Mode) in [Method View], and click  (Normal Size). 

When the peak is extracted from the chromatogram, the spectrum is processed using the preset 
conditions. 
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6.2.8 Manual Average/Subtraction Processing on Spectra
Average the spectrum in [Chromatogram View] to obtain an integrated spectrum on any specified 
time range. Also, subtract spectrum in [Chromatogram View] when performing background 
processing. 

 Average MS Spectra

1 Click  (Average Spectrum) on the toolbar. 

Spectra can also be averaged by right-clicking on [Chromatogram View], selecting [Spectrum 
Calculation], and clicking [Average]. 

2 Use the mouse to select the time range to be averaged on [Chromatogram View]. 

The spectrum averaged within the selected time range is displayed in [Spectrum View]. 
The averaged time range is displayed in black in [Spectrum Process Bar] at the bottom of [Chromatogram 
View]. 
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 Subtract MS Spectra

1 Click  (Subtract Spectrum) on the [MS Data Analysis] toolbar. 

Spectra can also be subtracted by right-clicking on [Chromatogram View], selecting [Spectrum 
Calculation], and clicking [Subtract]. 

2 Use the mouse to select the time range to be subtracted on [Chromatogram View]. 

The spectrum obtained by subtracting the spectrum in the specified time range in background is 
displayed in [Spectrum View]. The time range averaged for subtraction is displayed in gray in [Spectrum 
Process Bar] at the bottom of [Chromatogram View]. 

Click  (Subtract Spectrum) and double-click the target time in the chromatogram to perform the 
subtraction process on the spectrum. 
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 Check Averaged and Subtracted Retention Times in [Spectrum View]
The spectrum-calculated time is displayed at the top of the [Spectrum View]. The following is an example of 
a subtracted spectrum created by averaging the time 6.160 min to 6.810 min from the spectrum created by 
averaging the time 4.152 min to 4.760 min. 

6.2.9 Add Spectra to the Spectrum Process Table
The spectrum displayed in the [Spectrum View] can be entered into the Spectrum Process Table. 
Processed spectra can be displayed by selecting averaged or subtracted spectra that was previously 
added to the Spectrum Process Table. Spectra in the Spectrum Process Table are used in reports and 
library searches. 

1 Display the spectrum in the [Spectrum View], and click  (Register to Spectrum 

Process Table) on the toolbar. 

Spectra can also be registered by right-clicking on the spectrum display area of [Spectrum View], 
and clicking [Register to Spectrum Process Table] on the displayed menu.

2 Click [OK]. 
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The spectrum is registered to the Spectrum Process Table on the [Spectrum] tab in [Results View]. 

• Select a row in the Spectrum Process Table to display that information in the [Spectrum View]. 

• To delete a spectrum, right-click on the Spectrum Process Table, and click [Delete Row] or [Delete Table].
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 Sort the Spectrum Process Table by #(Scan) or Top Time (Retention Time)

This section describes how to change the sort procedure for the Spectrum Process Table from 
[#(Scan)] to [Top Time] (retention time). 

1 Click  (Wide Size) in [Results View]. 

2 Right-click on [#(Scan)] in the Spectrum Process Table, and click [Retention Time]. 

[Top Time] (retention time) is displayed in the Spectrum Process Table. 

3 Click  (Normal Size) in [Results View]. 
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6.3 Qualitative Processing
This section describes how to set qualitative peak integration parameters. The chromatogram displayed in 
[Chromatogram View] is targeted for qualitative processing. The result is displayed in the Spectrum 
Process Table on the [Spectrum] tab in [Results View] and on the [Peak Table] tab. 

6.3.1 Qualitative Peak Integration
This section describes how to set qualitative peak integration parameters in the [Method View]. 

The data processing parameters for the data file displayed in the [MS Data Analysis] window can be edited. 
The data processing parameters must be saved as a method file before they can be used to process other 
data files. Refer to the Data Acquisition & Processing Theory Guide for details on the method information 
stored in the data files. 

1 Click  (Full Size) in [Method View]. 

2 Click  (Edit Mode) in [Method View]. 
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3 Click the [Integration] tab, and set each parameter as required. 

1 Select the m/s or compound name from the list and enter the individual peak integration parameters. 

Only [Default] and compounds with [Yes] selected at [Individual setting] can be edited. 

2 Select whether to set peak integration parameters individually. 

Select [No (Use Default)] to perform peak integration using the parameters set as [Default] in the list. 

• Click  and enter the integration time program to change peak integration parameters at 

different times throughout the chromatogram.

•  Click [Noise/Drift Calculation], and enter the [Noise/Drift Calculation Settings] parameters to 
select the method of noise and drift calculation, and the detection and quantitative limit coefficient. 

• Right-click on [Method View] and click [Cancel Edit] to cancel editing in [Method View]. 

Reference
Refer to the Data Acquisition & Processing Theory Guide for details on each of the parameters. 

4 Click  (View Mode) in [Method View], and then click  (Normal Size). 

2

1
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5 Click the  (Qualitative Peak Integration) icon on the [MS Data] assistant bar. 

The same processing can be achieved by right-clicking on [Chromatogram View] and clicking [Peak 
Integration]. 

6 Set the parameters in the [Qualitative Peak Integration] sub-window, and click [OK]. 

1 If data acquisition was performed with multiple segments, click  to change the target segment.

2 Select how detected peaks are registered to the Spectrum Process Table on the [Spectrum] in 
[Results View]. 

3 Select [Proc.] to perform peak integration for the chromatogram at the selected m/z. 

1
2

3
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The base line and peak top comment are displayed in [Chromatogram View], and the results of qualitative 
peak integration are displayed on the [Spectrum] and [Peak Table] tabs in [Results View]. 

Reference
Refer to "Peak Top Comments" P.186 in "6.2.4 Change the [Chromatogram View] Display Mode" if 
peak top comments are not displayed on the chromatogram. 



 Operators Guide   203

6.3  Qualitative Processing

6

6.3.2 Manual Qualitative Peak Integration
Peak integration can be performed manually if the peaks are not detected with peak integration 
parameters. This section describes how to manually insert peaks. 

1 Right-click on [Chromatogram View], and click [Display Settings]. 

2 Set the chromatogram display mode to [Stack] or [Single], and click [OK]. 

The [Manual Integration Bar] cannot be displayed for overlaid chromatograms. Set the display mode 
to [Stack] or [Single] to perform manual peak integration. 
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3 Right-click on [Chromatogram View], and select [Manual Integration Bar]. 

The [Manual Integration Bar] can also be displayed by selecting [Manual Integration Bar] on the 
[View] menu in the [MS Data Analysis] window. 

4 Click the  (Auto Mode) icon.  

Reference
Refer to "4.2.4 Manual Peak Integration" P.93 for details about the icons.
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5 Move the mouse to near the vertical division line to unify. 

The vertical division line is highlighted.

6 Right-click on the graph, and click [Unify Peaks] on the displayed menu. 

The peak is unified.

• Peaks can be unified using  (Unify Peaks) icon.
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• The peak integration processing command can also be executed on multiple peaks as a single 
peak by changing the [Width] value on the [Integration] tab page in [Method View].

Reference
For details on the [Width] value, refer to Help.

7 Click  to close the [Manual Integration Bar].

6.3.3 Check Peak Integration Results in the Peak Table
Use the Peak Table to display the results of peak integration, and register selected peaks to the 
Spectrum Process and Compound Tables. 

1 Click  (Wide Size) in [Results View]. 

2 Click the [Peak Table] tab in [Results View]. 

1 Select the integrated chromatogram. 

The peak integration results in the Compound Table are displayed by compound name. 

2 Click a row on the Peak Table, and verify the peak information in [Chromatogram View] or [Spectrum 
View]. 

1

3
4

2
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3 Right-click on the row to register to the Spectrum Process Table, and click [Register Selected Peak 
to Spectrum Table]. 

The information is registered to the Spectrum Process Table on the [Spectrum] tab in [Results View]. 

4 Right-click on the row to register to the Compound Table, and click [Register Selected Peak to 
Compound Table]. 

The information is registered to the Compound Table on the [Compound] tab in [Method View]. 

Right-click on the Peak Table and click [Table Style] to select the items to be displayed in the 
Peak Table. 

6.3.4 MS Spectrum Library Searches
Use library searches to select spectra from MS library files with a high similarity to the spectrum of the 
detected peak. Use a specific search index as the search key to further filter the library spectra search. 
Libraries can be searched using [Library] or [(MSn)Library].

This section describes how to perform spectra library searches in [Spectrum View] and in the Spectrum 
Process Table. 

 Library Searches in [Spectrum View]

1 Click  (Full Size) in [Method View]. 

2 Click  (Edit Mode) in [Method View]. 



6  MS Data Analysis

208   Operators Guide

3 Click the [Library] tab or the [(MSn)Library] tab, and set each parameter. 

 [Library] tab

1 Select [Search with Library function].

2 Click  under [Library File Name] to select the files to be searched.

Up to 5 MS library files can be entered. [Min Similarity] can be set for each of the MS library files. 

3 Enter [File name], and click [Open]. 

4 Set the [Search Depth] and [Max Hits]. [Search Depth] specifies the range of important peak groups 
to target in the search, and [Max Hits] specifies the number of search result that are output. 

5 Set the search conditions to perform a filtered library search according to the index information, such 
as molecular weight and compound name. 

1

4

5

2
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 [(MSn)Library] tab

1 Select [Search with (MSn)Library function].

2 Click  under [Library File Name] to select the files to be searched.

Up to 5 MSn library files can be entered. [Min Similarity] can be set for each of the MS library files. 

3 Enter [File name], and click [Open]. 

4 Click  (View Mode) in [Method View], and click  (Normal Size). 

5 Right-click on the spectrum in [Spectrum View], and click [Library Search]. 

The [Library Search Results] sub-window or [(MSn) Library Search Results] sub-window is displayed. 

Reference
Refer to "6.3.5 Check the Library Search Results" P.211 for details on the [Library Search Results] 
sub-window or [(MSn) Library Search Results] sub-window. 
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 Library Searches in the Spectrum Process Table
A batch library search can be performed on multiple spectra in the Spectrum Process Table. 

Set the MS library files on the [Library] tab in [Method View]. Refer to "Library Searches in [Spectrum View]" 
P.207 in "6.3.4 MS Spectrum Library Searches" for details on how to set MS library files. 

1 Register the spectra to be searched from the library in the Spectrum Process Table. 

Reference
Refer to "6.2.9 Add Spectra to the Spectrum Process Table" P.196 for details on registering spectra 
to the Spectrum Process Table. 

2 Right-click on the Spectrum Process Table on the [Spectrum] tab in [Results View], 

select [Library Search], and click [All Rows]. 

• Right-click the row of the spectrum to perform the library search on, select [Library Search] and 
click [Selected Rows]. The library search is performed only on the spectrum registered to that row.

• Library searches can also be performed on the spectra of multiple rows. Select all of the rows with 
the [Shift] or [Ctrl] key held down then right-click and select [Selected Rows] at [Library Search].

The library search is performed for all spectra in the Spectrum Process Table with an “S” or a “M” 
displayed in the [Search] field. The (MSn) library search results with the largest similarity are displayed in 
the Spectrum Process Table. When a [Report] field is changed in the [(MSn) Library Search Results] sub-
window, the (MSn) library search results displayed in the Spectrum Process Table are also changed.
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3 Double-click the library-searched row. 

The [Library Search Results] sub-window or [(MSn) Library Search Results] sub-window is displayed. 

The [Library Search Results] sub-window or [(MSn) Library Search Results] sub-window can also be 
displayed by right-clicking on a library-searched row, and clicking [Library Search Results]. 

Performing either library search or (MSn) library search depends on the settings on 
the [Library] tab or [(MSn)Library] tab in [Method View]. Refer to "Library Searches in 
[Spectrum View]" P.207 in the"6.3.4 MS Spectrum Library Searches".

6.3.5 Check the Library Search Results
This section describes how to view the [Library Search Results] described in "6.3.4 MS Spectrum 
Library Searches" P.207. 

•  [Library Search Results] sub-window

No. Explanation
1 Displays a list of the search results. Compounds are displayed in order from the highest similarity to the lowest. 

2 Displays the target spectrum. 

3 Displays the selected library spectra found in the library search. Click the button on the left of the graph to 
display the next library spectra in the search result list. 

1

2

3

4
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Right-click on the spectrum in the [Library Search Results] sub-window, and click [Compare], [Information] 
and [Subtract] to change the display content. 

•  [(MSn)Library Search Results] sub-window

4 Displays the compare result spectra, compound information and subtraction result spectra. Click the button on 
the left of the compare result spectra to display the next library spectra in the search result list. The spectra 
obtained by subtracting the library spectrum from the target spectrum are displayed. 

No. Explanation
1 Compounds are displayed in order from the highest similarity to the lowest.

The spectrum of the selected row is displayed in the (4) area. 

2 When the library search results of the Spectrum Process Table are displayed, the compound names selected in 
the [Report] field can be reflected in the compound name cells of the Spectrum Process Table which the data 
were called from. 

3 Displays the library spectrum of the selected row. Display can be switched by clicking p or q on the left side of 
the graph.

4 Sets the contents to display in (6).
[Compared Compound]: Displays the spectrum specified in the library.
[Information]: Displays the details on the library spectrum currently displayed in (4).
[Subtracted]: Displays the differential spectrum for the target spectrum and the library spectrum.

5 Displays the contents which are set in the [Display Setting] area shown in (5)

No. Explanation

1

2

6

3

4

5
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6.4 Edit the Private Library

The libraries, which are used for searching mass spectra acquired by the mass spectrometer, 

are created or maintained in the [MS Library Editor] or [(MSn) MS Library Editor] window. The 

libraries are saved in different format files depending on MS library search or MSn library search.

6.4.1 Display the MS Library Editor Window

 Display the MS Library Editor Window

Click the  (MS Library Editor) on the [Main] assistant bar to display the [MS Library 

Editor] sub-window.

 Display the (MSn) MS Library Editor Window

Click the  ((MSn)MS Library Editor) on the [Main] assistant bar to display the [MSn 

Library Editor] sub-window.
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6.4.2 Handle the Libraries

This section describes the basic methods to handle the libraries. The methods can be used both 

in the [MS Library Editor] and [MSn Library Editor] windows.

 Create a New Library 

1 Click the  (New) on the toolbar or click [New Library File] on the [File] menu.

The [Create New File] sub-window is displayed.

2 Enter the file name and click [Save].

A new library file is created. 
When editing library files directly, refer to "Open the Library" below and open the MS library that was 
created.

 Open the Library

Click  (Open) on the toolbar or click [Open Library File] on the [File] menu.

 Close the Library

Click [Close Library File] on the [File] menu. 

• When the library is changed, the changes are saved in a temporary library. (The menu to save the library 
does not exist.)

• As the default setting, the (MSn) library files are saved in the [MSLibary] folder where LabSolutions is 
installed. Since the MS library files are frequently shared, they are not the projects (folders) to be browsed 
in the [Data Explorer] sub-window but managed in one place.
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6.4.3 Register a Spectrum in a Library

Register a spectrum to a private library from the [MS Data Analysis] window as follows.

1 Display the spectrum to register in [Spectrum View]. Right-click on the [Spectrum View] 

and click [Register Spectrum to Library] or [(MSn) Register Spectrum to Library] on the 

displayed menu.

After the [Select Library] sub-window is displayed, select the library file in which the spectrum will be 
registered.

2 Edit the compound information.

 When the destination to register a spectrum is MS library

 When the destination to register a spectrum is MSn library

3 Set each item and click [OK].
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6.4.4 Convert MS library to MSn library
MS Library file (.lib) cannot be used in (MSn) MS library search features. 
This section describes how to convert MS Library file to (MSn) MS library file.

1 Open MS library file (lib) file in the [MS Library Editor] window.

2 Click [Convert MLB Library File] on the [File] menu.

3 Specify the [File name], and click [Save].

• In (MSn) MS library search feature, information that can be registered in the library is increasing, such as 
precursor ion. Therefore it is recommended that original spectrum should be registered into (MSn) MS 
library from the original data file.

• In (MSn) MS library search feature, algorithm for calculating the similarity score is different from the MS 
library search feature. Therefore, both target spectrum and library spectrum is same, similarity may be 
different from MS library search and (MSn) MS library search.
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6.5 Quantitative Processing
This section describes how to set quantitative parameters to perform quantitative processing. The 
chromatogram displayed on the [Compound] tab in [Results View] is targeted for processing. The 
processing results are displayed on the [Compound] and [Calibration Curve] tabs in [Results View]. 

6.5.1 Edit Quantitative Parameters and Compound Tables
Edit the parameters and Compound Table that are required for quantitative processing. This section 
describes how to perform quantitation using a 4-point calibration curve by the internal standard method.

1 Click  (Full Size) in [Method View]. 

2 Click  (Edit Mode) in [Method View]. 
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3 Click the [Identification] tab, and set each parameter.

1 Set the quantitative method and identification tolerance range for the retention time in the Compound 
Table.

2 Select the [Use Reference Ions] checkbox to perform the spectrum identification.

Reference
Refer to "6.8 Use a Spectrum for Peak Identification" P.236 for details on the spectrum 
identification.

3 Set the time width of the chromatograms to be displayed on the [Compound] tab page in [Result 
View].

4 Click the [Quantitative] tab, and set each parameter. 

1 Select [external Standard] as the [Quantitative Method]. 

2 Enter the number of concentration levels (number of calibration points) at [# of Calib. Levels]. 

3 1 2

12
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If necessary, set the parameters on the [Integration] and [Identification] tabs. 

5 Click the [Compound] tab, and set [Type], [Conc.], and [ISTD Group] for each 

compound.

Enter the concentration of the standard sample. 

• Right-click on a Compound Table on the [Compound] tab and click [Table Style] to select the items 
to be displayed in the Compound Table. 

• The ISTD concentration values are used to calculate the calibration curve as the ISTD amount. 

• If multiple ISTDs are used, number the substances in the [ISTD Group] column so that the ISTDs 
corresponding to the target substance are in the same ISTD group. 

6 Click  (View Mode) in [Method View], and click  (Normal Size). 

The new parameters are applied. 
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6.5.2 Quantitative Processing on Chromatograms
This section describes how to perform quantitative processing on chromatograms by creating a calibration 
curve and calculating the concentration values of the target peak. 

Refer to "6.5.1 Edit Quantitative Parameters and Compound Tables" P.217 to perform quantitative 
processing and edit the quantitative parameters and Compound Table. 

1 Click the  (Peak Integration for All IDs) icon on the [MS Data] assistant bar. 

The chromatograms undergo quantitative processing (peak integration, identification and quantitative 
processing) for all of the IDs in the Compound Table on the [Compound] tab in [Method View]. 

• Quantitative processing can also be performed by clicking  (Peak Integration for All IDs) on 

the toolbar or by right-clicking on the Compound Result Table and clicking [Peak Integration for All 
IDs]. 

• Right-click on the Compound Result Table, and click [Peak Integration for ID #] to perform peak 
integration for selected IDs in the Compound Result Table. 

The results of quantitative calculation are displayed in the [Conc.] field of the Compound Result Table.

• The [Conc.] displays are the result of multiplying concentrations obtained from the calibration 
curve by the [Dilution Factor] and dividing the result by the [Sample Amount]. The [Dilution Factor] 
and [Sample Amount] can be edited on the [Sample Info.] tab in the [Property] sub-window. The 
[Property] sub-window is displayed by clicking [Data File Properties] on the [File] menu in the [MS 
Data Analysis] window.

• Click a row in the Compound Result Table to display the information for that compound in 
[Chromatogram View] and [Spectrum View]. 

• Right-click on a Compound Table on the [Compound] tab and click [Table Style] to select the items 
to be displayed in the Compound Table.
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6.5.3 Calibration Curves
The calibration curves are part of the method information in data files and can be displayed on the 
[Calibration Curve] tab in [Results View]. 

Reference
Refer to the Data Acquisition & Processing Theory Guide for details on method information in data files. 

 Display Calibration Curves

1 Click the [Calibration Curve] tab in [Results View]. 

The compound names of the current calibration curve are displayed. Click  to change the ID and 
calibration curve. 
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 Disable Calibration Curves
Calibration curves can be disabled if standard samples were not been analyzed appropriately. This section 
describes how to disable calibration curves. 

1 Right-click on the calibration curve display area, and click [Calibration Information]. 

2 Deselect [Cal. Point]. 

Calibration points whose [Cal. Point] is deselected are disabled, the calibration curve is created again and 
the concentration re-calculated. 
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6.5.4 Check Quantitative Results on the [Compound] Tab
The quantitative processing results are displayed on the [Compound] tab in [Results View]. The ID 
chromatogram, calibration curve and Compound Result Table are displayed on the [Compound] tab. 

• The ID chromatogram, calibration curve and Compound Result Table are separated by a divider. Drag 
these dividers with the mouse to adjust the size of the display areas. 

• Calibration curves are not displayed as default. Refer to "6.5.5 Change the [Compound] Tab Display" 
P.224 to display calibration curves. 

No. Explanation
1 Displays the chromatogram of the compound selected in the Compound Result Table and the spectra of 

identified peaks are displayed in [Spectrum View]. Double-click the time position to be extracted and the 
spectrum for that time position is displayed in [Spectrum View]. 

2 Displays the calibration curve of the compound selected in the Compound Result Table. 

3 Displays the result of quantitative processing. 

2 Calibration curve 3 Compound Result Table1 ID chromatogram
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6.5.5 Change the [Compound] Tab Display
The ratio between the [ID Chromatogram] and [Calibration Curve] display areas can be changed in the 
[Display Settings (Compound Results)] sub-window. 

1 Right-click on Compound Result Table, and click [Display Settings]. 

2 Set each item, and click [OK]. 

1 Select the checkbox to display [ID Chromatogram] or [Calibration Curve]. 

2 Set the display ratio in the horizontal direction for both the [ID Chromatogram] and [Calibration 
Curve]. 

The [ID Chromatogram] or [Calibration Curve] display is changed. 

1

2
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6.5.6 Manual Quantitative Peak Integration
Peak integration can be manually performed if peaks are not be detected with the peak integration 
parameters. This section describes how to clear the results of peak integration, and manually insert 
peaks. 

1 Click  (Full Size) in [Results View]. 

2 Refer to "6.5.5 Change the [Compound] Tab Display" to change the display to make ID 

chromatograms, calibration curves and the Compound Result Table easier to view.

3 Right-click on the ID chromatogram on the [Compound] tab, and click [Manual 

Integration]. 
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4 Click the  (Auto Mode) icon. 

5 Move the mouse to the peak start point to insert . 



 Operators Guide   227

6.5  Quantitative Processing

6

6 Move the mouse to near the peak end point to insert . 

The manual peak integration results are displayed. 

7 Click  to close the [Manual Integration Bar].

8 Click  (Normal Size) in [Results View]. 

Peaks can be inserted by using  (Clear & Insert Peak) icon.
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6.5.7 Manual Peak Identification
This section describes how to perform manual identification if the target peak is not successfully identified. 

 Correct Identified Peaks
The target peak can be manually changed if another adjacent peak was mistakenly identified. 

1 Use the mouse to drag the  mark at the top of the closest incorrectly identified peak to 

the top of the peak. 

The tops of already identified peaks are marked by the  mark. 

2 Drop near the top of a new peak. 



 Operators Guide   229

6.5  Quantitative Processing

6

The identified peak is changed and the quantitative results are re-calculated. 

 Manual Identification
Perform manual identification if the peak was detected but not identified. 

1 Right-click on the ID chromatogram on the [Compound] tab, and click [Manual 

Identification]. 
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2 The cursor changes to a vertical line. Click near the retention time of the peak to 

identify.

The peak is identified and the quantitative results are re-calculated and displayed in the Compound 
Result Table. 

Right-click on the ID chromatogram, and click [Remove Identified Result] to delete identification 
results. 
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6.6 Save Method Files
Changes to the data processing parameters in [Method View] can be saved (exported) to a method file. 

1 Click the  (Apply to Method) icon on the [MS Data] assistant bar. 

2 Specify the [File name], and click [Save]. 

3 Set the [Selected Method Parameters] sub-window, and click [OK]. 

1 [Current Settings] saves the latest method parameters. [Acquisition Settings] saves the method 
parameters that were used at the time of data acquisition. Select [Current Settings] for this example. 

2 Select the method parameters to save. 
The selected method parameters are saved to the method file. 

1

2
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To open a method file, click [Load Method Parameters] on the [File] menu in the [MS Data Analysis] 
window, and specify the method file. 

6.7 Use the "Compound Table Wizard"
By using the "Compound Table Wizard", [Identification Parameters], [Quantitative Parameters], and 
[Compound Table] in [Method View] can be set at once. The "Compound Table Wizard" acquires 
identification conditions, such as peak retention time and spectrums, from the actual data.

1 Click the  (Create Compound Table Wizard) icon in the [MS Data] assistant bar.

The "Compound Table Wizard" is started.This wizard can be used when [Method View] is in the display 
mode.

2 Select either 1 or 2, and click [Next].

No. Description
1 Creates a compound table using spectrums already registered in the spectrum process table. Before 

starting the "Compound Table Wizard", register necessary peak spectrums in the spectrum process 
table.

2 Creates a compound table using peak spectrums detected by peak integration of the TIC.

1

2
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3 Check the number of spectrums registered in [Spectrum Process Table], and click 

[Next].

4 Select spectrums to process and click [Next].

No. Description

1 Check the retention time of spectrums to use to create a compound table.
The peaks around the retention times registered here are calculated.

2 Displays spectrums according to the rows selected in the table of 1.
It works in conjunction with the display of [Chromatogram View] of [MS Data Analysis]. Check the peak 
cutout, etc.

1

2
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5 Set each item and click [Next].

Reference
When grouping type is selected, make settings for each group on the [Group] tab of [Method View] 
after completing setting in the "Compound Table Wizard".

6 Set each item and click [Next].

No. Description

1 Specify a quantitative calculation method and a curve type.
Set required items.
For [Calculated by], select either peak area value or peak height value as the data used for quantitative 
calculations.
For [# of Calib. Levels] at [Calibration Curve], enter the expected number of levels of the calibration 
curve.

2 Setting [Group Type] will allow you to quantitatively analyze the following groups in addition to the 
individual quantitative calculations for each peak:
• [Group Calibration]

A calibration curve is created from the total area/height of peaks specified in the same group, and 
used for quantitative analysis.

• [Conc. Summation]
The sum of concentrations that have been individually obtained by quantitative calculation for the 
peaks specified in the same group is output.

1

2

1

2
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7 Set each item and click [Next].

Complete the detailed settings for each row of [Compound Table].
Enter a component name and a type for the peak to be identified, and register the reference ion.

When the external standard method is used for quantitative analysis, always specify [Target] for 
[Type]. For the internal standard method, specify [ISTD] only for the type of the internal standard 
substance, and enter the same number for the internal standard peak and [ISTD Group] of peaks 
that are calculated using the internal standard peak in the compound table.

8 When the confirmation screen appears, click [Finish].

The "Compound Table Wizard" is completed, and the edited content is reflected in [Compound Table].

9 Click  (View Mode) in [Method View].

The edited content is fixed.

To cancel the edited data, select [Cancel Edit] on the [Edit] menu in the [MS Data Analysis] window 

before clicking  (View Mode).

No. Description

1 In concentration (1), (2), ..., enter level 1 concentration, level 2 concentration, ... of the compound 
contained in the standard sample.(The "Level" number of each sample to be analyzed must be set to 
each sample in the Batch Table.)

2 Specify the peak identification method.
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6.8 Use a Spectrum for Peak Identification
This section explains how to specify the spectrum identification setting in the compound table.

To perform the spectrum identification, set up "reference ion ratio".

 Reference ion ratio identification
For the ion in [m/z] in [Compound Table] (target ion), the mass of the reference ion and the height ratio/
height acceptable width for the target ion are specified and used for identification.

The reference ion ratio identification may be used with the retention time identification.

Set the reference ion ratio

1 Click  (Edit Mode) in [Method View].

2 Click the [Identification] tab, and select [Use Reference Ions].

The reference ion identification is enabled.

3 Right-click on the [Compound] tab, and select [Set Reference Ion Ratio] from the 

displayed menu.

The [Reference Ion Ratio] screen appears.
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4 Set [m/z], [Ratio], and [Allowance], and click .

5 Click  (View Mode) in [Method View].

Clicking [Spectrum View] when the focus bar is displayed in the [m/z] cell sets that m/z value.

Set compound information
[Set Compound Information] allows you to edit the compound information on one row at once.

1 Click  (Edit Mode) in [Method View].

2 Right-click on the [Compound] tab, and select [Set Compound Information] from the 

displayed menu.

The [Set Compound Information] screen appears.

3 Set each item, and click one of [Insert], [Overwrite], or [Add to Tail].

The list of [Type], [m/z], and [Rel. Inten.] located in the lower right area can be set from the spectrum 
as follows.

This section describes the procedure to obtain [m/z] as an example.
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1 Click the [m/z] cell.

The [Pick m/z Value] screen appears.

2 Double-click the spectrum peak of the desired mass position.

The mass is set to the [m/z] cell.

4 Click  (View Mode) in [Method View].
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6.9 Print Data Acquisition Results
The [MS Data Analysis] window has a graph image function to print the [Chromatogram View] and 
[Spectrum View], and a data report function to print a report according to a specified report format. 

6.9.1 Print a Graph Image
This function prints the chromatograms and spectra displayed in the [MS Data Analysis] window. 

 Print from the [File] Menu
Select [Print Graph Image] on the [File] menu to print the displayed chromatograms and spectra on a 
single page. 

1 Select [Print Graph Image] on the [File] menu in the [MS Data Analysis] window, and 

click [Print]. 

The graph image can also be printed by clicking  (Print) on the toolbar. 
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The chromatograms and spectra are printed on a single page. 

 Print from the Popup Menu
Select [Print Graph] from the [Chromatogram View] or [Spectrum View] right-click menu to print the 
chromatograms and spectra on separate pages. 

This section describes how to print using the [Chromatogram View] right-click menu. 

1 Right-click on the chromatogram in [Chromatogram View], select [Print Graph], and 
click [Print]. 
The currently displayed chromatograms are printed on a single page. 

Right-click on the spectrum in [Spectrum View], select [Print Graph], and click [Print]. The currently 
displayed spectra are printed on a single page. 
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6.9.2 Print Using a Report Format
Data reports can be printed using the report format displayed in the [Report] window. 

1 Click the (Data Report) icon on the [MS Data] assistant bar. 

The [Report] window opens. If a report file was specified in data acquisition or postrun batch, that 
template is loaded. 

The [Report] window can also be opened by selecting [Data Report] on the [File] menu in the [MS 
Data Analysis] window and clicking [Edit Format]. 

2 Click the [Report Format] tab in the [Data Explorer] sub-window to change the template, 

and drag-and-drop the desired report file onto the [Report] window. 

Select the report file “Sample1.lcr” in this example. 
The report format opens. 
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3 Click the  (Print) icon on the [Report] assistant bar. 

The report is printed as currently displayed in the [Report] window. 

6.10 Use Mass Spectrum Pattern
This section describes how to check the identification results of a compound using automatic MS/MS or the 
(MSn) library search feature.

One or more events set in the Compound Table must be set in the dependent event of an MRM survey 
event. See "6.3.4 MS Spectrum Library Searches" P.207 for details on how to set (MSn) library search 
criteria.

 Set Identification Conditions

1 Click  (Edit Mode) in [Method View].

2 Click the [Identification] tab, and select [Use Mass Spectrum Pattern].
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3 Click  (View Mode) in [Method View].

 Perform Quantitative Processing on Chromatograms
See "6.5.2 Quantitative Processing on Chromatograms" P.220 for details on how to perform quantitative 
processing on chromatograms.

 Check Mass Spectrum Pattern Results
Check mass spectrum pattern results in the [Compound] tab in [Results View].

1 Click [Compound] tab in [Results View].

Mass spectrum pattern results are displayed in the Compound Result Table.

If the mass spectrum pattern results are not displayed in the Compound Result Table, right-click on 
the Compound Result Table, select [Table Style], and add [Similarity(Library)], [Compound 
Name(Library)], and [Ret. Time(Library)] to the [Display Items] box.

Merged Spectrum combined with the dependent event spectra related to the compound and 
dependent event spectra are displayed in [Spectrum View]
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2 Right-click the row showing the mass spectrum pattern results in the Compound Result 

Table and click [(MSn) Library Search Results].

The [(MSn) Library Search Results] screen appears.
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7Report Function

This chapter describes how to use the report function to print chromatograms and quantitative results. 

Use the report format function, to combine report items, such as sample information, chromatograms 
and quantitative results, to create reports in various formats. 

7.1 Print Reports in Batch Processing
This section describes how to use the Batch Table to print reports in realtime batch. 

Reference
Refer to "3.2 Create Batch Tables" P.43 for details on creating a new Batch Table. 

1 Click the  (Realtime Batch) icon on the [Main] assistant bar in the [Realtime 

Analysis] program. 

2 Click  (Toggle Data Explorer) on the toolbar. 

3 In the [Data Explorer] sub-window, drag-and-drop the target batch file onto the Batch 

Table. 
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4 Select the [Report Output] cell in the desired rows, and select the [Report Format File]. 

• If a new report format file has not been created, select an installed report format file in the [Report 
Format File] cell. 

• If a report format file has been created, select that report format file in the [Report Format File] cell. 

• If the [Report Format File] cell is left blank, the default report format file “Default.lsr” is used to print the 
report. 

Reference
Refer to "7.1.1 Change the Default Report Format File" P.246 for details on the default report format 
file. 

5 Click the  (Start Realtime Batch) icon on the [Realtime Batch] assistant bar. 

The report is automatically printed when data acquisition for the selected row is complete. 

Set the Batch Table in the same way in the [Postrun Batch] window, to automatically print reports in 
postrun batch. 

Reference
Refer to "3.4.4 Print a Summary Report" P.62 for details on outputting summary reports. 

7.1.1 Change the Default Report Format File
When [Report Output] is selected for single run or realtime batch, reports are printed in a pre-determined 
default report format even if a report format file is not set. 

This section describes how to change the default report format file in the [Realtime Batch] window. 

1 Click [Options] on the [Tools] menu in the [Realtime Batch] window. 
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2 Click [Change] on the [Report] tab, set the report file to change, and click [OK]. 

• Do not delete or move the default report format file. 

• If the [Report Format File] cell is left blank and [Report Output] is selected, reports are printed in 
the report format saved in each data file. 

Reference
Refer to "7.2 Print Data Processing Results" P.247 for details on the report format saved in each data 
file. 

7.2 Print Data Processing Results
This section describes how to print reports from data files in the [Data Analysis] window or [PDA Data 
Analysis] window. 

1 Open the data file in the [Data Analysis] window or [PDA Data Analysis] window, select 

[Data Report] on the [File] menu, and click [Print]. 

The report is printed. 
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• If a report format file was not specified at the time of data acquisition, the default report format file 
[Default.lsr] is used to print the report. 

• Select [Data Report] on the [File] menu, and click [Preview] to check the printed details. The 
preview sub-window opens. 

• Select [Data Report] on the [File] menu, and click [Edit Format] to change the report format. The 
report format in the data file is edited. 

Reference
Refer to "7.4 Create a Report Format File" P.253 for details on pasting new items to reports. 

7.3 Edit Report Format Files
This section describes how to open the pre-installed report format file “peak report_1.lsr” in the [Report] 
window, and display the compound name in the peak top comment of the chromatogram. 

1 Click the  (Report Format) icon on the [Main] assistant bar. 

The [Report] window opens. 

2 Click  (Select Folder) in the [Data Explorer] sub-window. 

3 Select “\LabSolutions\Sample”, and click [Close]. 

The contents of the “\LabSolutions\Sample” [Folder] is displayed in the [Data Explorer] sub-window. 
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4 Drag-and-drop “Report1.lcr” from the [Data Explorer] sub-window onto the [Report] 

window. 

5 Click the  (Data) tab at the bottom of the [Data Explorer] sub-window, and drag-and-

drop the data file. 
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The contents of the data file is displayed in the [Report] window. 

If the data file is not displayed in the [Data Explorer] sub-window, click  (Select Folder), and 

specify the folder that contains the desired data file. 

6 Double-click the chromatogram item. 

The [Chromatogram Properties] sub-window opens. 

7 Click the [Peak Top Comment] tab, enter the [Chromatogram] tab parameters.
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8 Click the [Peak Top Comment] tab, enter the [Peak Top Comment] tab parameters, and 

click [OK]. 

1 Select [Name] in the [Hide Items] box, and click [Add]. 

[Name] is displayed in the [Display Items] box. 

Click [Format] to open the [Format Settings] sub-window to edit the number of display digits and 
rounding method. Refer to "7.5.8 Edit the Numeric Value Format in the Quantitative Results 
Table" P.265 for details.

2 Enter the [Angle] to change the angle or position of the peak top comment. 

The default angle is “90”. Increase the value to rotate the comment counterclockwise from the 
start of the text string.

Reference
Refer to "7.4 Create a Report Format File" P.253 for details on adding items to the report format.
Refer to "7.5 Edit Report Items" P.258 or "5.7.3 Edit PDA Report Format" P.163 to edit other report 
format items. 

9 Click the  (Preview) icon on the [Report] assistant bar. 

1

2
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10 Preview the report, and click [Close]. 

11 Click [Save Report Format File As] on the [File] menu. 

12 Enter a file name at [Save in], and click [Save]. 
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7.4 Create a Report Format File
This section describes an example of how to make a new report format file in the [Report] window. 

Reference
Refer to "7.5 Edit Report Items" P.258 for details. 

1 Click the  (Report Format) icon on the [Main] assistant bar. 

2 Click  (New) on the toolbar. 

3 Click  (Chromatogram) on the toolbar. 

Reference
Refer to "7.4.1 Types of Report Items" P.256 for details on each toolbar item. 

4 Drag the cursor on the format to specify a range for the chromatogram. 



7  Report Function

254   Operators Guide

5 In the [LC/PDA Chromatogram Properties] sub-window, correct the display position and 

edit the display items, and click [OK]. 

Double-click inside the item frame to open the [LC/PDA Chromatogram Properties] sub-window. 

Reference
Refer to "7.5.1 Chromatogram Properties" P.258 or "7.5.2 Change the Chromatogram Display Scale" 
P.259 for details on editing the chromatogram display.

6 Click the  (Data) tab at the bottom of the [Data Explorer] sub-window and drag-and-

drop the target data file onto the report format to examine the print details of a report 

format file. 

The chromatogram information of the data file is displayed in the [Report] window. 
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• Right-click on an item and click [Delete] to remove the item. 

• Drag-and-drop the data file to a specific item with the [Shift] key held down to load data only to 
that item. 

• If the data file is not displayed in the [Data Explorer] sub-window, click  (Select Folder), and 

specify the folder containing the desired data file. 

7 Click the  (Preview) icon on the [Report] assistant bar. 

8 Examine the report in the preview sub-window, and click [Close]. 

9 Click [Save Report Format File As] on the [File] menu. 

10 Specify a folder at [Save in], enter a [File Name], and click [Save]. 
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7.4.1 Types of Report Items
Items, such as chromatograms and quantitative result information, can be added to the report format using 
the icons on the toolbar. The following report items are available. 

Item Content

    Figure Use these icons to add a Line, Arrow, Rectangle or Ellipse to the report 
format. 

 Text Use this icon to add a text box to the report format. 

 Picture Use this icon to add bitmaps or other image files to the report format. 

 System Configuration Use this icon to add the instrument configuration at the time of data 
acquisition to the report format. 

 Sample Information Use this icon to add sample information to the report format. 

 Method Use this icon to add method file information, such as the instrument and data 
processing parameters to the report format. 

 Batch Table Use this icon to add the Batch Table and batch file settings to the report 
format. 

 System Check Use this icon to add the system check results saved in data files to the report 
format. 

 Chromatogram Use this icon to add chromatograms and instrument status information to the 
report format. 

 Calibration Curve Use this icon to add the calibration curve graph and information to the report 
format. 

 Peak Table Use this icon to add a table of the retention times and area values of detected 
peaks to the report format. 

 Quantitative Results Use this icon to add a table of the quantitative results of identified peaks to 
the report format. 

 Group Results Use this icon to add a table of the quantitative results for grouped compounds 
to the report format. 

 Fraction Collection Report Use this icon to add a table of the fraction collection status to the report 
format.

 Summary (Concentration) Use this icon to add a summary of the chromatograms, statistical 
concentration results, areas and heights for multiple data acquisitions to the 
report format. 

 Summary (Compound) Use this icon to add a summary of the concentrations, areas and heights of 
multiple data by individual compound to the report format. 

 Summary (Data) Use this icon to add a summary of the chromatograms and Peak Tables for 
multiple data to the report format. 

 Contour Graph Use this icon to add contour graphs of PDA data to the report format. 

 3D Graph Use this icon to add 3D graphs of PDA data to the report format. 

 UV Spectrum Use this item to add PDA spectra and spectra information to the report 
format. 

 Peak Purity Use this icon to add the PDA peak purity results to the report format. 

 Peak Profile Use this icon to add the PDA peak profile information to the report format. 

 UV Spectrum Index Use this icon to add PDA chromatograms and spectra for detected peaks to 
the report format. 

 UV Library Search Use this icon to add UV Library Search results to the report format. 

 UV Library Use this icon to add a list of the spectra in the library file to the report format. 
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 MS Chromatogram Use this icon to add the MS chromatograms to the report format.

 MS Calibration Curve Use this icon to add the MS calibration curve graph and information to the 
report format. 

 MS Peak Table Use this icon to add a table of the retention times and area values for the 
detected MS peaks to the report format. 

 MS Quantitative Graph Use this icon to add MS chromatograms for identified peaks to the report 
format. 

 MS Quantitative Table Use this icon to add a table of MS quantitative results for identified peaks to 
the report format. 

 MS Spectrum Use this icon to add the MS spectrum information to the report format. 

 MS Library Search Use this icon to add the MS Library Search results to the report format. 

 MS Status Log Use this icon to add the MS instrument status to the report format.

 MS Summary (Concentration) Use this icon to add a summary chromatograms, statistical concentration 
results, areas and heights for multiple MS data acquisitions to the report 
format. 

 MS Summary (Compound) Use this icon to add a summary of the concentrations, areas and heights of 
multiple MS data by individual compound to the report format.

 MS Summary (Data) Use this icon to add a summary of the chromatograms and Peak Tables for 
multiple MS data to the report format. 

 LC/MS/MS Tuning Use this icon to add the LCMS-8030/8040/8045/8050/8060 tuning results to 
the report format.

 MS Quantitative Result(Mass 
Spectrum Pattern) 

When the mass spectrum pattern is used in the identification, the 
chromatograms and quantitative results for identified peaks and the pattern 
matching results are displayed. Automatic MS/MS data in LCMS-8030/8040/
8045/8050/8060 is used for pattern matching.

Item Content
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7.5 Edit Report Items
This section describes how to edit properties for each report item. 

7.5.1 Chromatogram Properties
The following section describes how to set the chromatogram display properties on the [Chromatogram] 
tab of the [Chromatogram Properties] sub-window. 

1 Click the [Chromatogram] tab. 

2 Enter the properties on the [Chromatogram] tab, and click [OK]. 

1 Select each of the checkboxes to print the [Baseline] and [Peak Detection Mark]. 

2 Click [Portrait] and [Overlay] in the [Type] list to draw chromatograms overlaid in a portrait 
orientation.
Click [Landscape] and [Separate] in the [Type] list to draw chromatograms overlaid in a landscape 
orientation. 

3 Click [All] in the [Displayed Chromatogram] list. 

• When [Select Chromatogram] in the [Displayed Chromatogram] list is selected and select the 
detector in [Detector], all of the channels set by that detector are displayed.

• When [No Chromatogram] is selected in the [Displayed Chromatogram] list, chromatograms 
are not displayed. Use this parameter to display only the instrument status. 

2 13



 Operators Guide   259

7.5  Edit Report Items

7

7.5.2 Change the Chromatogram Display Scale
Set the chromatogram display scale and scale interval on the [Setting Scale] tab of the [Chromatogram 
Properties] sub-window. The scale of the intensity axis can also be changed for each chromatogram. 

1 Click the [Setting Scale] tab. 

2 Enter the [Setting Scale] tab parameters, and click [OK]. 

1 Select [Scale Interval], and set the interval at [Scale Interval] and [Sub Scale] to display the scale on 
the intensity axis (Y-axis) and time axis (X-axis). 

2 Deselect [Use range in data], and select the display unit and reference peak at [Inten. Unit] and 
[Scale to] to set the chromatogram intensity axis (Y-axis). 

• The default setting is [Use range in data], and the intensity unit and intensity axis range saved 
in data files are used. 

• If [Zero Base Point] is selected and a setting other than [User Defined] is selected at [Scale 
to], chromatograms are auto-scaled and displayed on the intensity axis of 0 V or more. 

• Set the upper/lower width (margin) of the intensity axis at [Margin] when chromatogram 
displays are auto-scaled. 

• If the intensity axis is unique for each chromatogram, for example, because the peak height 
of obtained by data acquisition differs for each detection channel, select [Set per 
Chromatogram] and enter the upper limit and lower limit values for each chromatogram. 

1

2
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7.5.3 Display the Instrument Status and Gradient Curve
Use the [LC Status] tab of the [Chromatogram Properties] sub-window to overlay the instrument status 
information and gradient curve on chromatograms.

This section describes how to overlay the gradient curve for pump B (B.Conc%) on a chromatogram. 

1 Click the [LC Status] tab. 

2 Enter the [LC Status] tab parameters, and click [OK]. 

1 Select [B.Conc] in the [Hide Items] box, and click [Add]. 

[B.Conc] is added to the [Display Items] box. 

2 Select [Y Scale (Conc.)] at [Scale] and [Title]. 

3 Click [Intensity Range] to set the intensity axis range. 

1 Click [Manual] in the [Scale to] list. 

2 Enter the upper limit and lower limits at [Conc]. 

3 Click [OK].

4 Check the edited details, and click [OK]. 

1

2

1

2
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7.5.4 Edit Sample Information Display
Click [Remarks] on the [Chromatogram] tab of the [Chromatogram Properties] sub-window, and select the 
desired remark to display sample information in the chromatogram remarks section. 

1 Click the [Chromatogram] tab, select [Remarks], and click [Detail]. 

2 Select the display item in the [Remarks] sub-window, and click [OK]. 

1 Select the items to print in the [Hide Items] box. 

2 Click [Add]. 
The added items are displayed in the [Display Items] box. 

1
2
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7.5.5 Display the Background File
Use the [Chromatogram] tab in the [Chromatogram Properties] sub-window to overlay the background data 
or the chromatograms before background compensation. 

1 Click the [Chromatogram] tab. 

2 Enter the [Chromatogram] tab parameters, and click [OK]. 

1 Click [Overlay] in the [Type] list. 

2 Select the checkbox of the chromatograms to be overlaid at [Displayed Chromatogram]. 

3 Select [Original Chrom. (before Background Compensation)] and [Background Chromatogram]. 

1

2

3
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7.5.6 Attach a Specific Chromatogram to the Report Format
Enter a file on the [File] tab of the [Chromatogram Properties] sub-window to attach a specific (reference) 
chromatogram to the report format and cause the same chromatogram to be printed each time the report 
format is used to print data. 

1 Click the [File] tab. 

2 Select the [File] tab parameters, and click [OK]. 

1 Click [Browse] and select the desired data file, and click [Open]. 

2 Select [Fix file in the item]. 

Select [Fix file in the item] to print the chromatogram selected in [File] each time the report 
format is used. This selected chromatogram is printed even if a different data file is loaded in the 
[Report] window. 

3
1
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7.5.7 Edit the Quantitative Results Table

1 Click the [Quantitative Results] tab. 

2 Set the [Quantitative Results] tab parameters, and click [OK]. 

1 Select items to print in the [Hide Items] box, and click [Add]. 

The added items are displayed in the [Display Items] box. 

2 Select the desired items to display statistical calculation results and the grid. 

When displayed items include column performance parameters (e.g. number of theoretical plates 
and tailing factor), all values calculated by the various pharmacopoeia methods (JP, USP, etc.) 
specified in the data processing parameters are displayed.
To filter the reported calculation results in the Quantitative Results Table, click the [Column 
Performance Settings] button, select [Display only selected calc. method] in the [Display Settings for 
Column Performance Results] sub-window that is displayed, and specify the calculation results to 
display.

1

2
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7.5.8 Edit the Numeric Value Format in the Quantitative Results Table
It is possible to set the rounding method and the display parameters for the numeric data. 

This section describes the procedure for changing the numeric format of [Area Ratio]. 

1 Click the [Quantitative Results] tab. 

2 Select [Area Ratio] in the [Hide Items] box, and click [Add]. 

[Area Ratio] is displayed in the [Display Items] box. 

3 Select [Area Ratio] in the [Display Items] box, and click the [99.9999] format.

4 Make the appropriate settings in the [Format Settings] sub-window, and click [OK]. 

1 Select [Option Settings]. 

2 Click [Significant Digits] at [Display Type]. 

3 Select [Significant Digits], and enter “6”. 

4 Click [Half Adjust] at [Rounding]. 

By default, [Option Settings] is deselected and the display format and rounding method set in the 
[Data Processing Setting] sub-window for [System Settings] in [Administration Tools] are used. 

5 Check the edited details, and click [OK]. 

2
1

3
4
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7.5.9 Edit Sample Information
Use the [Sample Information] tab of the [Sample Information Properties] sub-window to select the sample 
information to include in the report format. 

The following section describes how to display the repeat injection count of the same vial number set in the 
batch file.

1 Click the [Sample Information] tab. 

2 Set the [Sample Information] tab parameters, and click [OK]. 

1 Select [Sampling Count from the Vial] in the [Hide Items] box, and click [Add]. 

[Sampling Count from the Vial] is displayed in the [Display Items] box. 

2 To display 2 sample information items in a row, enter “2” at [# of Items in a Row]. 

Click [Setting Macro] on the [Sample Information] tab and create a method using macros to 
display sample information. Select the information to be displayed and the position in the 
macros sub-window. Once macros have been used to set the [Sample Information] tab 
parameters, the original table format sub-window cannot be displayed. 

1

2
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7.5.10Edit Calibration Curve Information
Use the [Header] tab in the [Calibration Curve Properties] sub-window to edit calibration curve information 
such as, calibration curve expressions and quantitative calculation methods. 

Macros are provided for each of the [Header] tab items. These macros can be edited to determine display 
items and positions in reports. 

This section describes how to edit the [Channel] macro to print the channel. 

1 Click the [Header] tab. 

2 Place the cursor in the position where the new information is to be added in the display 

area to the left, select [Channel] in the [Variable] list, and click [Insert]. 

[$Channel$] is added to the text display area. 

3 Prefix the additional macro [$Channel$] with “Channel:”. 
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• Tabs can be inserted by pressing the [Ctrl] and [I] keys at the same time. The tab interval is the 
number of characters set at [Tab Stop]. 

• Click [Initialize] to restore the default settings. 

• Use the [Position] tab to change the display position of the calibration curve graph and table. 

• [Channel] is displayed as follows:

4 Check the edited details, and click [OK]. 



 Operators Guide   269

7.5  Edit Report Items

7

7.5.11Change the Color and Line Width of Overlaid Chromatograms
Select the number of lines, line color and line width for overlaid chromatograms on the [General] tab in the 
[Summary (Concentration) Properties] sub-window. 

This section describes how to change the color, line type and line width of overlaid chromatograms. 

1 Click the [General] tab. 

2 Set the [General] tab parameters, and click [OK]. 

1 Enter “2” at [Definable Max Lines]. 

When “2” is set to [Definable Max Lines], [Graph - Chromato Line 2] is added to the [Color] list. 
Values higher than 2 for [Definable Max Lines] add additional chromatograms to the color list.

2 Select [Graph - Chromato Line 2] in the [Color] list. 

3 Click [Set], select red in the [Color] sub-window, and click [OK]. 

4 Click [Dot] in the [Style] list. 

5 Set [Width] to “2”. 

In addition to chromatograms, statistical results can also be output with the [Summary 
(Concentration)] item. Select the summary data (area, height and concentration) and the statistical 
items to display on the [Summary] tab to display the statistical calculation results of multiple data. 

1 2 3 4 5
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7.5.12Edit the Statistical Results Table
Items such as statistical results can be displayed by adding them to the [Display Items] box on the 
[Summary] tab in [Summary (Compound) Properties]. 

1 Click the [Summary] tab. 

2 Set the [Summary] tab parameters, and click [OK]. 

1 Select the items to be displayed in the report in the [Hide Items] box, and click [Add]. 

The added items are displayed in the [Display Items] box. 

2 Select the respective items to display the statistical results and the grid in the table. 

• If [Calculate by specified digits] is selected, statistical calculation is performed using the number 
of digits set in the [Format Settings] sub-window. 

• If the number of theoretical plates and tailing factor display items are selected, all values 
calculated by the formulas (JP method and USP method) specified in the data processing 
parameters are displayed. 
Click the [Column Performance Settings] button, and select [Display only selected calc. method] 
in the [Display Settings for Column Performance Results] sub-window to select calculation results 
to display in the Quantitative Results Table. 

7.5.13Edit the Measurement Results Table
Use the [Summary (Data)] item to display one of three tables, the Peak Table, Quantitative Results Table 
and Grouping Results Table. 

This section describes how to use the [Summary (Data)] item to edit the Peak Table display items.

1 Click the [Display] tab. 

1

2
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2 Select [Display peak table]. 

3 Click the [Peak Table] tab. 

4 Set the [Peak Table] tab parameters, and click [OK]. 

1 Select the desired items in the [Hide Items] box, and click [Add]. 

The added items are displayed in the [Display Items] box. 

2 Select the respective items to display the total values and grids. 

• If the number of theoretical plates and tailing factor display items are selected, all values 
calculated by the formulas (JP method and USP method) specified in the data processing 
parameters are displayed. 
Click the [Column Performance Settings] button, and select [Display only selected calc. method] 
in the [Display Settings for Column Performance Results] sub-window to select the calculation 
results to display in the Quantitative Results Table. 

1

2
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7.5.14Change the Display of Chromatograms and Results Tables
Use the [Display] tab in the [Summary (Data) Properties] sub-window to change the horizontal and vertical 
chromatogram display and table information to display. 

1 Click the [Display] tab. 

2 Set the [Display] tab parameters, and click [OK]. 

1 Click [Right Chromatogram] to display the table on the right side of the chromatogram. 

2 Change [Arrangement] to change the display aspect ratio of chromatograms and tables. 

7.6 Report Layout
Functions for editing the positions of report items include position and size adjustment, header/footer 
setting and the ability to add, move or delete pages. 

7.6.1 Change the Item Position and Number of Pages
If a report format includes multiple items, the layout icons are enabled in the toolbar so that the items can 
be repositioned.

Pages can be added to and deleted from the report format.

2
1
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 Re-Position Items

1 Click  (Pointer) on the toolbar. 

2 Drag the point so that it encloses the items to be re-positioned. 

3 Click each of the items on the [Report] toolbar, and adjust the position of items. 

• Some of the layout icons are disabled if only one item is selected.

• Drag the frame of the report item to resize that item. 

No. Explanation

1 Aligns items to the left edge of the left most item. 

2 Aligns items to the right edge of the right most item. 

3 Aligns items to the top edge of the topmost item. 

4 Aligns items to the bottom edge of the bottommost item. 

5 Aligns the width of each item to the longest horizontal item. 

6 Aligns the height of each item to the longest vertical item. 

7 Aligns the width and height of each item to the longest horizontal and vertical item. 

1 2 3 4 5 6 7
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 Add or Delete Report Pages

All icons except the [Insert (Page)] icon (1) are disabled if there is only one page.

7.6.2 Use the Grid
Use the grid to adjust the positions of report items.

This section describes how to display the grid in the [Report] window. 

1 Display the report format file on the [Report] window, and click  (Toggle Grid) on the 

toolbar. 

No. Explanation

1 Inserts a page after the currently displayed page. 

2 Deletes the currently displayed page. 

3 Displays the first page. 

4 Displays the previous page. 

5 Displays the next page. 

6 Displays the last page. 

3 4 5 61 2
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2 To adjust the interval of the displayed grid, click [Option] on the [View] menu. 

3 Enter [Grid Width], and click [OK]. 

The grid is displayed at that interval. 

7.6.3 Headers and Footers
This section describes how to display information such as, print date, page number in the header or footer 
of the report format.

1 Display the report format file on the [Report] window, and click [Header/Footer] on the 

[View] menu. 

2 Select the [Header] or [Footer] tab and select the information to be displayed in the 

[Left], [Center], and [Right] sections. 

3 Click [OK]. 

The settings are displayed in the report header or footer. 
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7.6.4 Paper Size and Margin
Click [Page Setup] on the [File] menu in the [Report] window. The [Page Setup] sub-window is displayed. 
Select the paper size, paper source, orientation (portrait or landscape), and margins of the report. 

7.7 Other Reports
Exclusive reports can also be output from the following sub-windows. 

Window/Sub-Window Explanation (Operation Method)

Data Acquisition The contents of the displayed method file are loaded to a system exclusive report 
format and output. ([Print Method File] on the [File] menu)

System Configuration The current system configuration information is loaded to a system exclusive report 
format and output. ([Print] button)

Realtime Batch
Postrun Batch

The contents of the Batch Table are loaded to a system exclusive report format and 
output. Edit the report format to match specific display items. 
([Print Batch Table] on the [File] menu)

Data Analysis
PDA Data Analysis
MS Data Analysis
Calibration Curve
Data Comparison
UV Library Editor
Quant Browser

The contents of files loaded to each window can be loaded to a system exclusive report 
format and output. 

Spectrum Index The PDA chromatograms and spectra for detected peaks are loaded to a system 
exclusive report format and output. 
([Print Spectrum Index] on the [File] menu in the [PDA Data Analysis] window)

Spectrum Table Spectrum information registered to the Spectrum Table is output. 

UV Library Search Results The UV library search results are loaded to an exclusive report format and output. 
Edit the report format to match the settings made in the data processing parameters. 
([Print] on the [Library Search] menu)

MS Library Search Results The MS library search results are loaded to an exclusive report format and output. 

 ([Print] on the [Search Results] of [Report] menu)

Audit Trail Log If the audit trail log is activated, the log contents are output in a fixed format. ([Print] 
button)

Log Browser Each log displayed in the log browser is output in a fixed format. 

Show Check Result Results of the program or raw data check are output in a fixed format. 

System Check Results The system check results are output in a fixed format. 
([Print] button)
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8Tuning

This chapter describes how to perform the tuning process to optimize MS control parameters. 

Two tuning modes, auto-tuning and manual tuning are described in the chapter. 

8.1 [MS Tuning] Window

8.1.1 Open the [Data Acquisition] Window

1 Click the  icon. 

2 Select and double-click the instrument on which data acquisition will be performed. 

The [Realtime Analysis] program opens. 

3 Click the  (Tuning) icon on the [Main] assistant bar. 

Click  on the title of the assistant bar if the  (Tuning) icon is not displayed. 
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8.1.2 [MS Tuning] Window Description
This section describes how to view and use the [MS Tuning] window. 

No. Explanation
1 Displays the [Standard], [Instrument Control], [LC Control], [PDA Control], [MS Control], and [MS Tuning] 

toolbars.

2 Displays the profile spectrum in the auto-tuning mode or manual tuning mode. 

3 Displays the tuning conditions and tuning results. 

2

3

1
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8.2 Auto-Tuning
Use the auto-tuning mode to optimize various control parameters of the MS instrument according to preset 
auto-tuning conditions. 

Before auto-tuning, verify the amount of sample in the standard sample bottle.

Verify that the standard sample flow path to ensure that it is correctly injected into the MS instrument.

8.2.1 Execute Auto-Tuning

1 Select [Print Result after Auto Tuning] on the [Tuning] menu to print the results when 

auto-tuning is complete. 

2 Click the  (Start Auto Tuning) icon on the [Tuning] assistant bar. 
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The [Auto Tuning] sub-window is displayed, and the auto-tuning process is initiated. Check the tuning 
status in the [Auto Tuning] sub-window. 

After tuning is complete with no error messages, the standard sample spectrum is acquired using the 
preset tuning parameters. Then, the spectrum and optimized parameters are displayed in the tuning 
result mode. 

Reference
Refer to "8.2.2 Check Tuning Results" P.281 for details on the tuning result mode.

• Auto-tuning is an extensive process since it searches for the optimum parameters. 

• The most probable cause of auto-tuning errors not related to the MS instrument is when the 
standard sample is not correctly introduced into the MS instrument.Verify that there is sufficient 
standard sample and that there are no problems with the flow path. 

• Peak sensitivity used for calibration during negative tuning can decrease significantly depending 
on the type of mobile phase. If this occurs, click [m/z for Negative Calibration] on the [Tuning] 
menu and edit the m/z value. 

3 Click  (Save) on the toolbar. 

The new control parameters are saved to a tuning file (file extension *.lct). 
When the tuning file is saved, a message to confirm whether or not to use this file as default is displayed. 
Once this file is applied as default, it will be used as the tuning file when any tuning file is not set in single 
run or realtime batch.
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8.2.2 Check Tuning Results
Tuning results can be checked on the [Tuning] assistant bar in real time. 

1 Click the (Result Tuning) icon on the [Tuning] assistant bar. 

Tuning results are displayed in the tuning result mode.
In this mode, the tuning results saved to the currently loaded tuning file are displayed.

• When the [Tuning] window is opened, the specified default tuning file is automatically loaded. 
• Unless otherwise specified, the tuning file loaded here is used in system checks or in data acquisition.



8  Tuning

282   Operators Guide

8.2.3 Repeat Auto-Tuning
If there is a problem with the tuning results, auto-tuning is only repeated for the required items such as 
resolution adjustment, sensitivity adjustment or mass calibration. 

1 Click the  (Auto Tuning Condition) icon on the [Tuning] assistant bar. 

2 Select the required items, and click [OK]. 

Auto-tuning is executed only for the selected items. 
Click [Only Positive Tuning] to perform tuning only on items with a positive polarity.
A small [FWHM] value improves resolution but lowers sensitivity. 

8.3 Manual Tuning
Use the manual tuning mode to correct the control parameters that were determined by auto-tuning and 
verify that the tuning results are satisfactory. 

1 Click the  (Manual Tuning) icon on the [Tuning] assistant bar. 

The mode changes to the manual tuning mode, and acquired data is loaded in real time. 
Each of the MS control parameters can be edited in the manual tuning mode. 
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2 Check the conditions of the standard sample ion peak. 

Click the respective tab, and directly edit the MS control parameters.

Select [m/z Calibration] from the [Tuning] menu to manually calibrate the mass axis.

3 Click  (Standard Sample) on the toolbar, and introduce the tuning sample into the 

flow path. 

The MS spectrum is displayed in each cell. New parameter settings are sent to the MS instrument in real 
time.
Fine-adjust the MS control parameters while checking the spectrum. 

• Do not click  (Standard Sample) if the tuning standard is not being injected from the standard 

sample bottle. Use the solvent delivery unit to inject the sample like a regular sample, or directly 
introduce the sample to the mass spectrometer by infusion acquisition. 

• Auto-tuning is normally sufficient and specialist knowledge of MS instruments is required to 
change the control parameters with manual tuning. 

• Quantitative results are influenced if the standard sample data used for the calibration curve and 
the unknown sample data are acquired under different tuning conditions. 



8  Tuning

284   Operators Guide



Operators Guide   285

9
9

9

9

9

9

9

9

9

9

9

9

9

9

9

9

9Method Optimization

Method optimization refers to a function that sets the voltage value in instrument parameters for an SIM or 
MRM event to an optimal value or adjusts the m/z values for precursor and product ions. 

If the m/z values for product ions are not known, an automatic search function is available as well. 
Optimization results are saved in a method file and can be confirmed at any time. 

This chapter describes the basic process flow for optimizing an MRM event. 

9.1 Process Flow from Method Optimization to 
Quantitation

[Data Acquisition] window

Use flow injection analysis (FIA) to optimize MRM events. 

To automatically search for precursor ions

Reference
"9.2 Optimize Methods by Searching Precursor Ions and Product Ions" P.287

To automatically search for product ions

Reference
"9.3 Optimize Methods by Specifying Only m/z Values for Precursor Ions" P.293

Example of LC instrument parameters for the flow injection analysis

Pump Flow: 0.2 mL/min

[LC Stop Time] on the [Data Acquisition] tab:0.5 min

[Stop] command on the [LC Time Prog.] tab: 0.5 min

No Column

Method File A

• LC instrument parameters (for FIA) 
• MS instrument parameters (optimized)
• Includes Compound Table settings

Method File A

• LC instrument parameters (for FIA)
Items Already Set Items Already Set
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Continuation of [Data Acquisition] window

Perform column analysis on a standard sample to investigate compound retention times. 

Reference
"9.4 Check Compound Retention Times" P.297

[MS Data Analysis] window

Set retention times in the Compound Table by confirming peaks in the standard sample 

measurement data. 

Reference
"9.5 Set Retention Times in the Compound Table" P.300

• LC instrument parameters 
(for column analysis) 

Method File B

• LC instrument parameters 
(for column analysis) 

• MS instrument parameters 
(optimized)

• Includes Compound Table settings

Add the MS instrument parameters and Compound 

Table created in  to Method File B. 

Method File A

• LC instrument parameters (for FIA) 
• MS instrument parameters (optimized)
• Includes Compound Table settings

Method File B

Standard Sample Data File

Export the 
Compound 
Table.

Method File B

• LC instrument parameters 
(for column analysis) 

• MS instrument parameters 
(optimized)

• Includes Compound Table settings

Method File B

• LC instrument parameters 
(for column analysis) 

• MS instrument parameters 
(optimized)

• Includes Compound Table settings 
(retention times already set)
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99.2 Optimize Methods by Searching Precursor Ions and 
Product Ions
Precursor Ions are determined based on the specified Precursor Ion auto selection conditions and Product 
Ions based on the specified Product Ion auto selection conditions. Then it optimizes the method.

9.2.1 Prepare the Sample

1 Remove the column to allow flow injection analysis.

2 Place the samples for optimization on the autosampler.

[Data Acquisition] window

Based on retention times in the Compound Table, update the measurement times for MRM 

events set in instrument parameters. 

Reference
"9.6 Update Measurement Times in MRM Events" P.305

[Realtime Batch] and [Quant Browser] Windows

Perform realtime batch on standard and unknown samples and perform quantitative 

processing. 

Reference
"9.7 Create a Calibration Curve and Perform Quantitative Calculations" P.307

Method File B

• LC instrument parameters
 (for column analysis) 

• MS instrument parameters 
(optimized and with updated MRM 
event measurement times)

• Includes Compound Table settings 
(retention times already set)

Update 
measurement 
times for MRM 
events. 

Method File B

• LC instrument parameters 
(for column analysis) 

• MS instrument parameters 
(optimized)

• Includes Compound Table settings 
(retention times already set)
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9.2.2 Open the [Data Acquisition] Window

1 Start up the [Realtime Analysis] program from the [LabSolutions Main] window to open 

the [Data Acquisition] window.

Reference
For details on operations, see "2.1.1 Open the [Data Acquisition] Window" P.9.

2 Select a method file set with the LC and MS instrument parameters. 

Set LC instrument parameters to flow injection analysis.

1 Drag-and-drop the method file onto the [Data Acquisition] window from the [Data Explorer] sub-
window.

Reference
For details on instrument parameter setting, see "2.2.2 Set the LC Instrument Parameters" P.12. 

9.2.3 Optimize Method

1 Click the  (Optimization for Method) icon on the [Acquisition] assistant bar.

The [Condition Settings for Optimize Method] sub-window is displayed.
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2 Click [Optimize MRM event from precursor ion search], and click [Next].

The [Condition Settings for Optimize Method] sub-window is displayed.
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3 Set the optimization conditions, and click [Next]. 

Optimize each event by measuring the sample for each item selected in area 1. 

No. Description
1 At [Search Precursor ion], data acquisition is executed once for automatically searching the m/z of the 

Precursor Ions. Precursor ion m/z values are calculated by the combination of molecular weight set at 3 
and adduct ions, polarities, and charges set at 4. When the peaks of precursor ion are observed, the 
m/z values (molecular weight + adduct) are used. Also, the precursor ion m/z to use are not actual 
measured values when observing peaks but theoretical values by calculating.
When [Adjust Precursor m/z] is selected, the m/z value with the highest peak intensity within the -0.5 to 
+0.5 u range is determined for precursor ion m/z. 
When [Optimize Voltage] is selected, the items selected for optimization in the [Optimize voltage 
settings] sub-window, which is displayed by clicking [Advanced Settings], are optimized. 
When [Adjust Product m/z] is selected, the m/z value with the highest peak intensity within the -0.5 to 
+0.5 u range is determined for product ion m/z identified by automatic searching. (Normally, these 
parameters do not need to be set.) 

2 Sets the minimum intensity value of the ion selected as Precursor Ion.
If [Select the Precursor m/z from All Candidate] is selected, the Precursor Ion is determined from all 
Precursor Ion candidates in search results. 
If [Select the Precursor m/z from Maximum Intensity] is selected, the Precursor Ion with the maximum 
intensity is determined from all Precursor Ion candidates in search results.

7

51

2

4

3

6

8

9
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3 Set the [Compound Name], [Molecular weight], and [+/-] settings for events. 
Set the measurement times at [Start (min)] and [End (min)]. 
Enter the vial number, tray, and injection volume for samples used for optimization. 
It indicates information about samples prepared in "9.3.1 Prepare the Sample". 

• If the LC end time value is greater than the specified end time value, the LC end time is applied. 

• Since the analysis is performed without column, please set a short analysis time.

• Parameters set here are applied to the [MS] tab in [Instrument Parameters View]. 

4 Click [Adduct Ion] to set the information of the adduct ions to add or detach.
[Adduct Ion Settings] sub-window is displayed.

Sets the formula or molecular weight and charges of the adduct ion, and then click [OK]  to return to the 
previous sub-window.

5 Click [Auto Selection Condition] to set criteria for selecting product ions. 
The [Auto Selection Condition Settings] sub-window is displayed. 

Set product ion conditions, and then click [OK] to return to the previous sub-window. 

6 A subfolder is created under the folder specified here. The name of the subfolder is determined by the 
date and time. The files automatically created during the optimization are output in this folder.

The default is the project folder.

7 Select [Create new method files by every event] to create a method file for each compound, and specify 
the folder to save the method file. 
The method files are saved using the method file name prefixed with a compound name and event 
number. 
Example: "A_1_FIA.lcm"

8 When [Shutdown after optimization] is selected, realtime batch is executed after optimization is finished. 
When performing shutdown after optimization, the method file currently opened is closed. 

9 Click [Next].
The [Confirming Precursor Ion for Optimize Method] sub-window.

No. Description
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If optimization results for each compound are saved in separate method files, methods can be 
created later by adding only the compounds required. 
For details, see "9.4.2 Create a Method File for Column Analysis" P.297.

4 Confirm the precursor ion m/z values, and click [Start].

The [Proceeding for Optimize method] sub-window is displayed during optimization. Clicking [Stop] 
stops method optimization. 
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9.2.4 Display Optimization Results
After optimization is finished, click [Detail] in the [Proceeding for Optimize method] sub-window to display 
the [Method Optimization Results] sub-window. 

• The displayed items vary according to the MS detector model.

• After the [Proceeding for Optimize method] sub-window is closed, optimization results can be displayed 
by clicking [Optimization Result] on the [Method] menu in the [Data Acquisition] window. 

• The data files output during the optimization are saved in the folder set at 6. To check detailed results, 
open the target data file in the [MS Data Analysis] window.

9.3 Optimize Methods by Specifying Only m/z Values for 
Precursor Ions
Use this procedure to optimize methods when only the m/z values for precursor ions are known and 
product ions are unknown. This searches for product ions according to the set automatic selection 
conditions. 

9.3.1 Prepare the Sample

Reference
See "9.2.1 Prepare the Sample" P.287.

9.3.2 Open the [Data Acquisition] Window

Reference
See "9.2.2 Open the [Data Acquisition] Window" P.288.
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9.3.3 Optimize Method

1 Click the  (Optimization for Method) icon on the [Acquisition] assistant bar.

The [Condition Settings for Optimize Method] sub-window is displayed.

2 Click [Optimize MRM event from product ion search], and click [Next].

The [Condition Settings for Optimize Method] sub-window is displayed.
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3 Set the optimization conditions, and click [Start]. 

Optimize each event by measuring the sample for each item selected in area 1. 

No. Description
1 When [Check for Precursor ion] is selected, data acquisition is executed once to check whether or not 

precursor ions exist. 
When [Adjust Precursor m/z] is selected, the m/z value with the highest peak intensity within the -0.5 to 
+0.5 u range is determined for precursor ion m/z. 
When [Optimize Voltage] is selected, the items selected for optimization in the [Optimize voltage 
settings] sub-window, which is displayed by clicking [Advanced Settings], are optimized. 
When [Adjust Product m/z] is selected, the m/z value with the highest peak intensity within the -0.5 to 
+0.5 u range is determined for product ion m/z identified by automatic searching. (Normally, these 
parameters do not need to be set.) 

2 Click [Auto Selection Condition] to set criteria for selecting product ions. 
The [Auto Selection Condition Settings] sub-window is displayed. 

Set product ion conditions, and then click [OK] to return to the previous sub-window. 

3 Enter the vial number, tray, and injection volume for samples used for optimization. 
It indicates information about samples prepared in "9.3.1 Prepare the Sample". 

7

4

2

3

5

8

1

6
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• If optimization results for each compound are saved in separate method files, methods can be 
created later by adding only the compounds required. 
For details, see "9.4.2 Create a Method File for Column Analysis" P.297.

• The [Proceeding for Optimize method] sub-window is displayed during optimization. Clicking 
[Stop] stops method optimization. 

9.3.4 Display Optimization Results

Reference
See "9.2.4 Display Optimization Results" P.293.

4 Set the [Compound Name], [Precursor m/z], and [+/-] settings for events. 
Set the measurement times at [Start (min)] and [End (min)]. 

• If the LC end time value is greater than the specified end time value, the LC end time is applied. 

• Since the analysis is performed without column, please set a short analysis time.

• Parameters set here are applied to the [MS] tab in [Instrument Parameters View]. 

5 A subfolder is created under the folder specified here. The name of the subfolder is determined by the 
date and time. The files automatically created during the optimization are output in this folder.

The default is the project folder.

6 Select [Create new method files by every event] to create a method file for each compound, and specify 
the folder to save the method file. 
The method files are saved using the method file name prefixed with a compound name and event 
number. 
Example: "A_1_FIA.lcm"

7 When [Shutdown after optimization] is selected, realtime batch is executed after optimization is finished. 
When performing shutdown after optimization, the method file currently opened is closed.

8 Check [Predicted end time], and click [Start].

No. Description



 Operators Guide   297

9.4  Check Compound Retention Times

9

9.4 Check Compound Retention Times
Perform single run on a standard sample to investigate compound retention times. 

9.4.1 Prepare for Data Acquisition

1 Attach the column. 

2 Place the standard sample on the autosampler. 

9.4.2 Create a Method File for Column Analysis
Add the MRM events set in multiple method files to the Event Table in the method file for column analysis. 

1 Select a method file set with the LC and MS instrument parameters. 

Set LC instrument parameters to column analysis settings. 

2 Drag-and-drop the source method files onto the [Data Acquisition] window from the 

[Data Explorer] sub-window. 
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3 Click [Add MRM event] on the [Method] menu.

The [Add MRM event] sub-window is displayed.

4 Select the method file(s) containing the MRM event settings to add, and click [Open]. 

Only the MRM events for the selected method files are added to the end of the Event Table. 
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9.4  Check Compound Retention Times

9

5 Select one of the events in MS instrument parameters, set the measurement time, and 

click [Set Same Measurement Time] on the right-click menu. 

6 When the confirmation message is displayed, click [OK].

This results in the same measurement time for all events. 

7 Click [Update compound table m/z by MRM event] on the [Method] menu.

The Compound Table parameters are updated based on the Event Table. 

Even if events are added or deleted in the Event Table on the [MS] tab in [Instrument Parameters 
View], Compound Table parameters are not automatically updated. 
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8 Save the changes in the method file. 

1 Click [Save Method File As] on the [File] menu. 

2 Enter the file name in the [Save Method File As] sub-window, and click [Save].

The results of adding the MRM events are saved in the method file. 

9.4.3 Execute Single Run

1 Drag-and-drop the method file for MRM acquisition onto the [Data Acquisition] window 

from the [Data Explorer] sub-window.

2 Click the  (Start Single Run) icon on the [Acquisition] assistant bar.

3 Set the data acquisition settings, and click [OK].

For details on operations, see "2.5.1 Execute Single Run" P.36.

9.5 Set Retention Times in the Compound Table
Set the retention times in the Compound Table in the method file used for MRM acquisition while 
confirming the compound peaks in the data file acquired in "9.4 Check Compound Retention Times" P.297. 

9.5.1 Open the [MS Data Analysis] Window

1 Click the  (Data Analysis) icon on the [Acquisition] assistant bar to open the [MS 

Data Analysis] window.

Reference
For details on how to use the [MS Data Analysis] window, see "6.1.2 [MS Data Analysis] Window 
Description" P.177.

The [MS Data Analysis] window is displayed.
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9

9.5.2 Load Data Files

1 Drag-and-drop the data file acquired in "9.4 Check Compound Retention Times" onto 

the [MS Data Analysis] window from the [Data Explorer] sub-window.

The content of the data file is displayed in the [MS Data Analysis] window.

9.5.3 Set Retention Times in the Compound Table

1 Click  (Wide Size) in [Method View].

2 Click  (Edit Mode) in [Method View].
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3 Click the [Integration] tab and set each parameter so that the peaks for target 

compounds can be detected.

4 Click the [Compound] tab, and click the [Ret. Time] cell in the Compound Table.

5 Display a mass chromatogram in [Chromatogram View], and double-click near the peak 

tops. 

This sets the retention time of the double-clicked position in the [Ret. Time] cell on the [Compound] tab. 
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9.5  Set Retention Times in the Compound Table

9

6 Set the retention times for other compounds as well by repeating steps 4 and 5. 

7 Click  (View Mode) in [Method View].

This applies the newly edited details.

When the [Peak integration for all IDs will be performed. Continue?] message is displayed, click 
[Yes].

8 Click the  (Peak Integration for All IDs) icon on the [MS Data] assistant bar.

The chromatograms of all IDs on the [Compound] tab in [Method View] undergo quantitative processing 
(peak integration, identification, and quantitative processing). 

9 Click  (Normal Size).

10 Click the [Compound] tab in [Result View] and confirm the quantitative calculation 

results. 

If no peaks could be detected, change the peak integration parameters on the [Integration] tab in 
[Method View] and perform quantitative processing again. 
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9.5.4 Save (Export) the Compound Table to a Method File

1 Click [Save Method As] on the [File] menu.

2 Enter the name of the MRM acquisition method file in the [Save Method As] sub-window, 

and click [Save].

Data files contain information about method files, batch files, and report format files. The [MS Data 
Analysis] window allows editing methods in data files and exporting the results. For details on file 
formats, refer to "System Users Guide". 

3 Select [Data Processing Parameters] at [MS Data Processing] in the [Select Method 

Parameters] sub-window, and click [OK].

The Compound Table is exported to the method file. 
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9.6  Update Measurement Times in MRM Events
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9.6 Update Measurement Times in MRM Events
Update MRM event measurement times for MS instrument parameters based on the retention times in the 
Compound Table set in "9.5 Set Retention Times in the Compound Table". 

9.6.1 Open the [Data Acquisition] Window

1 Drag-and-drop the method file for MRM acquisition onto the [Data Acquisition] window 

from the [Data Explorer] sub-window.

9.6.2 Update Measurement Times in MRM Events

1 Click [Update MRM event time by Compound] on the [Method] menu.
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2 When the confirmation message is displayed, click [Yes].

The measurement times in MRM events set in MS instrument parameters are updated. 

9.6.3 Check Updated Results

1 Check measurement time update results in the Event Table. 

• Event measurement times are calculated from retention time settings in the Compound Table and 
the [Process Time] settings in identification parameters. 

• Measurement times for non-MRM events are not updated. 

9.6.4 Save to Method Files

1 Click  (Save) on the toolbar.

The results of updating MRM event measurement times are saved in the method file. 

This completes the method optimization process. 
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9.7 Create a Calibration Curve and Perform Quantitative 
Calculations
Use the MRM acquisition method file saved in "9.6 Update Measurement Times in MRM Events" to 
analyze the actual sample. 

This section describes how to perform realtime batch on a standard sample, create a calibration curve, and 
quantitate an unknown sample. 

9.7.1 Set Calibration Curve Parameters in a Method File

1 Drag-and-drop the method file for MRM acquisition onto the [Data Acquisition] window 

from the [Data Explorer] sub-window.

2 Perform data acquisition on the standard sample and set parameters for creating a 

calibration curve. 

1 Click [Data Processing Parameters(MS)] on the [Method] menu. 

The [Data Processing Parameters] sub-window is displayed.
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2 Click the [Quantitative] tab.

3 Select [Quantitative Method].

4 Set the number of levels and type of calibration curve. 

4

3
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5 Click the [Compound] tab.

6 Set the concentrations for each level of the standard sample used to create the calibration curve. 

7 Click [OK] to apply the settings. 

3 Click  (Save) on the toolbar.

Quantitative processing parameters are saved in the method file for MRM acquisition. 

9.7.2 Create a Batch Table

1 Click the  (Realtime Batch) icon on the [Main] assistant bar.

The [Realtime Batch] window is displayed. 

2 Click the  (Wizard) icon on the [Realtime Batch] assistant bar.

The [Batch Table Wizard] sub-window is displayed.

3 Create a Batch Table using the Batch Table Wizard.

Reference
For details on operations, see "3.2.1 Batch Table Wizard" P.43.

6

7

5
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9.7.3 Start Realtime Batch

1 Place standard and unknown samples on the autosampler, with the trays and vial 

number in the order set in the Batch Table. 

2 Click the  (Start Realtime Batch) icon on the [Realtime Batch] assistant bar.

Realtime Batch is executed. 

9.7.4 Check Quantitative Results in the Quant Browser
Check the quantitative results calculated in "9.7 Create a Calibration Curve and Perform Quantitative 
Calculations" in the [Quant Browser] window. 

1 Drag-and-drop the batch file used for continuous data acquisitions onto the [Quant 

Browser] window from the [Batch] tab in the [Data Explorer] sub-window. 

The contents of the method file and data file currently set in the batch file are displayed in the [Quant 
Browser] window.

2 Click the [Compound] tab in [Method View], and click the compound to display.
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9.8  Reoptimize Previously Optimized Methods

9

The quantitative results of the compound selected on the [Compound] tab are displayed in [Quantitative 
Results View], and the calibration curve is displayed in [Calibration Curve/Spectrum View].

Reference
For further details, see "11.2 Check Quantitative Results in the Quant Browser" P.330.

9.8 Reoptimize Previously Optimized Methods
To re-optimize methods that have already been optimized before, use the following procedure. 

9.8.1 Prepare the Sample

1 Remove the column to allow flow injection analysis. 

2 Place the samples on the autosampler. 

9.8.2 Change the Method File for Flow Injection Analysis
Change a previously optimized method file (for column analysis) for use in flow injection analysis. 

1 Start up the [Realtime Analysis] program from the [LabSolutions Main] window to open 

the [Data Acquisition] window.

Reference
For details on operations, see "2.1.1 Open the [Data Acquisition] Window" P.9.
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2 Drag-and-drop the method file onto the [Data Acquisition] window from the [Data 

Explorer] sub-window.

3 Change the LC instrument parameters for use in flow injection analysis. 

1 Change the flowrate on the [Pump] tab. (Example: 0.2 mL/min)

2 Set a short time on the [Data Acquisition] tab. (Example: 0.5 min) 

3 Delete all rows except the [stop] command on the [LC Time Prog.] tab. 

4 Change a time of the [stop] command on the [LC Time Prog.] tab. (Example: 0.5 min) 

5 Deselect the [Column Oven] checkbox on the [Column Oven] tab.
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4 Select one of the events in MS instrument parameters, set the measurement time, and 

click [Set Same Measurement Time] on the right-click menu. 

Since the analysis is performed without column, please set a short analysis time.

5 When the confirmation message is displayed, click [OK].

This results in the same measurement time for all events. 

9.8.3 Optimize Method

1 Click the  (Optimization for Method) icon on the [Acquisition] assistant bar.

The [Condition Settings for Optimize Method] sub-window is displayed.
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2 Click [Optimize voltage], and click [Next].

The [Condition Settings for Optimize Method] sub-window is displayed.
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9.8  Reoptimize Previously Optimized Methods

9

3 Set the optimization conditions, and click [Start]. 

Optimize each event by measuring the sample for each item selected in area 1. 

No. Description
1 When [Adjust Precursor m/z] is selected, the m/z value with the highest peak intensity within the -0.5 to 

+0.5 u range is determined for precursor ion m/z set in MS instrument parameters. 
When [Optimize Voltage] is selected, the items selected for optimization in the [Optimize voltage 
settings] sub-window, which is displayed by clicking [Advanced Settings], are optimized. 
When [Adjust Product m/z] is selected, the m/z value with the highest peak intensity within the -0.5 to 
+0.5 u range is determined for product ion m/z identified by automatic searching.

2 Enter the vial number, tray, and injection volume for samples used for optimization. 
It indicates information about samples prepared in "9.8.1 Prepare the Sample". 

3 Select the events to optimize.

4 A subfolder is created under the folder specified here. The name of the subfolder is determined by the 
date and time. The files automatically created during the optimization are output in this folder.

The default is the project folder.

5 Select [Apply to method file]. Optimized results are applied to the currently open method file.

6 When [Shutdown after optimization] is selected, realtime batch is executed after optimization is finished. 
When performing shutdown after optimization, the method file currently opened is closed.

7 Check [Predicted end time], and click [Start].

1

2

4

3

6

75
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The [Proceeding for Optimize method] sub-window is displayed during optimization. Clicking [Stop] 
stops method optimization. 

 Display Optimization Results
After optimization is finished, click [Detail] in the [Proceeding for Optimize method] sub-window to display 
the [Method Optimization Results] sub-window. 
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The results are reflected in the method parameters.

• The displayed items vary according to the MS detector model.

• After the [Proceeding for Optimize method] sub-window is closed, optimization results can be displayed 
by clicking [Optimization Result] on the [Method] menu in the [Data Acquisition] window. 

• The data files output during the optimization are saved in the folder set at 4. To check detailed results, 
open the target data file in the [MS Data Analysis] window.

9.8.4 Restore Method File for Column Analysis and Confirm Retention 
Times

1 Change the LC instrument parameters for use in column analysis. 

Restore settings for column analysis, such as the pump flowrate, time program, data acquisition time, and 
column oven control. 

2 Check the compound retention times by single run. 

Reference
For details on operations, see "9.4 Check Compound Retention Times" P.297.

3 After single run is finished, set retention times in the Compound Table. 

Reference
For details on operations, see "9.5 Set Retention Times in the Compound Table" P.300.
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9.8.5 Update Measurement Times for MRM Events in Methods
Based on retention times in the Compound Table, update the measurement times for MRM events in MS 
instrument parameters. 

1 Click [Update MRM event time by Compound] on the [Method] menu.

2 When the confirmation message is displayed, click [Yes].

The measurement times for MRM events in MS instrument parameters are updated. 

That completes the method optimization process. 
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10Automatic MS/MS

Automatic MS/MS measurements are used when observed ions are unknown. Precursor ions are 
selected and MS/MS analysis is performed automatically according to criteria settings. 

If the LCMS-8030, LCMS-8040, LCMS-8045, LCMS-8050 or LCMS-8060 is used as an MS detector, 
automatic MS/MS measurement is enabled. 

10.1 Perform Measurements by Automatic MS/MS
This section describes how to automatically measure samples by MS/MS, using the Q3 scan for survey 
events (parent events) and the product ion scan for dependent events (child events). 

1 Start up the [Realtime Analysis] program from the [LabSolutions Main] window to open 

the [Data Acquisition] window.

Reference
For details on operations, see "2.1.1 Open the [Data Acquisition] Window" P.9.

2 Click the [MS] tab.
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3 Set the survey event. 

Add the survey event to the Event Table and set measurement conditions. 

1 Select the event polarity. 

2 Click the button for the event’s data acquisition mode. 
The event with the initial settings is added to the Event Table. 

3 Set the measurement time. 

4 Set the m/z range to measure. 

5 Select [Use as Survey Event].

6 Click the [Survey Event Settings] button.
The [Condition Settings for Survey Event] sub-window is displayed. 

2

1

4
3

65
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10.1  Perform Measurements by Automatic MS/MS
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4 Set the execution conditions for the survey event. 

Reference
For details on how to set this sub-window, refer to Help.

5 Click [OK].

This returns to the original sub-window. 

No. Description
1 Selecting [Automatic Exclude] automatically excludes previous precursor ions and prevents them from 

being selected as precursor ions for the period set at [Automatic Exclude Period]. 

2 Set the minimum repeat counts (count that is repeated even if the result of the survey event is weak) for 
dependent events that use the same mass. 

3 Set the m/z values and measurement time to exclude in selecting ions as precursors. 

4 Set the m/z values and measurement time to prioritize in selecting ions as precursors. 

2

4

1

3
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6 Set the dependent event. 

Add the dependent event to the Event Table and set measurement conditions. 

1 Select the data acquisition mode for the dependent event. 

2 Click the [Add] button.

A corresponding dependent event is added to the survey event in the Event Table. 

The polarity and measurement time range is the same as for the survey event. 

3 Set the m/z range to measure. 

4 Click the [Dependent Event Settings] button.

The [Condition Settings for Dependent Event] sub-window is displayed.

2
1

4

3
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10.1  Perform Measurements by Automatic MS/MS

10

7 Set the execution conditions for the dependent event. 

Reference
For details on how to set this sub-window, refer to Help.

8 Click [OK], and close the [Condition Settings for Dependent Event] sub-window.

9 Click the  (Start Single Run) icon on the [Acquisition] assistant bar.

10 Set the data acquisition settings, and click [OK].

Reference
For details on operations, see "2.5.1 Execute Single Run" P.36 .

No. Description
1 Set the criteria for dependent events in selecting precursor ions.  

2 Enter the minimum intensity value (absolute intensity) for precursor ions, where ions with lower intensity 
are excluded. 

3 Displays the settings made in the [Condition Settings for Survey Event] sub-window. These items cannot 
be edited in this sub-window.

1 2

3
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10.2 Check Data Measured by Automatic MS/MS
This section describes how to display automatic MS/MS measurement results in the [MS Data Analysis] 
window. 

10.2.1Load Data Files

1 Click the  (Data Analysis) icon on the [Acquisition] assistant bar to open the [MS 

Data Analysis] window.

Reference
For details on how to use the [MS Data Analysis] window, see "6.1.1 Open the [MS Data Analysis] 
Window" P.175.

The [MS Data Analysis] window is displayed.

2 Drag-and-drop the data file acquired in "10.1 Perform Measurements by Automatic MS/

MS" onto the [MS Data Analysis] window from the [Data Explorer] sub-window. 

The content of the data file is displayed in the [MS Data Analysis] window.
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10.2  Check Data Measured by Automatic MS/MS
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3 Click the [Tree] tab in [Spectrum View].

Selected precursor ions are displayed on the [Tree] tab in [Spectrum View], in order of m/z. Clicking a 

precursor ion listed in the tree displays corresponding spectra of survey and dependent events. 

10.2.2Change the Tree Display Content

1 Click the [Settings] button on the [Tree] tab in [Spectrum View].

The [MS Data View Parameters] sub-window is displayed. This sub-window allows setting detailed 
spectrum tree display settings. 

Displays the [event number], 
(interface type and polarity), 
data acquisition mode, and 
retention time.

The display contents can be changed in the [Details-Spectrum View 
Display Settings] sub-window displayed by clicking the [Detail] button on 
the [Display] tab.

MS/MS

MS
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2 Switch between editing sub-windows by clicking on respective tabs on the [Spectrum 

Tree] tab. 

The tree display can be updated without closing the sub-window by clicking the [Apply] button located on 
each tab. 

Reference
For details on how to set the parameters for each tab, refer to Help.

Items Description
[Sort] tab Sets the conditions for sorting items to display in tree.

[Precursor Extract] tab Sets the precursor ion extraction criteria. 

[MS/MS] tab Edits the precursor ion masses. Allows detailed filtering of precursor ions to display in 
the tree.
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11Quant Browser

Use the [Quant Browser] window to edit a method file and then perform quantitative calculation on 
multiple data. 

This chapter describes how to edit the quantitative results for multiple data files, and perform 
collective postrun analysis on multiple data files.

11.1 [Quant Browser] Window
The [Quant Browser] window is comprised of the following views:

• [Quantitative Results View] - displays the quantitative calculation results

• [Method View] - displays the method file parameters

• [Chromatogram View] - displays the chromatograms and sample information

• [Calibration Curve/Spectrum View] - displays the calibration curves and spectra 

11.1.1Open the [Quant Browser] Window

1 Select the  icon on the [LabSolutions Main] icon bar, and double-click the  

icon. 

The [Browser] program opens. 
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2 Click the  (Quant Browser) icon on the [Main] assistant bar in the [Browser] 

program. 

3 Drag-and-drop the method file from the [Data Explorer] sub-window onto the [Quant 

Browser] window. 

The contents of the method file are displayed in the [Quant Browser] window. 



 Operators Guide   329

11.1  [Quant Browser] Window
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11.1.2 [Quant Browser] Window Description
This section describes how to view and use the [Quant Browser] window. 

• The [Quant Browser] views that are separated by dividers. Drag the dividers with the mouse to resize the 
views.

• Use the [Quant Browser] to check the quantitative calculation results of up to 1024 data files.

• Click [Save Browsing File As] on the [Layout] menu to save the name of the method and data file, file sort 
order, layout information, and other details as a browsing file (file extension *.lcq).

• Files are [Read Only] if they are currently being edited in other windows and cannot be edited. Close the 
file in the other window, and open the file again to edit these files.

No. Explanation
1 Displays the [Standard] and [Quant Browser] toolbars. 

2 Displays the quantitative calculation results of compounds selected on the [Compound] tab in [Method View]. 

Click  to change the ID # and the displayed compound. 

3 Displays the data processing parameters in the method file. Click  (Edit Mode) to change the 

parameters. Click  (View Mode) after editing to reflect the changes in [Method View]. 

4 Displays the calibration curve for the compound selected on the [Compound] tab in [Method View] or the 
spectra specified in [Chromatogram View]. 

5 Displays the [Chromatogram] and [Sample Info] for the selected data file. Clicking  or  to double or 
halve the intensity axis (Y-axis), respectively.

6 Click this icon to expand the view to the full screen size.

6

Toolbar1

4 [Calibration Curve/
Spectrum View] 

 [Quantitative Results View]2 [Method View]3

[Chromatogram View]5
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11.2 Check Quantitative Results in the Quant Browser
Multiple data can be displayed in a simple form in the [Quant Browser] window.

This section describes how to display data in each of the [Quant Browser] views. 

11.2.1Open Batch Files
This section describes how to open batch files to display the contents of the method file and data files. 

1 Click the  (Batch) tab at the bottom of the [Data Explorer] sub-window. 
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11.2  Check Quantitative Results in the Quant Browser
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2 Drag-and-drop the batch file onto the [Quant Browser] window from the [Data Explorer] 

sub-window. 

The contents of the method file and data files are displayed in the [Quant Browser] window. 

3 Click the [Compound] tab in [Method View], and select the desired compound. 

The quantitative results of the selected compound are displayed in [Quantitative Results View], and the 
calibration curve is displayed in the [Calibration Curve/Spectrum View]. 
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4 Select the data file from [Quantitative Results View], and click the data file. 

The chromatogram of the selected data file is displayed in the [Chromatogram View]. 

• The method file in the top row of the Batch Table is displayed in [Method View] when a batch file is 
selected in the [Data Explorer] sub-window. If the method file contains calibration curve information, the 
standard sample data file used for making the calibration curve is loaded. 

• The data file and method file must be saved to the same folder as the batch file to display the content of 
the method file and data file using a batch file. 

• Edit the method file and data file in the [Quant Browser] window. The batch file is not changed when data 
is displayed. 
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11.2  Check Quantitative Results in the Quant Browser
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11.2.2Open Data Files
Open data files to display the contents of data files in each view. 

This section describes how to open the data file of an unknown sample. 

1 Drag-and-drop the data file onto the [Quant Browser] window from the [Data Explorer] 

sub-window. 

The contents of the data file and method file are displayed in the [Quant Browser] window. 

Multiple files are selected when the data file is dragged-and-dropped onto the [Quant Browser] window from 
the [Data Explorer] sub-window. The method file in the top data file is displayed in [Method View]. If the 
loaded method file contains calibration curve information, the content of the standard sample data file used 
to make the calibration curve is also displayed.
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11.2.3Check Spectra from [Chromatogram View]
Double-click the MS or PDA chromatogram displayed in [Chromatogram View] to display the spectrum at 
that retention time. 

This section describes how to display a MS spectrum. 

1 Select the [Chromatogram] tab in [Chromatogram View], and double-click the MS 

chromatogram. 

[Calibration Curve/Spectrum View] changes to the [Spectrum] tab, and the MS spectrum is displayed. 

• MS spectra cannot be displayed when is displayed on the MS chromatogram. 

• To display chromatograms in all time ranges in [Chromatogram View], right-click on [Chromatogram 
View], and click [All Peaks] on the displayed menu. 
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11.2.4Check Internal Standard Peaks
Chromatograms of ISTDs registered in the same ISTD group as the selected compound can be displayed 
in a stack in [Chromatogram View]. This section describes how to display ISTD chromatograms and how to 
adjust the scales of the Y-axes to the largest peak.

1 Right-click on the chromatogram on the [Chromatogram] tab page in [Chromatogram 

View], and click [ISTD Peaks] on the displayed menu.

Chromatograms of ISTDs registered in the same ISTD group as the compound selected in [Compound 
Table] are displayed in a stack.

2 Right-click on the chromatogram, and click [Y-axis:Fit Largest peak] on the displayed 

menu.
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The scales of the Y axes in all the graphs are adjusted to the largest peak intensity in the displayed 
graphs.

11.2.5Display Chromatograms from Multiple Data
Chromatograms from the multiple data files can be displayed in [Chromatogram View] in a stack. This 
section describes how to display the chromatograms from two data files.

1 Right-click on the chromatogram on the [Chromatogram] tab page in [Chromatogram 

View], and then click [Peaks for 2 data files] on the displayed menu.
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2 Enter the [Quantitative Results View]-[Data#] number that corresponds to the data file to 

display, at [Data#] in [Chromatogram View].

Chromatograms that have the same ID numbers as the compounds selected in [Compound Table] are 
displayed in a stack.

11.3 Postrun Analysis of Multiple Data
This section describes how to edit [Quantitative Results View] and [Method View] and perform collective 
postrun analysis on multiple data. 

11.3.1Edit the Compound Table
Compound Tables that were used for data acquisition can be edited in [Method View]. 

This section describes how to change [Conc. (1)] in the Compound Table. 

1 Click  (Edit Mode) in [Method View]. 
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2 Click  (Full Size) in [Method View]. 

3 Click the [Compound] tab, select the desired compound, and change [Conc. (1)]. 

In this example, change the [Conc. (1)] setting from “0.01” to “0.02”. 

4 Click  (Normal Size) and  (View Mode) in [Method View]. 

5 Click the  (Peak Integration for All Data) icon on the [Quant Browser] assistant bar, 

and then click [OK].

The calibration curve is recreated, the quantitative results are re-calculated, and [Quantitative Results 
View] is updated. 
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• Right-click on [Method View] and click [Cancel Edit] to cancel method editing. 

• Select the columns that are displayed in the Compound Table in the [Table Style] sub-window. Right-
click on the Compound Table and click [Table Style] to open the [Table Style] sub-window. 

11.3.2Edit [Quantitative Results View]
This section describes how to change the items displayed in the [Quantitative Results View]. 

Quantitative results are automatically re-calculated when each item is changed. 

• Right-click on [Quantitative Results View] and click [Remove] to delete a data file in [Quantitative Results 
View]. If deletion of a data file affects the calibration curve, all data files are re-calculated. 

• Click the  icon on the toolbar to filter the data files displayed in [Quantitative Results View] by 
individual sample type. 

• Right-click on [Quantitative Results View] and click [Full Path] to display the folder and file name at [Data 
Filename]. 

• Click the title of a column in the [Quantitative Results View] table to sort the data by [Data Filename], 
[Sample Name], [Sample ID], [Sample Type], [Level #], [Vial #], [Tray], and [Date Acquired].

• Select the columns that are displayed in the [Quantitative Results View] table in the [Table Style] sub-
window. Right-click on the [Quantitative Results View] table and click [Table Style] to open the [Table 
Style] sub-window. 

• Click [Save Method File] on the [File] menu to save changes made to the data and method files in 
[Quantitative Results View]. 
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 Change the Sample Type
Sample types that were set at data acquisition can be changed. 

1 Click the [Sample Type] cell of the sample to be changed, and select the sample type 

from the displayed list. 

 

If [Standard (Calc. Point)] is changed to another sample type, or another sample type is changed to 
[Standard (Calc. Point)], the calibration curve is re-created, and all data files are re-calculated. 

 Change the [Level#]
The level numbers that were set at data acquisition can be changed. 

1 Change the [Level#] of the desired sample. 

 Disable Calibration Points
Calibration curve points can be disabled if the standard samples were not analyzed appropriately. 

1 Deselect [Cal. Point]. 

If a [Cal. Point] is disabled, the calibration curve is re-created. 

Calibration points for individual compounds can be enabled or disabled on the [Compound] tab in [Method 
View]. 
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 Display Statistical Results
Statistical calculations can be applied to quantitative results and the results can be displayed in the 
[Quantitative Results View]. 

1 Right-click on [Quantitative Results View], and click [Statistical Result]. 

The statistical calculation results are added to the bottom of the table. 

Select the [Statistic] column in the [Quantitative Results View] table to target a data file for statistical 
calculation. [Statistic] is not displayed in [Quantitative Results View] by default. Right-click on the 
[Quantitative Results View] table and select [Table Style] to display the [Statistic] column. 

11.3.3Change Peak Integration Parameters
This section describes how to change the peak integration parameters and re-integrate the peak. 

1 Click  (Edit Mode) in [Method View]. 
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2 Click the [Integration] tab, and set each parameter as required. 

In this example, change the [Slope] to “20”. 

Reference
Refer to the Data Acquisition & Processing Theory Guide for details on peak integration. 

3 Click  (View Mode) in [Method View]. 

4 Select [Peak Integration] on the [Process] menu, and click [Peak Integration for All IDs 

of All Data]. 

[Peak Integration for All IDs of All Data] executes peak integration on all IDs of all currently loaded data 
files. 

The results of peak integration and quantitation are displayed in the [Quantitative Results View]. 
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• Quantitation is performed following peak integration. 

• Either click  (Peak Integration (ID)) on the toolbar, or select [Peak Integration] on the [Process] menu, 

and click [Peak Integration by ID] to perform peak integration on the displayed IDs for the selected data 
files. 

• Select [Peak Integration] on the [Process] menu and click [Peak Integration for all IDs] to perform peak 
integration on all IDs for the selected data files.

11.3.4Calibration Curve Correction
During calibration curve creation, low-concentration samples may not be integrated properly. If the low-
concentration calibration point is disabled, a 3-point calibration curve becomes a 2-point calibration curve. 

This section describes how to manually integrate the data of a standard sample that could not be 
automatically integrated, and correct the calibration curve.

This section describes an example where peak integration failed, resulting in 2-point calibration curve. 

1 Click the  (Manual Peak Integration) icon on the [Quant Browser] assistant bar in 

the [Browser] program. 

The [Manual Integration Bar] is displayed. 
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2 Click  (Clear & Insert Peak) on [Manual Integration Bar], and click the peak start 

point and then the peak end point. 

The peak is detected, and the results are re-calculated. 
The 4-point calibration curve is re-created, and all data files are recalculated. 

To confirm the calibration curve information, right-click on the calibration curve on the [Calib Curve] tab in 
[Calibration Curve/Spectrum View], and click [Calibration Information] on the displayed menu. 

Peaks can be inserted by using  (Auto Mode) or  (Clear & Insert Peak) icon.
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11.3.5Export the Quantitative Results
The contents of the [Quantitative Results View] table can be converted to the ASCII text format and saved 
to a file or copied to the Clipboard. 

1 Click [Export Quantitative Results] on the [File] menu. 

2 Select the desired parameters, and click [OK]. 

1 Select [Export to]. 

Enter the folder and file name to output files. 

2 Set [Items to Output]. 

Select [Items Displayed on the Screen] to output the items displayed in the [Quantitative Results 
View]. 

3 Set [IDs to Output]. 

Select [All IDs] to display the results of all compound IDs. 

Select [Designate IDs] and enter the ID numbers of the compounds to output. 

• Enter multiple ID numbers to output with a comma or space. (example: 1,3,8)

• Enter a range of continuous ID numbers with a hyphen. (example: 2-8)

4 Select a [Delimiter]. 

1

2

3

4
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11.4 Print Quantitative Results
The [Quant Browser] window has a summary report function for collectively reporting multiple data.

1 Click the  (Summary Report) icon on the [Quant Browser] assistant bar. 

2 Click the  (Print) icon on the [Report] assistant bar. 

An image of the table is printed for each compound. 

Example of Quant Browser printout
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12Data Browser

Use the [Data Browser] window to compare multiple data, compare the data of different detectors, set 
the layout of display data, perform peak integration of chromatograms, and print browser reports. 

This chapter describes how to collectively check multiple chromatograms and spectra. 

12.1 Open the [Data Browser] Window
Up to 64 chromatogram data, sample information, etc. can be displayed as a list in the [Data Browser] 
Window. 

1 Select the  icon on the [LabSolutions Main] icon bar, and double-click the 

 icon. 

The [Browser] program opens. 
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2 Click the  (Data Browser) icon on the [Main] assistant bar in the [Browser] program.

3 Drag-and-drop the data files onto the [Data Browser] window from the [Data Explorer] 

sub-window. 

4 Select the Data Type parameters, and click [OK]. 

• If the cell fixed function is not enabled, the [Select Data Type] sub-window is displayed. Refer to 
"12.3 Cell Fixed Function" P.358 for details on the cell fixed function. 

• Multiple chromatogram data can be opened in a single cell to be displayed as an overlaid or 
stacked chromatogram. 

3

1
2
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1 Select the [Target Cell]. 

Select [Load Data to Current Cell] to display the selected data files in the cell where the files were 
dragged-and-dropped into from the [Data Explorer] sub-window. 

Select [Add data to MS Chromatogram] to display chromatograms of different data files in the same 
cell.

Select [Open as New Cell] to display each data file in a new cell. Determine which direction to open 
the new cell in at [Cell Location]. 

[Add data to MS Chromatogram] is only available when data files are dragged-and-dropped into 
an [MS Chromatogram] cell. Select from three types of chromatograms, [Chromatogram], [PDA 
Chromatogram] or [MS Chromatogram] at [Data Type], and chromatograms are displayed in the 
[MS Chromatogram] cell. 

2 Set [Cell Location]. 

If [Open as New Cell] was selected at [Target Cell], set the direction that new cells will be added. 
Select [Rightward] to create columns and select [Downward] to create rows. 

3 Set [Data Type]. 

Select the multiple types of data to be displayed. 

The contents of the data files are displayed in the [Data Browser] window. 

 [Target Cell]
Cells are created according to the [Target Cell] setting in the [Select Data Type] sub-window. The following 
example assumes that a data file is already loaded in a layout whose [Row] and [Col] settings are set to “3” 
and “1”, respectively. 
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• [Load Data to Current Cell] is selected at [Target Cell] and [Add data to MS Chromatogram] is not 
selected
The [MS Chromatogram] cell contents are replaced by the data file that is dragged-and-dropped into that 
cell. In this example, the cell contents are overwritten with the [Chromatogram] and the [PDA 
Chromatogram] and [MS Chromatogram] are opened in the direction specified at [Cell Location]. Here, the 
[PDA Chromatogram] cell and [MS Chromatogram] are overwritten to cells below the cell that the data file 
was dragged-and-dropped into. 

The cell order becomes [Chromatogram], [PDA Chromatogram] and [MS Chromatogram]. 

If multiple data files are dragged-and-dropped, only the data file initially selected in the [Data 
Explorer] sub-window is processed. 

Cell overwritten by drag-and-drop

Overwritten cell

Overwritten cell
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• [Load Data to Current Cell] is selected and [Add data to MS Chromatogram] is selected)
The contents of the data files are added to and displayed in the [MS Chromatogram] cell into which the data 
file was dragged-and-dropped. 

 The display does not change. 

The display does not change.

 Dragged-and-dropped cell
The chromatogram of the data
files are added here.
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• [Open as New Cell] is selected
New cells are created to individually display the [Chromatogram], [PDA Chromatogram] and [MS 
Chromatogram].

If the [Row] or [Col] display reaches the maximum number of 8 each (8 rows, 8 columns), a new 
[Row] or [Col] is created to display the additional data files. 

Dragged-and-dropped cell
The display does not change. 

The display does not change. 

The display does not change. 

Newly created cell

Newly created cell

Newly created cell
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12.1.1 [Data Browser] Window Description
This section describes how to view and use the [Data Browser] window. 

• Files currently being edited in other windows are [Read Only] and cannot be edited. Close the file in the 
other window and open the file again to edit these files. 

• The arrangement of cells in the vertical direction is referred to as [Row], and the arrangement of cells in 
the horizontal direction is referred to as [Col]. 

• The maximum number of [Row] and [Col] is 8 each, which means that up to 64 cells can be displayed. 

No. Explanation
1 Displays the [Standard] and [Data Browser] toolbars. 

2 Displays the preset cell number. The cell number can be changed by clicking . If the cell fixed function is 

enabled,  is displayed. Refer to "12.3 Cell Fixed Function" P.358 for details on the cell fixed function. 

3 The focus bar is displayed in the currently selected cell.

4 Displays the content of the data file in the cell. 
Place the mouse pointer over the data file name display area to display the sample information. 

5 Clicking this button to expand the cell to the full screen view. 

6
When the focus pin is upright and green ( ), it is linked to other cells. 
Refer to "12.4.7 Link Content Between Cells" P.372 for details on linking cells. 

1

6

2

3

4

5
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12.2 Adjust Layouts
Adjust and re-arrange layouts so that the content of the currently displayed data can be easily compared. 

• Drag the boarder of the [Data Browser] cell with the mouse to resize the cell. The size of [Data Browser] is 
automatically determined so that it is split into equal lengths according to the number of displayed cells. 

• Use the cell connect function to partially create larger cells. Refer to "12.2.3 Connect Cells" P.357 for 
details on connecting cells. 

12.2.1Adjust Display Layouts
This section describes how to adjust the layout of display cells. 

1 Click the  (Layout Property) icon on the [Data Browser] assistant bar. 

The [Property] sub-window can also be opened by clicking [Property] on the [Layout] menu of the 
[Data Browser] window. 

2 Select the [Style] tab, set the number of rows and columns of the cell to display, and 

click [OK]. 

In this example, set [Row] and [Col] at [Cell Created] to “4” and “2”, respectively. 
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A 4  2 grid of cells is displayed. 

• Select [Scroll Mode] in the [Style] tab to display additional cells using the scroll bars. For example, 

when [Row] and [Col] at [Cell Displayed] are set to “3” and “2”, respectively, a 3  2 grid of cells is 
displayed in the sub-window and the remaining cells are displayed by scrolling with the scroll 
bars. 

• To delete rows or columns, either right-click a cell in the row or column to be deleted, select 

[Adjust Layout], and click [Delete Row] or [Delete Column], or click  (Delete Row) or  

(Delete Column) on the toolbar. Select the cell and click [Delete Cell] from the [Edit] menu to 
delete a single cell.

• Select [Save Layout File As] on the [Layout] menu to save cell layouts or the display information 
of data loaded to each cell. This data can be saved as layout files (file extension *.lyt). 
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12.2.2Change the Contents of Cells
The contents displayed in cells in the [Data Browser] window can be changed. 

This section describes how to change the cell content from [Chromatogram] to [Sample Information]. 

1 Click the desired cell. 

The focus bar is displayed. 

2 Click  (Sample Information) on the toolbar. 

The display data can also be changed by right-clicking on the cell, selecting [Change Data Type], 
and clicking [Sample Information]. 

The display content of the cell is switched from a chromatogram to the sample information. 
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• Click the  (Display Settings) icon on the [Data Browser] assistant bar to set the display mode and 

range of each cell. Refer to "12.4.2 Change the Chromatogram Display Mode" P.361 for details on the 
display mode. 

• Right-click on the source cell and click [Copy Cell] then right-click on the destination cell and click [Paste 
Cell] to copy the contents to other cells. This function is handy for displaying the contents of the same 
data file in multiple cells. 

• To swap the contents of the currently selected cell with the contents of another cell, drag the title (file 
name) of the selected cell and drop it on the target cell. 

• Right-click on the desired cell and click [Release Data from Cell] to delete the display contents of a cell. 

12.2.3Connect Cells
Adjacent cells can be connected or disconnected. 

This section describes how to connect cells. 

1 Select the cells to connect with the [Ctrl] key held down. 

The focus bar is displayed on the multiple cells. 

2 Right-click on one of the selected cells and click [Connect Cell]. 
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The cells are connected. 

• When cells are connected, data which is open in secondary cells is closed.

• Right-click on the connected cell and click [Disconnect Cell] to disconnect cell connections. 

• Select cells to be connected so that the shape of the resulting cell is a rectangle.

12.3 Cell Fixed Function
Use the cell fixed function to efficiently compare different data files. For example, compare the peaks of the 
control sample and target sample. 

When the cell fixed function is used, the cell numbers are displayed in each cell. The contents of the same 
data file is displayed in cells of the same cell number. 

Reference
"12.4.6 Load a Data File in Multiple Cells" P.368

"12.4.8 Peak Integration on Chromatograms" P.374

12.3.1Use the Cell Fixed Function
This section describes how to turn the cell fixed function on. 

1 Click the  (Cell Fixed) icon on the toolbar. 
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 (Cell Fixed) is selected, and cell number ( ) is displayed in the cell. 

• Click the  (Cell Fixed) icon on the toolbar again, to turn the cell fixed function off.

• The cell fixed function can also be switched on and off by clicking [Cell Fixed] on the [Edit] menu 
in the [Data Browser] window. 

12.4 Compare Data
The chromatograms from different detectors or multiple data files can be displayed in the same [MS 
Chromatogram] cell. Data from different detectors can be overlaid.

12.4.1Display the Chromatograms from Different Detectors in the Same 
Cell
The chromatograms from different detectors can be displayed in the same [MS Chromatogram] cell. 

This section describes how to display MS chromatograms, chromatograms and PDA chromatograms in the 
[MS Chromatogram] cell. 

1 Drag-and-drop the data file onto the [MS Chromatogram] cell from the [Data Explorer] 

sub-window. 
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2 Set each item, and click [OK]. 

1 Select [Load Data to Current Cell], and select [Add data to MS Chromatogram]. 

2 Select [Chromatogram], [PDA Chromatogram] and [MS Chromatogram]. 

The [Chromatogram], [PDA Chromatogram] and [MS Chromatogram] are all displayed in the same cell. 

1

2
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12.4.2Change the Chromatogram Display Mode
The chromatogram display mode in the [MS Chromatogram] can be changed to [All Segments], [Multiple 
Segments] or [Each Segment]. 

The [Overlay], [Stack], [Compare] and [Single] parameters are available for chromatograms in the [Each 
Segment] display mode. 

This section describes how to change chromatogram display from [Overlay] to [Stack]. 

1 Select the [MS Chromatogram] cell to be changed, and click the  (Display Settings) 

icon on the [Data Browser] assistant bar. 

2 Click the [MS Chromatogram Settings] tab, set each item, and click [OK]. 

1 Set [Display Mode]. 

Select [Each Segment] and [Stack]. 

Reference
Refer to "6.2.4 Change the [Chromatogram View] Display Mode" P.183 for details on [Display 
Mode]. 

1

2

3
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2 Enter the [Range Settings]. 

The axis range can be fixed. Select [Apply to same type cell] or [Apply to all cell] to apply the same 
axis range to other cells. Click [Initialize] to return the range to its original setting. 

3 Determine whether to display the information area in all of the cells. 

An information area is displayed on the right of all chromatogram and spectrum cells when [Display 
Information Area in All Cells] is selected. 

The [MS Chromatogram Settings] sub-window can also be displayed by right-clicking on the 
[MS Chromatogram] cell, and clicking [Display Settings].

[Display Mode] is changed to [Stack]. 

Up to 16 data files can be displayed in one [MS Chromatogram] cell. 
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12.4.3Display or Hide the Chromatogram
Select or deselect [Disp.] on the [Chromatogram Table] tab or [LC Settings] tab in the [MS Chromatogram 
Settings] sub-window to display or hide chromatograms in the [MS Chromatogram] cell. 

 Hide Chromatograms in the [MS Chromatogram] Cell

1 Click the [MS Settings] tab in the [MS Chromatogram Settings] sub-window, and select 

[Use Chromatogram Table in each data file]. 

2 Deselect the [Disp.] column for the MS chromatogram to be hidden in the 

Chromatogram Table, and click [OK]. 

The [MS Chromatogram] cell is no longer displayed. 
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When [Use Chromatogram Table in each data file] is selected, the chromatogram to display is based on the 
Chromatogram Table in the respective data file. When [Use Chromatogram Table in each data file] is not 
selected, the [MS Chromatogram Settings] can be applied to all open data in the [MS Chromatogram] cell. 

Reference
Refer to "6.2.6 Display Chromatograms from the Chromatogram Table and MIC Table" P.188 for details on 
the Chromatogram Table. 

3 Click [Yes].

The settings are applied to all [MS Chromatogram] cell. Clicking [No], the settings are applied to the 
currently selected [MS Chromatogram] cell. 

 Hide Chromatograms and PDA Chromatograms
Chromatograms and PDA chromatograms displayed or hidden on the [LC Settings] tab in the [MS 
Chromatogram Settings] sub-window. 

This section describes how to hide the [PDA Chromatogram]. 

1 Click the [LC Settings] tab in the [MS Chromatogram Settings] sub-window, set each 

item, and click [OK]. 

1 Deselect the [Disp.] column for the [PDA Chromatogram] cell to be hidden. 

2 Select the desired detector from the list of available detectors in the selected data file. 
Enter the amount of base shift for overlaid chromatograms. 

1 2 3
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3 Set the intensity axis scale for the chromatogram display. 

The [PDA Chromatogram] is no longer displayed. 

12.4.4Display Multiple Chromatograms in the Same Cell
Multiple data file chromatograms can be displayed in the same [MS Chromatogram] cell. 

In this example, the MS chromatogram of data file Data2.lcd is added to the [MS Chromatogram] cell that is 
currently displaying data file Data1.lcd. 

1 Drag-and-drop Data2.lcd onto the [MS Chromatogram] cell that is currently displaying 

Data1.lcd from the [Data Explorer] sub-window. 

2 Set each item, and click [OK]. 

1 Select [Load Data to Current Cell] and [Add data to MS Chromatogram]. 

2 Select [MS Chromatogram] as the data type. 

1

2
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The MS chromatograms of Data1.lcd and Data2.lcd are displayed in the same cell. 

• The name of the data file highlighted at the top of the cell is the active data. 

• Up to 80 chromatograms can be displayed in the same cell. 

12.4.5Time Compensation
When the chromatograms of different detectors are displayed in the same cell, if there is a difference in the 
retention times, it is not always easy to determine whether the chromatograms are for the same substance. 
The time compensation function allows the chromatograms to be aligned by compensating for each 
detector. 

This section describes how to align a [PDA Chromatogram] with the [MS Chromatogram].

1 Display the chromatogram of the PDA detector in the [MS Chromatogram] cell. 
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2 Click [MS Data View Parameters] on the [Method] menu. 

3 Click the [Delay Time] tab, set each item, and click [OK]. 

1 Select whether to compensate by time or volume. 

2 Set the compensation time or volume of each detector. 

In this example, enter “7” sec. for the [Detector PDA]. 

3 If the [Display the analysis time range of each detector] checkbox is selected, the chromatogram is 
displayed in a time-compensated time range for each detector. If this checkbox is not selected, the 
chromatogram is displayed in a range that uses the minimum start time and maximum end time of all 
of the detectors.

4 When [Align same peak #] is selected, the same peak number can be assigned to peaks of each 
detector with the same retention time. Set the time width to be used for judgement of same peak at 
[Search Threshold]. 

1

2

3

4
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The chromatograms are compensated. 

12.4.6Load a Data File in Multiple Cells
This section describes how to use the cell fixed function to display the chromatograms, PDA 
chromatograms and MS chromatograms of data files 1 and 2.

1 Determine the layout and cell type. 

This example uses a 3 row  2 column layout to display a chromatogram in the 1st row, a PDA 

chromatogram in the 2nd row, and an MS chromatogram in the 3rd row. 

Reference
Refer to "12.2.1 Adjust Display Layouts" P.354 for details on changing layouts, and "12.2.2 Change 
the Contents of Cells" P.356 for changing cell type. 

2 Click the  (Cell Fixed) icon on the toolbar. 
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 (Cell Fixed) is selected and cell number ( ) is displayed in the cell display area. 

3 Click the cell number ( ) that is to be changed, and set the cell number. 

In this example, set the cells in the 1st column to “1” and the cells in the second column to “2”. 
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4 Drag-and-drop data file 1 onto the number 1 chromatogram cell from the [Data Explorer] 

sub-window.

If a data file is dragged-and-dropped into an [MS Chromatogram] cell that already has a data file in it, 
a confirmation message is displayed prompting whether it is OK to add data to the cell. Click [Yes] to 
add the selected data file to the [MS Chromatogram] cell. Click [No] to swap all of the data files in al 
of the number 1 cells with the new data. In this example, select [No]. 
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The contents of the data file are displayed in the number 1 cells. 

5 Drag-and-drop data file 2 onto the number 2 chromatogram cell from the [Data Explorer] 

sub-window. 
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The contents of the data file are displayed in the number 2 cells. 

12.4.7Link Content Between Cells

An upright focus pin ( ) indicates that the cell is linked to other cells. 

For example, if the [PDA Chromatogram] and [PDA Spectrum] cell are linked and the chromatogram is 
double-clicked, the displayed spectrum in the [PDA Spectrum] cell is updated. 

This section describes how to link the [PDA Spectrum] cell display with the [PDA Chromatogram] cell. 

1 Ensure that the focus pin is upright ( ) on the [PDA Chromatogram] and [PDA 

Spectrum] cells. 

If the focus pin is down ( ), click  to change it to the upright state ( ). 
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2 Double-click the desired time position in the [PDA Chromatogram] cell. 

The spectrum at that time is displayed in the [PDA Spectrum] cell. 

• Depending on the type of cell, the display may be altered to display other information. 

• The default state of the focus pin in the cell is upright. 

•  Click an upright focus pin to disable cell links. 
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12.4.8Peak Integration on Chromatograms
This section describes how to perform peak integration on [PDA Chromatogram] in the [Data Browser] 
window. 

 Perform Peak Integration

1 Open the [PDA Chromatogram] to be integrated. 

2 Click [PDA Data Processing Parameters] on the [Method] menu. 

3 Click the [Integration] tab, set each of the integration parameters, and click [OK]. 

1 Select the channel to be integrated. In this example, select [Extracted Chromatogram]. 

2 Change the [Slope] setting to “1000”. 

1

2
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Reference
Refer to the Data Acquisition & Processing Theory Guide for details on each of the parameters. 

If automatic peak integration is not successful, try manual peak integration. Right-click on the PDA 
chromatogram and click [Manual Integration Bar] to display the [Manual Integration Bar]. The 
[Manual Integration Bar] cannot be displayed if an overlaid PDA chromatogram is displayed. Select 
[Stack] or [Single] to display the [Manual Integration Bar]. Refer to Help for details on the [Manual 
Integration Bar]

Peak integration is performed on the extracted chromatogram and the results are displayed. 
The baseline and peak top comment are displayed on the PDA chromatogram. 
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 Examine the Peak Integration Results
The results of peak integration can be examined in the [PDA Peak Table] cell. 

This section describes how to change the displayed cell to the [PDA Peak Table] cell to examine the peak 
integration results of the extracted PDA chromatogram. 

1 Select the cell to be changed to the [PDA Peak Table] and click  (PDA Peak Table) on 

the toolbar. 

Click the cell to display the focus bar in that cell. Click  (PDA Peak Table) on the toolbar to change 

the cell to the [PDA Peak Table] cell. 
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2 Click the cell number and select the cell number in the [Select Cell Number] sub-

window.

If the cell number is not displayed, refer to "12.3.1 Use the Cell Fixed Function" P.358 to turn the cell fixed 
function off.

3 Click the [Extracted] tab. 

The peak integration results of the extracted PDA chromatogram are displayed. 

The peak integration results of LC chromatograms and MS chromatograms are displayed in the [LC Peak 
Table] cell and [MS Peak Table] cell, respectively. 
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 Link Cells to Check Peak Integration Results
This section describes how to link the [PDA Chromatogram], [PDA Peak Table] and [PDA Spectrum] cells 
to check peak integration results. 

1 Position the [PDA Chromatogram], [PDA Peak Table] and [PDA Spectrum] cells as 

follows. 

Reference
Refer to "12.2 Adjust Layouts" P.354 for details.
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2 Ensure that the focus pins of the cells are in the upright ( ) position. 

If the focus pin is down ( ), click  to change it to the upright state ( ). 

3 Click the [PDA Chromatogram] cell. 

The focus bar is displayed on the [PDA Chromatogram] cell. 

4 Click [PDA Data Processing Parameters] on the [Method] menu. 
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5 Enter the parameters in the [Data Processing Parameters] sub-window, and click [OK]. 

Peak integration is performed when [OK] is clicked, even if no changes were made in the [Data 
Processing Parameters] sub-window. 

6 After peak integration, click a row on [PDA Peak Table]. 

The information for that peak is displayed in the [PDA Chromatogram] and [PDA Spectrum] cells.
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12.5 Print a Browser Report
The [Data Browser] window has functions for printing all of the cells or only selected cells. Size, color and 
other information in the chromatogram and spectrum cells also are reflected in the printout.

12.5.1Print All of the Cells
An image of all of the cells currently displayed in the [Data Browser] window can be printed. 

This section describes how to print all of the cells. 

1 Select [Print Image for All Cells] on the [File] menu, and click [Print]. 

An image of all of the cells is printed in the preset report layout locations. 
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12.5.2Print Selected Cells
An image of the cells currently selected in the [Data Browser] window can be printed.

This section describes how to print the [PDA Chromatogram] cell. 

1 Right-click on the desired cell, select [Print Graph], and click [Print]. 

The right-click menu changes to [Print Table] or [Print Sample Information] when the cell content is a 
table or sample information, respectively. 
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The image of the selected cell is printed. 
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13Data Comparison

This chapter describes how to overlay multiple data overlaid and perform calculations in the [Data 
Comparison] window. Up to 16 chromatograms can be overlaid in the [Data Comparison] window for 
comparison. 

Comparison calculations can be performed for the data of any currently specified chromatograms.

13.1 Open the [Data Comparison] Window
This section describes how to overlay the chromatograms of selected data in the [Data Comparison] 
window.

1 Click the  (Data Comparison) icon on the assistant bar in the [Postrun Analysis] 

program. 
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13.2 [Data Comparison] Window Description
This section describes how to view and use the [Data Comparison] window. 

• Right-click on the chromatogram and select [Base Shift] to shift the displayed chromatograms by an equal 
interval.

• Right-click on the chromatogram and select [Copy] to paste the chromatograms into other applications as 
image files. 

• Select [Close] on the [File] menu, then select [All Data] to close all of the open data. 

No. Explanation

1 Displays the [Standard] and [Data Comparison] toolbars.

2 Displays the information for the displayed data file.
Right-click on the data file information and click [Close] to close the data file.

3 Use these buttons to expand, reduce or moves a selected chromatogram to the top, bottom, left or right. 

• To move a chromatogram up/down or left/right, click  (Move Up/Down) or  (Move Left/Right) and 
drag the chromatogram to the move destination position. 

• Click  (Base Point) to expand or reduce a chromatogram and the click the position of the base point on 

the chromatogram to determine that point. Next, click  (Zoom Up/Down) or  (Zoom Left/Right), and 
drag the chromatogram to the expand/reduce destination point. The chromatogram is expanded or reduced 
to that point. 

4 Displays the chromatogram of the open data file as [Full Chromatogram] or [Zoomed Chromatogram]. Three 
view methods are available, [Overlay], [Stack] and [Base Shift]. 

5 Displays the Peak Table of the selected chromatogram. 

6 Displays calculation formulas for operations performed between the data of selected chromatograms.

Toolbar1 2

5

3

4

6
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13.3 Overlay Multiple Data
This section describes how to display the chromatograms of selected data overlaid in the [Data 
Comparison] window. 

1 Select the data file to overlay in the [Data Explorer] sub-window, and drag-and-drop that 

file onto the [Data Comparison] window. 

The chromatogram and Peak Table of the data files are displayed in the [Data Comparison] window. 

• A sub-window opens for channel selection when displaying a data file obtained by data 
acquisition on multiple channels. Select the checkbox of the channel to display. 

• Data files obtained by a PDA detector cannot be displayed overlaid in the [Data Comparison] 
window. 
To display in the [Data Comparison] window, select [Export Data] on the [File] menu in the [PDA 
Data Analysis] window, click [Export Chromatogram to Data File] and extract the multi 
chromatogram. 

• Click the  (Stack) icon on the [Comparison] assistant bar to display chromatograms in a 

stacked format. 
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13.4 Perform Calculations on Chromatograms
Specify any displayed chromatograms to perform arithmetic calculations (addition/subtraction/
multiplication/division) on the data.

This section describes how to perform arithmetic operations on 2 chromatograms.

1 Right-click on [Chromatogram View], and click [Show/Hide Data]. 

2 Select [Operation] to perform the arithmetic operation on the data, and click [OK]. 

Arithmetic operation can only be executed between 2 chromatograms. 
An error occurs if 3 or more chromatograms are selected. 

3 Click the desired arithmetic operation ( ) on the toolbar. 

The arithmetic operation is performed on the data of the selected chromatograms, and an additional 
green chromatogram is displayed. 
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The calculation formula can be checked by . 

• Click  (Reverse Data Order) on the toolbar to change  to 

 so that the calculation data is reversed. 

• Right-click on [Chromatogram View], and select [Save Processed Data] to save the calculation 
result.
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14LC Calibration Curves

This chapter describes how to make calibration curves and check calibration curve information. 

There are two ways to make a calibration curve:

• Automatic creation by batch processing

• Manual creation in the [Calibration Curve] window

This section describes how to make calibration curves automatically by postrun batch processing at 
"14.1 Calibration Curves by Postrun Batch" and manually in the [Calibration Curve] window at "14.2 
[Calibration Curve] Window". 

Reference
• MS data cannot be processed in the [Calibration Curve] window. Check and edit calibration curves for MS 

data in the [Quant Browser] window. See"11 Quant Browser" P.327.

• See "3.6 Create a Calibration Curve to Quantitate an Unknown Sample" P.71 for details on automatically 
making calibration curves using realtime batch. 

14.1 Calibration Curves by Postrun Batch
Use postrun batch to automatically make a calibration curve using the data file of a standard sample that 
has already been acquired. 

This section describes how to set data processing parameters and Batch Table items to make calibration 
curves. 

14.1.1Edit the Data Processing Parameters
This section describes how to edit the data processing parameters of method files using standard samples 
data. 

1 Click the  (Data Analysis) icon on the [Main] assistant bar in the [Postrun Analysis] 

program. 

2 Drag-and-drop the standard sample data file that has already been acquired onto the 

[Data Analysis] window from the [Data Explorer] sub-window. 

3 Click the  (Wizard) icon on the [Data Analysis] assistant bar. 
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4 Refer to "4.5.1 Compound Table Wizard" P.116 to set the data processing parameters 

using the Compound Table Wizard. 

5 Click  (View Mode) in [Method View]. 

The data loaded in the [Data Analysis] window is reanalyzed according to the new parameter settings.  
Check the analysis results in [Chromatogram View] and [Results View]. 

6 Click the  (Apply to Method) icon on the [Data Analysis] assistant bar. 

The parameters are exported to the method file. 

Reference
For details, see "4.7 Save (Export) to Method Files" P.126. 

14.1.2Edit Batch Tables

 Create Batch Tables
This section describes how to create batch tables. There are two ways to create a Batch Table according to 
how data is acquired. 

• New Batch Table

• Load the Batch Table used for data acquisition
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New Batch Table

1 Click the  (Postrun Batch) icon on the [Main] assistant bar in the [Postrun Analysis] 

program. 

If the  (Postrun Batch) icon is not displayed on the assistant bar, click  on the assistant 

bar title. 

2 Click [Add Rows with Selected Data File] on the [Edit] menu. 
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3 Select the data file name and then click . 

The data file name is displayed in the [Selected Data Files] box. Repeat this procedure to select all of the 
files required for postrun batch. 

The Batch Table is created from the information in the selected data file. 

Load a Batch Table Used for Data Acquisition

1 Click the  (Postrun Batch) icon on the [Main] assistant bar in the [Postrun Analysis] 

program. 

If the  (Postrun Batch) icon is not displayed on the assistant bar, click  on the assistant 

bar title. 
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2 Drag-and-drop the batch file used for data acquisition onto the [Postrun Batch] window 

from the [Data Explorer] sub-window. 

 Set the Sample Type
Set the type of sample to measure. 

In the case of a standard sample, set the first standard sample to [Initialize Calibration Curve] and the next 
standard sample to [Add Calibration Level]. The default setting [0: Unknown] is used for unknown samples.

1 Click the [Sample Type] cell of the initial standard sample. 

2 Click [Standard], select [Initialize Calibration Curve] and click [OK]. 

The initial cell for the sample type is displayed as [1: Standard (i)]. 

3 Click the [Sample Type] cell of the next standard sample. 
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4 Click [Standard], select [Add Calibration Level] and click [OK]. 

The cell for the sample type is displayed as [1: Standard]. 
Repeat steps 3 and 4 for multiple standard samples. 

 Setting the Level #
Set the standard sample [Level#] according to the concentration value in the Compound Table of the 
method file. The calibration points are created from the level number of the Compound Table and the area 
and height values of the preset standard sample. 

[Level#] values are not used for unknown samples, even if they are set. 

1 Click the [Level#] cell for the standard sample. 

2 Enter the level number. 

The level number. is changed. 

3 Set the [Level#] cell for other standard samples. 
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14.1.3Postrun Analysis Using Batch Tables

1 Click the  (Start Postrun Batch) icon on the [Postrun Batch] assistant bar. 

Postrun batch is started. 

14.1.4Check Calibration Curves
Check whether the calibration curve has been successfully drawn in the [Calibration Curve] window in 
"14.1.3 Postrun Analysis Using Batch Tables". 

1 Select the [Method File] cell in the batch table, and click the  (Method Development) 

icon on the [Postrun Batch] assistant bar. 

2 Check the calibration curve in the [Calibration Curve] window. 
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14.2 [Calibration Curve] Window
Check calibration curves made in realtime or postrun batch in the [Calibration Curve View] window and 
make calibration curves by manually adding calibration points. 

The [Calibration Curve] window has four views, [Calibration Curve View] displays calibration curves, 
[Method View] displays the data processing parameters, the [Data Files] tree view displays the data files 
used for calibration curves, and [Chromatogram View]. 

14.2.1 [Calibration Curve] window Description
This section describes how to view the [Calibration Curve] window. 

The layout of each view can be changed in the [Calibration Curve] window. 
Two modes are provided for the display layout, [Normal Mode] and [Many Ingredients Mode], which is used 
when there are many identified peaks. 

No. Explanation

1 Displays the [Standard] and [Calibration Curve] toolbars. 

2 Displays a calibration curve graph, calibration curve information and Calibration Table. 

3 Displays the data files for the individual levels used to make the calibration curve. 
Calibration points for each level can be added or deleted. 
Add data files by dragging-and-dropping them from the [Data Explorer] sub-window. 

4 Displays the chromatograms and sample information of the data files used to make the calibration curve. 

5 Parameters are displayed in the [View] mode, and can be changed in the [Edit] mode. 

6 Displays the data processing parameters in the method file.

Toolbar1 [Calibration Curve View]2 [Data File] tree view3

4 [Chromatogram 
View]

5

6 [Method View]
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14.2.2Make Calibration Curves in the [Calibration Curve] Window
This section describes how to manually make calibration curves. 

Data processing parameters must be set before calibration curves can be manually created in the 
[Calibration Curve] window. 

1 Click the  (Calibration Curve) icon on the [Main] assistant bar in the [Postrun 

Analysis] program. 

2 Select the method file. 

• Existing method file

1 Drag-and-drop the method file onto the [Calibration Curve] window from the [Data Explorer] sub-
window. 

• New method file

1 Click the  (New) button on the toolbar. 

The following message is displayed. 

2 Click [OK].
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3 Select the method file used for data acquisition or a method file with the same system configuration, 
and click [Open]. 

The detector is set based on the system configuration information in this file.

The [Calibration Curve] window changes to [Untitled]. 

3 Click the [Data] tab at the bottom of the [Data Explorer] sub-window. 
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4 Drag-and-drop the data file of the standard sample onto the target level in the [Data 

Files] tree view from the [Data Explorer] sub-window. 

Drag-and-drop the data file onto the same level position as the concentration set in the Compound 
Table of the method file. 

The data file is added to the level. 

Repeat the above step and drag-and-drop the additional standard sample data file onto the target level 
when multiple standard samples are used. 
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Set the [# of Calib. Levels] on the [Quantitative] tab in the [Method View] to increase the number of 

levels in the calibration curve. 
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5 Click the  (Wizard) icon on the [Calibration] assistant bar. 

6 Refer to "4.5.1 Compound Table Wizard" P.116 to set the data processing parameters 

using the Compound Table Wizard. 

7 Click  (View Mode) in [Method View]. 

Data processing is performed on the data loaded in the [Data Files] tree view according to the parameters 
set in the Compound Table Wizard. 

8 Click the  (Save) button on the toolbar. 

The method file and the data file(s) in the [Data Files] tree view are saved. 
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15Appendix

This chapter describes how to locate operation details on the Help menu or in the online manuals. 
Use this information in the event that you are having problems with software operation, and the basic 
operations in software screens. 

15.1 Operation Problems
This software provides the Help menu and online manuals. Use the Help menu and online manuals to 
learn more about software operations or the terms displayed on screen. 

This section describes how to use the Help menu and online manuals. 

15.1.1Help
Use the following procedures to open the Help menu. 

 Keyword Search
If the term or parameter is unknown, enter a keyword to perform a search, and a list of topics that match 
the keyword is displayed. This allows for review of Help topics that pertain to the terms and parameters. 

1 Open Help.

2 Click the [Index] tab, and execute the search.

Type of Operation Operation Procedures
[Help] Click [Help] on the sub-window. 

The section Help for the current sub-window is displayed. 

 (Help) Click  (Help) on the toolbar. 

[Help] menu Click [Contents] on the [Help] menu. 

[F1] key Press the [F1] key on your keyboard. To locate the details relating to the current 
sub-window.

1

2

3
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1 Enter the keyword to search for, and press the [Enter] key on your keyboard. 

Topics matching the keyword are displayed in an alphabetical order. 

2 Click the topic. 

3 Click [Display]. 

The contents of the selected topic is displayed. 

• The [Topic Found] sub-window opens if there are multiple matching keywords. Select the 
desired keyword in the list in this sub-window, and click [Display]. 

• Use the [Search] tab in the Help window to search the entire text of the Help topic for the 
keyword terms.

15.1.2Online Manuals
The "Operators Guide", "System Users Guide", "Data Acquisition & Processing Theory Guide", "Getting 
Started Guide" and other online manuals are installed in PDF format when this software is installed.

This section describes how to display online manuals. 

1 Click the  icon in the [LabSolutions Main] window.
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2 Click the icon of the desired instruction manual.

This opens Adobe Acrobat Reader and the instruction manual.

• The “Operators Guide” online manual can also be opened by clicking [Online Manual] on the 
[Help] menu in the window. 

• Adobe Reader is required to open online manuals. 

• Visit Adobe's website for details on Adobe Reader. 

No. Explanation

1 Go directly to the desired page by clicking the hierarchically structured bookmarks (table of contents). 

2 Search for desired terms. 

3 Go directly to a related page by clicking the references or the terms in blue. 

1

3

2
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15.2 Common Screen Operations
The windows, assistant bars, toolbars and other graphical user interface elements in this software can be 
customized.

15.2.1Resize the View
Many of the windows such as [Data Acquisition] and [Data Analysis] are comprised of sections (views) that 
are separated by dividers. Drag the dividers to resize the views to make on-screen operations more 
efficient. 

 Resize Icons

To resize a view, click  (Full Size) in each view. This changes the normal size display to its full size. 

Alternatively, click  (Normal Size) to return the full size display to its normal size. 

[Results View] and [Method View] in the [Data Analysis] window contain a  (Wide Size) icon for displaying 

views at the full horizontal size and a  (Normal Size) icon to return the wide size view to the normal size.

 Drag the Dividers to Resize Views
Views can be resized as desired by dragging the dividers of each view. 

Full sizeNormal size
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15.2.2Customize Windows
This software allows a customized view layout for a specific operation to be saved. 

For example, since the [Data Analysis] and [PDA Data Analysis] windows have many views, data can be 
more easily analyzed by saving various layouts with unwanted views hidden. 

This section describes the procedure for saving the [Data Analysis] window layouts. 

 Save Layouts

1 Click [Save Layout] on the [Layout] menu. 

2 Enter the name of the layout, and click [OK]. 

The layout of the currently open window is saved. 
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 Open a Saved Layout

1 Click [Select Layout] on the [Layout] menu. 

2 Select the name of the layout, and click [Select]. 

The window is opened using the selected layout. 
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15.2.3Customize Assistant Bars
This software allows the addition or deletion of icons displayed on assistant bars to customize assistant 
bars for specific operations. 

This section describes how to delete the [Batch Editor] icon from the [Main] assistant bar in the [Realtime 
Analysis] program. 

1 Open the [Data Acquisition] window. 

2 Select [Customization] on the [Tools] menu, and click [Customization Settings]. 

3 Click the [Assistant Bar] tab, select the icon to delete, and then click [OK]. 

1 Select [Main] at [Windows].

2 Select the [Batch Editor] icon at [Display Icons].

3 Click [Remove] to move the [Batch Editor] icon to [Hide Icons].

The [Batch Editor] icon is no longer displayed on the [Main] assistant bar in [Realtime Analysis].

• It is only possible to customize the icons for the functions used in each window of the [Realtime 
Analysis], [Postrun Analysis] and [Browser] programs. Customize windows by editing [Available] 
on the [Application Windows] tab. 

• Select the icon at [Display Icons], and click [Up] or [Down] to change the display order of icons on 
the assistant bar. 

1 3 2
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15.2.4Customize Toolbars
This software allows the addition or deletion of icons displayed on toolbars to customize the toolbars for 
specific operations. 

This section describes how to add the [Open Reference Data File] icon to the [Data Acquisition] toolbar.

1 Open the [Data Acquisition] window. 

2 Select [Customization] on the [Tools] menu, and click [Toolbar Customization Settings]. 

3 Click the [Command] tab, customize the [Data Acquisition] toolbar, and then click 

[Close]. 

1 Select [Data Acquisition] at [Categories]. 

2 Drag-and-drop  (Open Reference Data File) onto the [Data Acquisition] toolbar. 

The button is added to the [Data Acquisition] toolbar. 

• Deselect the check mark of a displayed toolbar on the [Toolbar] tab to hide a toolbar.

• Drag-and-drop a button on the toolbar to an area outside of the toolbar to delete the button from 
the toolbar.

21
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15.2.5Copy Sub-Windows to the Clipboard
Chromatograms and Calculation Results Tables displayed in the sub-windows of this software can be 
copied to the Clipboard and pasted to other application software. 

This section describes how to copy chromatograms and Calculation Results Tables displayed in the [Data 
Analysis] window. 

 Copy Chromatograms to the Clipboard
Right-click on the graph in [Chromatogram View], and click [Copy]. The currently displayed content of the 
chromatogram is copied to the Clipboard. 

The chromatogram is displayed as follows when it is pasted from the Clipboard to other applications (In this 
example Paint is used). 
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 Copy Results Tables to the Clipboard
Select and right-click on the cell or row of a Compound Table or Peak Table, and click [Copy]. The currently 
displayed table information is copied to the Clipboard. 

Click [Copy Entire Table] to copy all of the information included in the table (displayed and hidden).
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15.3 Common File Operations
The contents of the files displayed in the [Data Explorer] sub-window can be displayed by double-clicking 
the files in the [Data Explorer] sub-window or dragging-and-dropping them onto each window. 

This section describes how to open files in this software. 

15.3.1Double-Click Files in the [Data Explorer] Sub-window
This section describes the action when a file in the [Data Explorer] sub-window is double-clicked. 

 If the File Display Window Is Not Open

• The windows for each of the files are opened from the program according to the file relationships set 
during installation.

• Double-click a file to load the file in the window indicated in the “Open Window” column. 
If the window is already open, the file is loaded to that window. 

File Name Program Name Open Window
Method file [Realtime Analysis] program [Data Acquisition] window

[Offline Editor] program [Method Editor] window

[Postrun Analysis] program [Calibration Curve] window
• If the method file contains calibration curve information, all 

data files for the standard samples that make up the 
calibration curve are loaded in the [Data Files] tree view. 

[Browser] program [Quant Browser] window
• If the method file contains calibration curve information, all 

standard sample data files that make up the calibration 
curve are loaded in the [Quantitative Results View]. 

Data file [Realtime Analysis] program [MS Data Analysis] window
• The [MS Data Analysis] window opens when data 

acquisition was performed by a MS detector.
[Data Analysis] window
[PDA Data Analysis] window

• The [PDA Data Analysis] window opens when data 
acquisition was performed by a photodiode array detector. 

[Offline Editor] program

[Postrun Analysis] program

[Browser] program [Data Browser] window
• The data file is loaded in the MS chromatogram cell in the 

[Data Browser] window. 

Batch file [Realtime Analysis] program [Realtime Batch] window

[Offline Editor] program [Batch Editor] window

[Postrun Analysis] program [Postrun Batch] window

[Browser] program [Quant Browser] window
• The method file in the initial row of the Batch Table and all 

data files in the Batch Table open at the same time. 

Report format file [Realtime Analysis] program [Report] window

[Offline Editor] program

[Postrun Analysis] program

[Browser] program
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 If the File Display Window Is Open

An exclusive [Report] window for opens for displaying data report format data. 

File Name Double-Clicked File Handling Window
Method file [Data Acquisition] window

[Method Editor] window

[Calibration Curve] window
• If the method file contains calibration curve information, all data files for the 

standard samples that make up the calibration curve are loaded to the [Data Files] 
tree view. 

[Quant Browser] window
• If the method file contains calibration curve information, all standard sample data 

files that make up the calibration curve are loaded to [Quantitative Results View]. 

Data file [MS Data Analysis] window
• The [MS Data Analysis] window opens when data acquisition was performed by a 

MS detector.
[Data Analysis] window
[PDA Data Analysis] window

• The [PDA Data Analysis] window opens when data acquisition was performed by a 
photodiode array detector. 

[Data Comparison] window

[Data Browser] window

[Quant Browser] window
• If the method file is not open in the [Quant Browser] window, the method file used 

to process the data files opens at the same time. 
• If the method file contains calibration curve information, all data files for the 

standard samples that make up the calibration curve are loaded to the [Data Files] 
tree view. 

Batch file [Realtime Batch] window

[Batch Editor] window

[Postrun Batch] window

[Quant Browser] window
• The method file in the initial row of the Batch Table and all data files in the Batch 

Table open at the same time. 

Report format file [Report] window
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15.3.2Drag-and-Drop Files from the [Data Explorer] Sub-Window
The following table describes the operations equivalent to drag-and-drop to display the method file in a 
specific window. 

 Operations Equivalent To Drag-and-Drop

• Only the currently displayed data can be displayed in the exclusive [Report] window. 

• The method file cannot be opened in a [Calibration Curve] window opened from the [Quant Browser] 
window. 

File Name Drop Destination Window Operations Equivalent to Dragging-and-Dropping 
Method file [Data Acquisition] window [File] - [Open Method File]

[Method Editor] window

[Calibration Curve] window

[Quant Browser] window

[MS Data Analysis] window [File] - [Load Method Parameters]
• Default method parameter are set when the method 

file data does not match the instrument configuration. 
[Data Analysis] window

[PDA Data Analysis] window

Data file [MS Data Analysis] window [File] - [Open Data File]

[Data Analysis] window

[PDA Data Analysis] window

[Data Comparison] window [File] - [Open] - [Add Data File]

[Data Browser] window [File] - [Load Data to Cell]

[Calibration Curve] window [Data] - [Add]
• The data file is displayed in the [Data Files] tree view. 

[Quant Browser] window [Data] - [Add]
• If the method file is not open in the [Quant Browser] 

window, the method file used to process the data file 
opens at the same time. 

[Postrun Batch] window [Edit] - [Add Rows with Selected Data File]

[Report] window [File] - [Load Data File]

Batch file [Realtime Batch] window [File] - [Open Batch File]

[Batch Editor] window

[Postrun Batch] window

[Quant Browser] window [File] - [Load from Batch File]
• The method file in the initial row of the Batch Table 

and all data files in the Batch Table open at the same 
time. 

Report format file [Report] window [File] - [Open Report Format File]

Library file [UV Library Editor] window [File] - [Open Library File]

[MS Library Editor] window

Browsing file [Quant Browser] window [Layout] - [Open Browsing File]
• The method file and data files in the browsing file 

open at the same time. 

Layout file [Data Browser] window [Layout] - [Open Layout File]
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 Drag-and-Drop Onto a Report with the [Shift] Key Held Down
The following table describes the action when a file is dragged-and-dropped from the [Data Explorer] sub-
window onto a report item with the [Shift] key held down.

File Name Drop Destination Item Action

Method file [System Configuration] The system configuration information in the method file is 
displayed. 

[Method] The instrument parameters and data processing parameters 
in the method file are displayed. 

[Calibration Curve]
[MS Calibration Curve]

The calibration curve information in the method file is 
displayed. 

Data file All places where data files 
can be loaded

Items are displayed individually. The chromatogram of the 
standard sample and the chromatograms of unknown 
samples can be displayed in a single report by dropping data 
files onto each item. 

• Multiple data files can be dragged-and-dropped onto 
the [Summary (Concentration)], [Summary 
(Compound)], [Summary (Data)], [MS Summary 
(Concentration)], [MS Summary (Compound)], and 
[MS Summary (Data)] items.

• Data files cannot be loaded in the [Line], [Arrow], 
[Rectangle], [Ellipse], [Picture], and [UV Library] 
items.

Batch file [Batch Table] The table and batch table information are displayed. 

Batch files saved in text format cannot be loaded. 

Library file [UV Library] The spectrum information in the library file is displayed. 

System check result 
file

[System Check] Displays the results of the system check. 
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15.3  Common File Operations

15

15.3.3Batch Table File Operations
This section describes the action when each cell in the method file, data files and report format files set to 
the Batch Table are clicked with the [Alt] key on your keyboard held down. 

While performing an operation on a file in the Batch Table, either select the file with the [Alt] key held down or 
double-click the file. To make changes, select [Options] on the [Tools] menu, and enter the changes on the 
[Batch Table Edit] tab in the [Setting Options] sub-window that opens.

File Name Program Name Open Window
Method file [Realtime Analysis] program [Data Acquisition] window

[Offline Editor] program [Method Editor] window

[Postrun Analysis] program [Calibration Curve] window
• If the method file contains calibration curve information, all 

data files for the standard samples that make up the 
calibration curve are loaded to the [Data Files] tree view. 

Data file [Realtime Analysis] program [MS Data Analysis] window
• The [MS Data Analysis] window opens when data 

acquisition was performed by a MS detector.
[Data Analysis] window
[PDA Data Analysis] window

• If data acquisition was performed with a photodiode array 
detector, the [PDA Data Analysis] window opens. 

[Offline Editor] program

[Postrun Analysis] program

Report format file [Realtime Analysis] program [Report] window

[Offline Editor] program

[Postrun Analysis] program
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